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About TeleVantage call centers _____________________________
TeleVantage provides the following two systems of setting up call centers:

� Call center queues

� ACD workgroups

For a detailed comparison of the features available using call center queues or ACD workgroups, 
see the table beginning on page 1-3.

With either method, you can set up a call center that automatically distributes incoming calls to 
a group of agents. Examples of call centers include a sales workgroup, a customer support 
department, or any department in which multiple agents answer calls to a single number. 

Call center queues
TeleVantage call center queues provide a full-featured call distribution system. A call center 
queue automatically answers calls, puts them in a queue, and then distributes them to ready 
agents. With call center queues you can customize the caller’s waiting experience, play single 
or repeating prompts, prompt callers to enter data, configure call priority, grant specialized 
supervisor permissions such as the ability to monitor calls, and use the TeleVantage Call Center 
Reporter to run a variety of reports on call center activity.

To use call center queues, you must have purchased Call Center Agent licenses. See 
Administering TeleVantage.

Call center queues are described in Chapter 2 through Chapter 5 of this manual.

For instructions for agents who participate in call center queues, see Chapter 5.

ACD workgroups
ACD workgroups have fewer features than call center queues. They are an alternative for those 
who have not purchased Call Center Agent licenses.

Creating ACD workgroups and participating in them as agents are described in Chapter 6 of this 
manual.
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Call center queue and ACD workgroup features _______________
The following table compares the features of a call center queue to those of an ACD workgroup.

Feature
Call 

Center
Queue

ACD 
Workgroup

Administration

Single-point interface to create

Take a queue or ACD workgroup off-line and 
send its calls to voicemail

Automatically take a queue off-line when all 
agents are unavailable

Choice of language for system prompts

E-mail and pager notification of new 
voicemail

Voice titles for call center extensions

Overflow groups of agents for times when 
primary agents are busy

Overflow agents with individual overflow 
levels

Overflow agents only called after all agents 
are busy for a time you configure

Agents automatically placed on break if they 
let queue calls ring unanswered

Callers redirected if the queue is too busy, 
callers are waiting too long, there are not 
enough agents, or there are no agents with 
matching skills

Individual permissions for whether an agent 
can use personal status to make himself or 
herself unavailable

View call center and personal Call Log in the 
same ViewPoint application

Queue logs for troubleshooting

Separate licensing required per agent

Caller Experience
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Call center automatically answers incoming 
calls

Hold music

Different hold music for each queue or ACD 
workgroup

Extension or DID number to dial queues or 
ACD workgroups

Call center extensions listed in the 
dial-by-name directory

Greetings to welcome callers

Repeating messages for waiting callers

Conditional messages for waiting callers

Priority for individual callers that reduces 
wait time

Messages that tell callers their expected wait 
times

Messages that tell callers how many callers 
are ahead of them

Caller options to stop waiting and leave 
voicemail or transfer out of the queue to an 
extension

Ability to prompt callers to enter data

Agent Experience

Call Monitor tabs for agents

Agents can answer any call using 
TeleVantage ViewPoint

Agents can work from home or any remote 
location

Call center listed in Extensions folder in 
ViewPoint

Individually configurable agent wrap-up time

Feature
Call 

Center
Queue

ACD 
Workgroup
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Agents can manually end their wrap-up time 
early

System-wide wrapup time

Special personal statuses for agents: 
Available (Queue only), Available 
(Non-Queue) and On Break

Agents can make themselves ready or 
unavailable to receive calls using ViewPoint 
or telephone commands

Agents can sign in and out of individual 
queues using ViewPoint or telephone 
commands

Visual indication of which agent will get the 
next call

Agents can place calls as the queue, 
enabling supervision and reporting of 
outbound calls

Supervision

Changing an agent’s personal status

Signing an agent in or out of a queue

Comprehensive Queue Monitor to view 
real-time queue and agent statistics

Customizable shift periods for comparative 
statistic display

Critical queue statistics available by phone in 
audio format

Coaching and monitoring of agents

Viewing agents who are being monitored

Automatically setting absent agents to On 
Break status

Automatically recording of agent and call 
center calls on a periodic basis

Call Distribution

Feature
Call 

Center
Queue

ACD 
Workgroup
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TeleVantage documentation ________________________________
TeleVantage provides documentation in several easy-to-access online formats that provide the 
benefits of instant hypertext navigation. This section describes the different TeleVantage 
documents and how to access them in various formats.

Ordering printed documentation
You can order printed versions of TeleVantage documents. To do so, contact your TeleVantage 
reseller or visit www.artisoft.com/manuals.

Sequentially by agent order

Round robin (each agent in turn)

Simultaneously (ring all agents)

To longest idle agent

To agent with fewest calls

To agent with least talk time

To agent with best matching skills

To agent via custom routing method

Reports

Separate licensing required for reports

User Activity Report for agents includes 
personal status breakdown and call center 
details section

All other reports

Feature
Call 

Center
Queue

ACD 
Workgroup
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The TeleVantage documentation set
The following table describes the TeleVantage documents and the formats in which each is 
available. See the next section for instructions on using each format.

Document Audience
Available 
in print

HTML 
book

Acrobat 
PDF

Installing TeleVantage
This manual covers the requirements and 
installation process for upgrades and fresh 
installations, and describes how to order 
telephone company services, add licenses, 
configure advanced settings, and 
troubleshoot problems.

Administrators
and

TeleVantage
providers

Yes Yes Yes

Installing Intel Telephony Components
This manual covers the requirements and 
installation process for upgrades and fresh 
installations, and describes how to change 
hardware and troubleshoot problems.

Administrators
and

TeleVantage
providers

Yes Yes Yes

Administering TeleVantage
This manual describes setting up, managing 
and monitoring your TeleVantage system, 
including using the TeleVantage 
Administrator to configure system settings, 
trunks, stations, users, call routing, IP 
telephony, and more.

Administrators Yes Yes* Yes

Using TeleVantage
This manual covers how to use the 
TeleVantage system, including the telephone 
commands, TeleVantage ViewPoint, 
ViewPoint Web Access, working from 
remote locations, call center participation, 
and more.

All audiences Yes Yes Yes

TeleVantage QuickStart Guide 
This small guide provides easy-to-read 
instructions for first-time users and basic 
TeleVantage use, including a complete 
telephone command reference and 
coverage of ViewPoint fundamentals.

All audiences Yes Yes Yes
CHAPTER 1. INTRODUCTION 1-7



* Administering TeleVantage and the TeleVantage Call Center Administrator’s Guide are combined into a 
single online book called Administering TeleVantage and Call Centers.

Accessing online documentation
You can access TeleVantage’s online documentation in the following formats.

Online Help
From any TeleVantage application window, you can press F1 or click Help to get 
context-sensitive Help describing the window and its individual fields. For overviews of 
features, see the online or PDF books, not the online Help. 

HTML books
TeleVantage provides complete compiled HTML Help (.CHM) versions of four of its printed 
manuals, enhanced with hypertext navigation panes and links. To access the HTML books from 
within ViewPoint or the Administrator, choose Help > Online Books.

TeleVantage Call Center Administrator’s 
Guide 
This manual describes configuring, 
maintaining, supervising, and participating in 
a TeleVantage call center. Contains separate 
sections for administrators and agents. 
Includes instructions for running call center 
queues, ACD workgroups, and TeleVantage 
call center reports.

Administrators Yes Yes* Yes

TeleVantage Developer’s Guide 
This reference describes how to extend 
TeleVantage’s built-in features using the 
Client API, the Add-in API, the IVR Plug-in 
API, the Device Status API, and TAPI.

Programmers Yes No Yes

TeleVantage Pocket Reference Card 
This wallet-sized card is a convenient 
reference for the most-used TeleVantage 
telephone commands.

All audiences Yes No Yes

Document Audience
Available 
in print

HTML 
book

Acrobat 
PDF
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To access the HTML books without ViewPoint or the Administrator, open the following files, 
located in C:\Program Files\Common Files\Vertical\TeleVantage:

� AdministeringTV.chm. Contains Administering TeleVantage and the TeleVantage Call 
Center Administrator’s Guide.

� InstallingTV.chm. Contains Installing TeleVantage.

� UsingTV.chm. Contains Using TeleVantage.

Adobe Acrobat PDF books
The .PDF versions of TeleVantage manuals are the same files that Vertical sends to be 
professionally printed, and can be used for your own printing or browsing. They are available 
on the TeleVantage Master CD in the \Manuals directory. To view and print these files, use the 
Adobe Acrobat Reader, available on the TeleVantage Master CD in the \Adobe directory.

Getting technical support________________________________
Contact your TeleVantage administrator for technical support.
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About call center queues __________________________________
TeleVantage call center queues provide a full-featured system for distributing calls to agents. 

This chapter describes creating and maintaining a queue. For information about working as an 
agent in a call center queue, see Chapter 5. For information about working as a supervisor or 
manager in a call center queue, see Chapter 6. 

For information on ACD workgroups, see Chapter 7.

When agents receive queue calls
For an agent to receive calls from a queue, the following four conditions must be true:

� The agent is defined as a member of the queue. A TeleVantage user who is not a 
member of a queue can see no part of that queue in ViewPoint, and never receives calls 
from that queue. The queue administrator adds and deletes agents as members of a 
queue. 

� The agent is signed in to the queue. This setting determines whether the agent receives 
calls from this particular queue. Agents must be signed in to the queue to receive calls 
from it. An agent who is signed out does not receive calls from that queue, but can still 
see and monitor the queue in ViewPoint—a useful state for supervisors. An agent might 
be signed into some queues and signed out of others at any given time. The queue 
administrator determines which agents are signed in or out of each queue. You can also 
give individual agents permission to sign themselves in and out.

� The agent is in an available personal status. To receive queue calls, an agent must be 
in the personal status Available, Available (Queue Only), or any personal status with the 
Queue calls field set to Yes. Agents in any personal status with Queue calls set to 
No—for example, Available (Non Queue) or Do Not Disturb—do not receive calls from 
any queue. Agents can change their own personal status if they have permission to do 
so, and it can also be changed by others if they have permission to do so.

� The agent is ready. This agent state, viewable in the Queue Monitor (see “The Agents 
pane” on page 6-3), determines whether the agent is currently eligible to receive queue 
calls. Agents are ready when they are signed into at least one queue, are in an available 
personal status, and are not currently in a call or the wrap-up period following a call.

What agents experience
Agents can work in a queue using the telephone alone or in conjunction with TeleVantage 
ViewPoint. Agents can change their personal status to begin their shifts, take breaks, and end 
their shifts. After finishing each call, agents have a wrap-up time to complete paperwork before 
they receive the next call.

By default agents have permission to change their own personal status, enabling them to control 
their own workflow. You can revoke this permission for individual agents, so that a supervisor 
must change their personal status for them. See “Preventing agents from changing their personal 
status” on page 2-16.
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What callers experience
Callers reach the queue either by dialing its extension directly or choosing it from your 
company’s auto attendant (for example, “for Technical Support, press 2”). They hear an initial 
message, called a Welcome prompt, that introduces them to the queue. You can also have the 
queue prompt them to enter data at this point, such as a customer number, that can optionally 
modify their waiting experience. If no agents are ready, the callers are then placed on the queue 
to wait. 

While waiting, callers hear hold music. Occasionally they hear other messages called Hold 
prompts. These are messages that you record to assure callers that their calls will be answered, 
to play them an advertisement, and so on. You can define Hold prompts that play only once, play 
on a repeating basis, or change based on how close the call is to being answered. Instead of 
waiting, callers can choose to leave a voice message or transfer out of the queue to an extension 
you define, such as an Operator or your auto attendant.

When an agent becomes ready, the caller is transferred to that agent.

Basic call center queue terminology
To work in a call center queue as an administrator, supervisor, or agent, you should be familiar 
with the following call center queue terms:

� Agent. A TeleVantage user who answers incoming calls to the call center.

� Queue. A call center that is set up at a single extension. Callers to that extension who 
are waiting are said to be “in the queue.” A call center can have more than one queue. 
For example, a technical support department can have one queue for Product A and 
another queue for Product B. Each queue has its own list of agents who answer calls and 
its own method of distributing calls to agents. A user can be an agent for more than one 
queue.

� Supervisor. An agent who has special permissions. Supervisors can perform 
administrative maintenance on a queue by using the TeleVantage Administrator 
application, and they can view current queue statistics in ViewPoint. Agents can have 
varying levels of supervisor permission. If you have supervisor permissions, see Chapter 
6 for further information.

� Overflow agent. A user who answers calls to a queue only when all the queue’s regular 
agents are busy (standby or unavailable).

� Personal calls. Any calls directly to an agent’s extension, as opposed to calls the agent 
receives from a queue.

Agents, call forwarding and routing lists
Queue calls to agents do not use the agents’ routing lists or call rules, so they cannot try an agent 
at multiple locations. Queue calls do follow the agents’ call forwarding / Where I Am settings.
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Viewing queue configuration and setup
The Call Center Queue Information report shows general information about each queue in your 
system, including a list of agents and their current settings. You can use this report to get a 
snapshot of a queue’s setup. For more information, see Chapter 8.

About creating a call center queue___________________________
The queue is the backbone of a call center. A queue defines the primary and overflow agents 
who receive call center calls, the method by which calls are distributed to those agents, what 
callers experience while they are waiting, and so forth.

Licenses and permissions
To create a call center queue, you must have the appropriate licenses and permissions.

Agent licenses
To create a queue, you must first purchase and enter one Call Center Agent license for each call 
center agent. Only one license is required for each agent, even if agents are members of multiple 
queues. See Administering TeleVantage for more information about entering licenses.

Queue folder permission
To create or edit a queue, you must have the general TeleVantage permission Access Queues 
Folder set to View and Edit. You do not need other Administrator permissions, so you can 
manage queues without being a full TeleVantage system administrator. To set permissions, use 
the Users view of the Administrator. See Administering TeleVantage.

Overview of creating a queue
You create a queue in the TeleVantage Administrator using the tabs in the Queue dialog box, 
accessed by choosing File > New > Queue. The sections in this chapter describe each feature 
you can use.

When you have finished creating a queue, you can then set up one or more methods of directing 
calls to it. You can:

� Create an auto attendant menu choice that sends callers to the queue. See “Setting up a 
menu choice for a queue” on page 2-51. 

� Give the queue a DID number or route a trunk directly to the queue. See Administering 
TeleVantage.

� Create a utility user that receives calls and automatically routes them to the queue. By 
doing this you can use TeleVantage’s advanced call-handling features with a queue, for 
example contact identification, intelligent call routing, time scheduling, and more. By 
using a utility user you can give your VIP callers special treatment. See Chapter 4.

After you have set up a method of directing calls to the queue, the queue is complete and 
available.
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The Queues view
To create or edit a queue, open the Queues view in the TeleVantage Administrator by clicking 
its button in the view bar.

Each queue that you create appears as a row in the view. The following table shows the 
information that is displayed for each queue in the Queues view.

Column Description

Name Name of the queue

Extension Extension dialed to reach the queue from the auto 
attendant or when transferring a call

DID Direct Inward Dial—Phone number dialed to 
reach the queue directly

Distribution Algorithm used to distribute calls to agents

Status Whether the queue is currently distributing calls to 
agents. The possible statuses are:

Open. The queue is distributing its calls to 
ready agents as normal.

Closed. The queue is closed. No calls are 
being distributed to agents.

Closed - No agents. All agents in the queue 
are currently signed out, so the queue is 
automatically sending its calls directly to 
voicemail.

Number of 
Agents

Total number of agents who are members of the 
queue.

Record Nth Call If checked, the queue is set to record its calls.
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Opening the Queue dialog box
Use the Queue dialog box to create or edit a queue. To open it, do one of the following:

� To create a new queue, choose File > New > Queue.

� To edit an existing queue, double-click its row in the Queues view.

Change Hold 
Music To

The name of the music-on-hold source being 
used for the queue’s hold music, if any.

Hold Callback The amount of time that the queue waits before 
ringing back an agent who leaves a call on hold or 
parked. “Off” indicates that ringback is not being 
used.

Priority If checked, the queue has a priority variable that 
can be used for assigning some callers a higher 
priority than others.

Overflow If checked, the queue is using overflow agents.

Redirect Separate columns for Too Busy, Maximum Wait, 
and Queue Closed. If checked, the queue is set 
to redirect callers when the circumstance occurs.

Mail Usage Percentage of allocated voicemail space currently 
used.

Greeting Usage Percentage of allocated space for greetings 
currently being used.

Disk Usage Amount of disk space (in megabytes) used by the 
queue’s audio files, including voicemail and 
greetings.

Mailbox size How much space (in minutes) the queue’s voice 
mailbox has.

Greeting size How much space (in minutes) is allocated to the 
queue for greetings.

Comments Any comments about the queue

Column Description
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Entering general information about a queue __________________
Click the Queue tab in the Queue dialog box.

1. Enter the following information for the queue:

� Name. Give the queue a short name that will easily identify it, such as “Sales 
queue.” When users transfer a call to this queue using ViewPoint, they will select it 
by name.

� Extension. Enter an extension for the queue. Users can then transfer calls to the 
queue by phone. The extension is generally not used by callers to dial the queue 
from an auto attendant. Callers should reach the queue either by dialing a Direct 
Inward Dial number or by making a choice on the auto attendant menu. See “Setting 
up a menu choice for a queue” on page 2-51.

� Password. Give the queue a unique numeric password. You will need to log in with 
the password if you want to change the queue configuration or check the queue’s 
voice messages when you are at a remote phone. For example, on a day when your 
business is closed unexpectedly, you can call, log in, and change the queue’s 
voicemail greeting so that callers are aware of the situation.

� DID Number. Optionally, you can give the queue a Direct Inward Dial number from 
the block of numbers provided by your telephone company. Callers can then dial 
the queue directly, without going through an auto attendant. 

To assign multiple DID numbers to a queue, separate each number by a comma. For 
example, enter 1234,1235,1236.

� Operator. Select the extension to which callers will be transferred if they press 0 
while they are leaving voicemail for the queue.

� Comments. Enter any descriptive information about the queue.

� Queue is closed. See the next section.
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� Trace queue and agent activity to queue logs. Check to create queue logs that 
record detailed agent and queue activity for troubleshooting purposes. See 
Appendix B for more details.

2. Click OK to save the queue as you have defined it so far or go to the next section.

Closing the queue
You can close the queue and prevent new incoming calls from being routed to agents, for 
example after business hours when your department is closed. When a queue is closed, incoming 
calls to it are automatically handled according to the selections you make on the Redirect tab 
(see “Redirecting calls when the queue is closed” on page 2-33). 

To close the queue

1. Click the Queue tab of the Queue dialog box.

2. Check Queue is closed.

3. Click OK to save the queue as you have defined it so far or go to the next section.

Note: You can have the queue close itself automatically when there are no agents signed in. 
See “Redirecting calls when the queue is closed” on page 2-33.

Queue status when closed
Queue status displays in ViewPoint’s Extensions list in the Personal Status Name column, and 
lets you see at a glance whether the queue is currently accepting calls or not. The queue statuses 
are:

� Open. The queue is distributing to its calls to ready agents as normal.

� Closed. The queue is redirecting calls as specified on the Redirect tab.

� Closed - No agents. All agents in the queue are currently signed out or unavailable, so 
the queue is automatically redirecting calls as specified on the Redirect tab.

For more about ViewPoint’s Extensions list, see Using TeleVantage.

Defining call logging for the queue
Click the Queue \ Call Log tab.

1. Enter the following information:

� Log this queue’s calls. Specify which of this queue’s calls appear in the Call Log. 
You can log inbound calls, outbound calls, both, or none. To log no calls, uncheck 
the field.

Important:If you turn off call logging for the queue, you cannot run reports on this 
queue. 

� Organization. If you are using Organizations, check to associate this queue with the 
Organization you select from the dropdown list. Click  to create a new 
2-8 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



Organization. Inbound calls to the queue that did not reach an agent will be logged 
as belonging to the selected Organization (for example, abandoned calls and calls 
where the caller left a voice message).

Organizations are a means to represent different companies or tenants that share a 
TeleVantage Server. For more information, see Administering TeleVantage.

Note: Outbound calls made by users calling as the queue are not associated with 
the queue’s Organization. They are always associated with the user’s Organization, 
even if the user has no associated Organization.

2. Click OK to save the queue as you have defined it so far or go to the next section.

Setting ISDN Caller ID information for outbound queue calls
Agents can place outbound calls that are marked as being from the queue rather than their 
personal extension (see “Placing calls from a queue” on page 5-8). For outbound queue calls that 
are placed over ISDN trunks, you can determine the Caller ID information that accompanies the 
call.

Notes

� Caller ID information entered here is overridden by any ISDN Outbound Caller ID entered 
for the ISDN span. See Administering TeleVantage.

� On trunk types other than ISDN, outbound Caller ID is always set by the telephone 
company.

To set ISDN outbound Caller ID for the queue

1. Click the Queue \ ISDN Outbound Caller ID tab.

2. From the Calling party presentation dropdown list, select one of the following:

� System default. Outbound Caller ID will be whatever you have specified under 
Tools > System Settings for the TeleVantage system as a whole. The current 
setting is displayed in parentheses.

� Custom. You can specify your own Caller ID number to accompany outbound calls 
from the queue. Enter the Caller ID number in Calling party number.

� Set by telephone company. No specific Caller ID is attached to outbound calls 
from the queue. Outbound Caller ID is assigned by your telephone company 
network.

� Blocked. Caller ID is blocked on outbound calls from the queue. Note that the 
system still sends Caller ID information even though it is blocked: this is a 
requirement, because some institutions have the right to read blocked Caller ID, for 
example emergency services and 800-numbers.

3. Click OK to save the queue as you have defined it so far or go to the next section.
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Including the queue in the dial-by-name directory
You can include the queue in the dial-by-name directory so that, for example, a caller could dial 
SALES to reach your Sales queue.

If you include the queue in the dial-by-name directory, you should record its voice title. See 
“Recording a voice title for the queue” on page 2-46.

To include the queue in the dial-by-name directory

1. Click the Dial-by-name Directory tab of the Queue dialog box.

2. Check List in dial-by-name directory.

3. To play a user's extension along with the user's name when callers choose the user 
from the dial-by-name directory, check Play extension to the caller. 

4. Click OK to save the queue as you have defined it so far or go to the next section.

Defining agents for the queue_______________________________
Use the Agents tab in the Queue dialog box to define agents for the queue. Both primary agents 
and overflow agents must be defined as agents on this tab. Primary agents are agents whose 
primary task is answering queue calls. Overflow agents are agents whose primary task is not 
answering queue calls, but who receive them when all primary agents are busy. See page 2-25 
for further information about defining overflow agents for your queue.

For an agent to work in more than one queue, you must add the agent separately to each of those 
queues.

Agents must be TeleVantage users before you can add them to a queue (see Administering 
TeleVantage for information about creating TeleVantage users). 
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Changing wrap-up time and permission defaults
You can set defaults for agent wrap-up time and permissions. There are two benefits to doing 
this:

� To save time when adding agents. Before adding agents, set the defaults to the way 
you want them to be for a typical agent. The default settings will then appear as each new 
agent’s settings, which you can then modify for an individual agent if necessary. 

� To change a permission for several agents at once. When you change a default agent 
permission, you change it for all existing agents except agents for whom you have 
specified an unchanging permission. For example, you might give your agents the 
Queue Sign In/Out permission, and then later decide to disallow it. This effect works 
only for permissions, not wrap-up time.

To set a default wrap-up time

On the Agents tab, enter a number of seconds in Default wrap-up for new agents in seconds.

To set default agent permissions

1. Click the Agents \ Permission tab.

2. To set a default permission, click the Value column in its row in the list, then select the 
permission level you want from the dropdown list. For a description of the permissions 
and permission levels, see “Agent permissions” on page 2-14.

3. Click OK to save the queue as you have defined it so far or go to the next section.

Adding agents to the queue
Click the Agents tab of the Queue dialog box.

1. Click Add. The Agent dialog box opens at the General tab.

2. For This agent is the following user, select a user from the list.
CHAPTER 2. CREATING A CALL CENTER QUEUE 2-11



3. For Wrap up time in seconds, accept the default or enter a different wrap-up time. 

Agents can terminate their wrap-up period early and make themselves ready to receive 
calls. See Chapter 5 for complete instructions on being a call center queue agent.

4. For Overflow tier, leave the default value of 0 unless you want the agent to be an 
overflow agent. See “Setting up overflow agents” on page 2-25.

5. For This agent is an observer, not shown in Queue Monitor, check to make this 
agent an observer who can monitor queue activity without being seen by other agents 
in the queue. If checked:

� Other agents cannot see the agent in ViewPoint in the Agents pane of the Queue 
Monitor (see “Viewing queue statistics in the Queue Monitor folder” on page 6-3) 
or the queue’s tab in the Extensions list. 

� The agent is automatically signed out and cannot sign in, so that the agent does not 
receive calls from the queue (see the next step).

� The agent cannot be given the permission Queue Sign In/Out.

The observer agent can view queue activity in the Queue Monitor and Call Monitor, 
supervise other agents’ calls and perform other supervisory actions. The observer 
agent can also take queue calls manually by using the Take Call command in the Call 
Monitor.

If the checkbox is cleared, the agent appears in the Agents pane of the Queue Monitor, 
and can be signed in or out.

6. For This agent is signed in, select the check box if the agent receives calls from the 
queue when the agent is ready. Clear the check box to define a supervisor who can 
monitor the queue but does not receive calls from the queue. 

When the check box is cleared, calls from this queue are not sent to the agent, even 
when the agent is ready. However, the agent still sees the tab for this queue in the Call 
Monitor and can answer queue calls using the Take Call command.

Note: To receive calls from a queue, an agent must be both signed in, available for 
queue calls, and ready. See “When agents receive queue calls” on page 2-2.

You can use this check box to switch an agent from one queue to another, by signing 
the agent in for one queue and out for the other queue. 

You can also give agents the permission to sign themselves in and out of a queue. See 
“Agent permissions” on page 2-14 and “Signing in and out of a queue” on page 5-5.

7. To change the agent’s permissions from the queue’s defaults, click the Permissions 
tab, click the permission, click the arrow in the Value column, and select a value for 
the permission. If you choose “Use Default,” the value changes when you change the 
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default permission (see “Changing wrap-up time and permission defaults” on 
page 2-11). For an explanation of permissions, see “Agent permissions” on page 2-14.

You do not need to use the Skills tab unless you are using skills-based routing. See 
Chapter 3.

8. To set automatic call recording for this agent, check Automatically record this 
agent’s calls. See the next section for details.

9. When you have finished defining the agent, click OK. The Agent dialog box closes and 
you return to the Agents tab in the Queue dialog box.

Automatically recording an agent’s calls
You can have TeleVantage automatically record an agent’s queue calls on a periodic basis. The 
recorded calls appear as new voice messages in the voice mailbox that you select. The system 
records both inbound and outbound queue calls. 

If you want to record all user calls, use system call recording instead. See Administering 
TeleVantage.

Notes

� You can include a repeating beep on queue call recordings to indicate to the agent and 
caller that the call is being recorded. See Chapter 4 of Administering TeleVantage.

� In some U.S. states, it is illegal to record a call without notifying the caller. If you are using 
TeleVantage in such a state, your queue’s Welcome prompt should inform callers that 
their calls may be recorded, and you may want to play a regular beep during call 
recording. See “Warning callers that their calls may be recorded” on page 2-47.

To automatically record an agent’s inbound queue calls

1. Click the General tab in the Agent dialog box.

2. Check Automatically record this agent’s calls.

3. In Record 1 call out of every, enter a number. Enter 1 to record every call to this 
agent, 2 to record every other call, 3 to record every third call, and so on.

Note: All calls that an agent handles count for purposes of counting his or her calls.

4. From the Recording direction dropdown list, select whether to record inbound calls 
only, outbound calls only, or both. Selecting both means that you get one recording per 
n calls regardless of the calls’ direction.

5. From the Send agent call recordings to dropdown list, select the mailbox that will 
receive the call recordings as new voice messages.
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6. From the When mailbox is full dropdown list, select what happens if the destination 
mailbox is full when TeleVantage attempts to store a new call recording there:

� Discard new call recording. TeleVantage deletes the new call recording instead of 
storing it.

� Delete oldest call recording. TeleVantage deletes the oldest call recording in the 
mailbox to make room for the new recording. Only call recordings can be deleted 
by this method. TeleVantage never deletes voice messages in this way.

7. Click OK. The Agent dialog box closes.

Note: You can also record a general sampling of calls to the queue, regardless of which agent 
answers them. See “Automatically recording queue calls” on page 2-48.

Agent permissions
You can give agents permissions in the following areas:

Agent Permissions

Permission Description Default value

Change the 
personal status 
of another user

The agent can manage other 
agents’ workflow by changing 
their personal status. See 
“Changing an agent’s personal 
status” on page 6-20. 

If agents are prevented from 
changing their own personal 
status, you must create a 
supervisor with this permission to 
manage their workflow is . See 
“Preventing agents from changing 
their personal status” on 
page 2-16.

Allow

Join another 
agent’s call

The agent can enter another 
agent’s call, such that all parties in 
the call hear each other. See 
“Supervising other agents’ calls” 
on page 6-17.

Disallow

Coach an agent The agent can enter another 
agent’s call and be heard by the 
coached agent but not by the 
caller. See “Supervising other 
agents’ calls” on page 6-17.

Disallow
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Monitor Agent 
calls

The agent can listen in on other 
agents’ calls without being heard 
by the monitored agent or the 
callers. See “Supervising other 
agents’ calls” on page 6-17.

Disallow

Monitor Queue 
statistics

The agent can view real-time 
queue statistics in ViewPoint’s 
Queue Monitor folder or listen to 
statistics using the telephone 
command *55. See “Monitoring 
queue statistics” on page 6-3.

Allow

Queue sign 
in/out

The agent can sign in or out of 
individual queues. See “Signing in 
and out of a queue” on page 5-5.

Note: If an agent has the general 
TeleVantage permission Access 
Queues folder set to “View and 
Edit,” and is not an observer 
agent, the agent can sign in and 
out of all queues regardless of 
how this queue permission is set. 

Disallow

Sign in/out other 
agents

The agent can sign other agents 
in and out of queues from the 
Queue Monitor.

Disallow

View agents 
being monitored

The agent can see when agents’ 
calls—including their own—are 
being monitored. With this 
permission, agents whose calls 
are being monitored display in the 
Call Monitor with the monitoring 
party attached as an indented 
line. See “Viewing when agents 
are being monitored” on 
page 6-18.

Disallow

Access Queue 
call log

The agent can view a record of 
calls to the queue. With “View and 
Edit,” the agent can perform all 
actions in the folder. See Using 
TeleVantage.

View only

Agent Permissions
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Permissions are granted to call center agents using the following levels:

� Use default. The agent’s permission level is whatever the default is for that permission. 
The current default is shown in parentheses. If the default changes, the agent’s 
permission changes with it. See “Changing wrap-up time and permission defaults” on 
page 2-11.

� Allow. The agent can perform the specified operation.

� Disallow. The agent cannot perform the specified operation.

� No access. The agent cannot view this part of the ViewPoint interface.

� View only. The agent can view the information in ViewPoint, but cannot perform any 
commands on an item. For example, if Access queue call monitor is set to View only, 
the agent can see queue calls but cannot answer or transfer them.

� View and Edit. The agent can view the information and perform all commands.

Preventing agents from changing their personal status
By default, TeleVantage allows agents (and all users) to change their own personal status. If you 
want, you can prevent agents from changing their personal status by setting their user permission 
Change Personal Status to Disallow (see Administering TeleVantage for instructions). When 
on duty, such agents are unable to select a personal status to stop receiving queue calls, for 
example Do Not Disturb or On Break. Supervisors can still change the agents’ personal status 
to start and end their workday and let them take breaks.

Note: When you prevent users from changing their personal status, they cannot use any of the 
personal status features described in Using TeleVantage.

Agent skills
The Skills tab of the Agent dialog box is used only if you are using skills-based routing. See 
Chapter 3.

Access Queue 
call monitor

The agent can see queue calls on 
a tab in ViewPoint’s Call Monitor 
folder. With “View and Edit,” the 
agent can perform all actions in 
the folder. See “Using the Call 
Monitor tabs” on page 5-7.

No access

Access queue 
mailbox

The agent can view and play 
voice messages in the queue’s 
voice mailbox. With “View and 
Edit,” the agent can perform all 
actions in the folder. See 
“Managing a queue’s voice 
mailbox” on page 6-21.

View and Edit

Agent Permissions
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Changing the order of agents
On the Agents tab in the Queues dialog box, click the arrow buttons to change the order of 
agents.

If you are using the top down or round robin algorithms to distribute calls to agents, the order 
of agents in the queue is especially important, because it determines the order in which agents 
receive calls.

The order of agents can also be important when using other distribution algorithms. For 
example, if you are using the fewest calls algorithm, and three agents are tied for the fewest 
calls, the topmost of those agents in the order gets the next call. Note that at the end of a shift all 
statistics are reset to zero, so all agents are tied in statistical categories, and agent order briefly 
becomes the method of distributing calls, until new statistics are accumulated.

For a description of the distribution algorithms, see “Configuring call distribution” on 
page 2-18.

Using remote agents
If you have call center agents who work primarily at a remote phone (for example, from their 
home or cell phone, or an IP phone), you should give them external stations. If they mostly work 
on a internal office station but occasionally work from home, you should assign them an internal 
station but make sure they use the "Imitate a station" feature and turn on call forwarding when 
working at home. See Administering TeleVantage for instructions on assigning users external 
stations, and Using TeleVantage for instructions on using a remote phone with TeleVantage. 

Using roaming agents, or hot-desking
If your call center agents frequently move from desk to desk, or take calls at whatever internal 
phone happens to be nearest, you can set up your call center to ensure the accuracy of statistics 
and reports, as follows:

1. Give all agents a station ID of 0.

2. For each desk, create a placeholder user with the station ID of the desk’s phone. Name 
the user after the desk, for example, “Cube 101” or “Desk 5.”

3. Tell agents to add the following steps to their routine for beginning and ending their 
shifts. Following these steps ensures that TeleVantage correctly displays and reports 
on agent activity no matter what phones they use.

� When agents first sit down at a new phone to receive calls, before they mark 
themselves as ready, they should log in and forward their calls to their current 
location. They can use either of the following methods:

� To use the telephone commands, pick up the phone and log in by pressing # 
<extension> # <password> #. Once logged in, press 5 1 to forward calls to 
their current location.
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� To use TeleVantage ViewPoint, start ViewPoint. The Select Station dialog 
appears. Select the second login option, Use station <x> to place and answer 
calls as <name>. Check Forward my calls to this station.

� When agents are finished using a phone, log out from it. This ensures that subsequent 
calls from that phone are not added to the agent’s record. To log out from a phone, either 
pick up the phone and press *0 0, or choose the ViewPoint command File > Exit and Log 
Off.

For more information, see “Working at different phones” on page 5-4.

When you have finished defining agents
Click OK in the Queue dialog box to save the queue as you have defined it so far or go to the 
next section.

Configuring call distribution________________________________
Click the Distribution tab in the Queue dialog box to perform the following tasks:

� “Choosing how queue calls are distributed to agents” (next section)

� “Placing agents on break if they do not answer calls” on page 2-21 

� “Closing the queue” on page 2-8 
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Choosing how queue calls are distributed to agents
There are several methods by which you can distribute incoming queue calls to agents. Note that 
calls are distributed only among agents who are both signed in and ready (see “When agents 
receive queue calls” on page 2-2 and “Starting your shift” on page 5-2).

To specify how the queue distributes calls to agents

1. Click the Distribution \ Agent Scoring tab of the Queue dialog box.

2. From the Agent scoring algorithm dropdown list, select one of the following:

� Top down. The call moves through the list of agents—from the top of the list 
downward—until it reaches a ready agent. For this algorithm, the order of agents in 
the queue is important. See “Changing the order of agents” on page 2-17. 

� Round robin. Agents receive calls in the same sequence as with Top Down, but 
starting with a different agent each time. Each call starts with the agent after the one 
who answered the previous call. 

� Longest idle agent. The ready agent who has waited the longest time for a call 
receives the next call. This algorithm is calculated by determining which agent has 
gone the longest period of time without being in an Active state. Non-queue calls 
count as being “idle,” because they put an agent in the Standby state. See the Agent 
State column under “Agents Pane Information” on page 6-4.

� Fewest calls. The ready agent who has answered the fewest calls from this queue 
since beginning their work shift receives the next call.

� Least talk time. The ready agent who has spent the least amount of time on calls 
from this queue since beginning their work shift receives the next call. This agent 
may be someone other than the agent who has handled the fewest calls.
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� Simultaneous ring. All agents’ phones ring at the same time. The agent who 
answers first takes the call. This feature is especially useful for small offices or 
departments. 

� Skills-based or custom routing. This option lets you construct your own 
distribution algorithm, using agent skills and other attributes. It is more complex to 
set up, but can be more flexible. See Chapter 3 for further instructions.

3. If you chose Longest idle agent, Fewest calls, Least talk time, or Skills-based or 
custom routing, choose the following options under Distribution calculations are 
based on... 

� Time period. Choose whether to distribute calls based on totals for the current shift 
or the current day (since midnight). For more information about shifts, see 
“Collecting queue statistics” on page 2-50.

� Direction. Choose whether the algorithm counts inbound calls only, or both 
inbound and outbound calls.

4. Click OK to save the queue as you have defined it so far or go to the next section.

Note: By default, outbound queue calls are not recognized by distribution algorithms. For 
example, “Longest Idle Agent” counts agents as idle unless they are on an inbound queue call. 
To have distribution algorithms recognize outbound queue calls, use the TeleVantage Advanced 
Settings Editor to set the database registry setting Server\CCRouteOutbound to 1. See 
Appendix A of Administering TeleVantage for instructions.

Distribution when the score is tied
When two or more agents tie for the same score (for example, with the “Fewest calls” algorithm, 
three agents have 0 calls each), the call always goes to the longest idle of the tied agents.

Notes on simultaneous ring
Simultaneous ring does not ring the phones of overflow agents unless the overflow wait time 
has been exceeded. At that point it rings the phones of all agents. See “Setting up overflow 
agents” on page 2-25.

When an agent answers a call with simultaneous ring, it does not count as an unanswered call 
for the other agents, for purposes of putting the agent automatically in On Break status. 
However, if all agents fail to answer the call while it is ringing, it counts as an unanswered call 
for all of them. See “Placing agents on break if they do not answer calls” on page 2-21.
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Note on Longest idle agent
The TeleVantage Advanced Setting Server\LongestIdleFromSignIn governs how the “Longest 
idle agent” algorithm treats newly-logged-in agents.

� If set to false (the default), the behavior is the same as in previous versions of 
TeleVantage.  The algorithm treats newly logged in agents as being idle since the 
beginning of the day or shift.  This can result in those agents receiving calls ahead of 
agents who have been idle longer.

� If set to true, the algorithm takes account of sign in time.  When an agent signs in after 
the start of the day or shift, the agent's idle time is counted from the sign in time, and not 
from the start of the day or shift.

For more information on advanced settings, see Appendix J of Installing TeleVantage.

Placing agents on break if they do not answer calls
You can have TeleVantage automatically place agents in the On Break personal status if they 
fail to answer one or more consecutive queue calls. Placing a missing agent On Break ensures 
that the queue does not send calls to that agent and provides the caller with a smoother waiting 
experience. This feature is a safeguard against agents leaving their phones and forgetting to 
place themselves in the On Break personal status. 

To automatically place missing agents On Break

1. Click the Agents tab of the Queue dialog box.

2. Check If an agent does not answer, set that agent to On Break. 

3. In After how many unanswered calls, enter the number of consecutive unanswered 
queue calls that must occur for TeleVantage to automatically place an agent in the On 
Break personal status.

4. Click OK to save the queue as you have defined it so far or go to the next section.

If an agent declines a queue call by using the call announcing options, that action is considered 
an unanswered call. See Using TeleVantage for an explanation of call announcing.

You can keep track of how often the queue automatically puts agents into On Break status, using 
the Queue Monitor statistics Away, No Answer, and Forced Break. See “The Agents pane” on 
page 6-3.

Note: Supervisors can also manually place agents in the On Break personal status or in any 
other personal status. See “Changing an agent’s personal status” on page 6-20.

See Using TeleVantage for more information about using the On Break personal status and other 
personal statuses.
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Defining how calls are scored ______________________________
When several calls are waiting in the queue, the queue scores each call to determine the order in 
which they will be sent to agents. The call with the highest score is the next one sent when an 
agent becomes available. 

By default, a call’s score is the number of seconds it has been waiting in the queue. The call with 
the highest score is the one that has been waiting the longest and will be the next one sent to an 
agent. However, you can manipulate call scoring to give certain calls a higher score, bumping 
them closer to the front of the queue so that they will be answered sooner. You can increase a 
call’s score using the following methods:

� Basing a call’s score on time in queue or time in system. See page 2-22

� Giving some calls higher priority. See page 2-23.

� Increasing a call’s score for skill matches. See page 2-25.

To use any of these methods, open the Queue dialog box and go to the Distribution \ Call Scoring 
tab.

Choosing by how much to increase a call’s score
A call’s score is based on its wait time in seconds, so it’s helpful to think in terms of seconds 
when deciding by how much to increase a call’s score. For example, if you want a high-priority 
call to jump ahead of a call that has been waiting for a minute, you would want to add 60 to its 
score. To have it jump ahead of a call that has been waiting 5 minutes, you would want to add 
300.

Basing a call’s score on time in queue or time in system
You can choose whether a call’s score is based on the length of time (in seconds) it has spent in 
that queue or in the TeleVantage system as a whole. If based on time in queue, then calls 
transferred between queues resume waiting anew with a score of 0. You might want to base call 
score on time in system if your calls often move from queue to queue, or are returned to the 
queue after talking to an agent or leaving voicemail. 

To choose the basis for call scoring, click either Time in this queue, in seconds or Time in the 
system, in seconds on the Distribution \ Call Scoring tab.
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Giving some calls higher priority
You can give some queue calls a higher priority than other queue calls. Calls with higher priority 
get a higher call score and advance to the head of the queue quicker than other calls. 

You assign priority to calls in the following way:

1. Define a custom data variable to use for call priority (the “priority variable”).

2. Set a “priority multiple” that determines the weight priority carries in the call score.

3. Identify high-priority calls when they enter the queue and assign priority appropriately 
using the custom data variable.

The value of a call’s priority variable is multiplied by the priority multiple and the result is added 
to the call’s score. The higher the priority multiple, the greater the effect of a high priority 
number. For example, if the priority multiple is 60, each unit of priority is worth a minute, so a 
call with priority 5 is equal to 5 minutes of wait time. If the priority multiple is 480, each unit of 
priority is worth 8 minutes, so a call with priority 5 is equal to 40 minutes of wait time.

Examples
The following tables illustrate how priority changes the order in which calls are answered.

Priority Multiple = 120 (Each unit of priority = 120 seconds or 2 minutes)

Order
received

Base Wait 
Time (sec.) Priority Priority score Call score Queue order

First 900 0 0 900 Second

Second 600 0 0 600 Fourth

Third 300 5 600 900 Third

Fourth 60 2 240 300 Fifth

Fifth 30 10 1200 1230 First

Sixth 10 1 120 130 Sixth

Priority Multiple = 500 (Each unit of priority = 500 seconds or 8 minutes 20 seconds

Order
received

Base Wait 
Time (sec.) Priority Priority score Call score Queue order

First 900 0 0 900 Fourth

Second 600 0 0 600 Fifth

Third 300 5 2500 2800 Second

Fourth 60 2 1000 1060 Third

Fifth 30 10 5000 5030 First

Sixth 10 1 500 510 Sixth
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Note: Redirection overrides caller priority. If the queue is currently redirecting callers based on 
the criteria you defined (see “Configuring the queue to redirect calls” on page 2-30), then calls are 
redirected no matter how high their priority would have been.

Configuring a queue to use call priority
To configure a queue for call priority, you must specify the custom data variable to use for 
priority (or create a new one) and specify the priority multiple, as follows:

1. On the Distribution \ Call Scoring tab, Check Certain callers have a higher priority 
than other callers.

2. Under Priority is stored in custom variable, do one of the following:

� Select an existing custom data variable.

� Click  to create a new custom data variable. For instructions see “Creating a 
custom data variable” on page 2-55.

Make sure the variable is of Data Type Long and has a Default value of 0. 

The variable you select here is the queue’s priority variable. 

3. In For each unit of the variable’s value add __ to the call’s score, enter the priority 
multiple. This number is multiplied by the value of a call’s priority variable to 
determine by how much the call’s score is increased.

4. Click OK to save the queue as you have defined it so far or go to the next section.

Assigning priority to calls
You assign priority to an incoming call by assigning a value to the custom data variable that you 
selected in the previous procedure. You can assign value to the variable using any of the 
following methods:

� With an auto attendant. Callers receive priority based on the phone number that they 
dial or menu choice they select. You could have a special phone number that you give 
out to your premier customers that gives them a high priority when they call that number. 
See Administering TeleVantage for more information about creating custom data 
variables.

� With an IVR Plug-in. Your IVR Plug-in application can assign priority based on analysis 
of the call (for example, you could give international callers a high priority) or based on 
information that the caller enters (for example, account number). See Administering 
TeleVantage for more information about creating custom data variables.

� With queue data entry. The queue can assign priority directly from a number that the 
caller enters (for example, you could give out customer numbers that range from 1 to 10 
and have the queue prompt callers to enter them). See “Setting up caller data entry” on 
page 2-42 for more information about creating custom variables.

� With the TeleVantage Call Classifier. This TeleVantage add-on application can benefit 
call centers in many ways. Among other things it can automatically assign priority to 
calls based on issue number, Caller ID, or caller identification against your company 
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database. For more information about the Call Classifier, see “Using the Call Classifier” 
on page 2-53.

Increasing a call’s score for skill matches
If you are using skill-based routing, you can increase a call’s score based on the available agents’ 
appropriate skills. See “Reducing wait time for calls with skill requirement matches” on 
page 3-11.

Setting up overflow agents ________________________________
Overflow agents are agents who receive calls from a queue only if the queue’s primary agents 
are all busy for a certain number of minutes. Overflow agents can be users whose main focus is 
another task, but who are available to take queue calls if needed. You can set up multiple tiers 
of overflow agents, so that tier 1 agents receive calls only when all primary agents are busy, 
tier 2 agents receive calls only when all primary agents and tier 1 agents are busy, and so on.

Calls are distributed among each tier of overflow agents according to the queue’s distribution 
algorithm. For example, if the algorithm is Top Down, the call rings the topmost ready primary 
agent. If all primary agents are busy, the call rings the topmost ready tier 1 agent. If all primary 
and tier 1 agents are busy, the call rings the topmost ready tier 2 agent, and so on.

Note: With the Simultaneous Ring algorithm, if the overflow wait time has been exceeded, the 
phones of all primary and overflow agents ring regardless of overflow level.

Setting up overflow agents consists of the following tasks:

� Assigning an overflow tier to agents

� Setting up the overflow wait time and options

Assigning an overflow tier to agents
To create overflow agents, first add them to the queue as you would normal agents (see “Adding 
agents to the queue” on page 2-11). When defining the agent on the General tab, set Overflow 
tier to the tier level you want. Tier 0 corresponds to a primary agent.

Note: You do not have to number tier levels sequentially. Only the order is important. For 
example, you could have tier levels 1, 5, 6, and 10.

Setting up the overflow wait time and options
To use overflow agents, set up how you system handles them, as follows:
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1. Click the Distribution \ Agent Filtering (Overflow) tab in the Queue dialog box.

2. Check Certain agents are only called when other agents are busy.

With this field unchecked, overflow tiers are ignored and all agents are treated as 
primary agents.

3. Set any of the following overflow options:

� Calls are distributed to overflow agent tiers after waiting __ seconds. 

This field determines how long calls wait for a primary agent before being sent to 
an overflow agent. For example, by default calls must wait 5 minutes without being 
answered by a primary agent before being sent to an overflow agent. 

You can choose whether or not the wait time applies individually to each overflow 
tier. See the Callers should wait option.

� If no agents in the current tier are signed in and available then immediately 
offer calls to the next tier. 

If checked, the queue bypasses the overflow wait time if no primary agents are 
signed in and available. In that case calls are sent immediately to overflow agents. 
Note that for purposes of this check, an agent in On Break status is considered to be 
available. For the bypass to occur, primary agents must all be either signed out or 
signed in with a personal status other Available, Available (Queue Only), or On 
Break.

The bypass also occurs between overflow tiers. For example, if all primary and tier 
1 agents are signed out, calls are immediately sent to tier 2 agents. If all primary, 
tier 1, and tier 2 agents are signed out, calls are immediately sent to tier 3.

Leave unchecked to use the wait time in all cases, even when a tier is signed out. 
For example, in the changeover between shifts there might be a moment when all 
primary agents are signed out, but you might still want calls to wait rather than 
ringing overflow agent phones.

� Callers should wait...

This choice determines whether the overflow wait time applies only once, or 
separately for each overflow tier.

� Choose Callers should wait a fixed amount of time for any available agent 
to apply the overflow wait time only once. If no primary agents answer during 
the wait time, the call is sent to the lowest-tier ready overflow agent, regardless 
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of what tier that might be. For example, if all tier 1 agents are On Break when 
the overflow wait time expires, the call is sent to a tier 2 agent.

� Choose Callers should wait longer for agents with higher skill values to have 
calls wait longer before being sent to higher overflow tiers. With this option 
selected, the wait time is multiplied by the tier level to determine how long a 
call must wait before being sent to that tier. For example, if the wait time is 5 
minutes, a call must wait 5 minutes before being sent to tier 1, 10 minutes before 
being sent to tier 2, 15 minutes before being sent to tier 3, and so on. 

Note that by changing the overflow tier value, you can increase the wait time 
for a tier. For example, if you define three overflow tiers with tier values of 1, 
2, and 10, then the wait times for the tiers would be 5 minutes, 10 minutes, and 
50 minutes. In this way you can refine the circumstances in which an overflow 
tier is pulled into queue activity.

4. Click OK.

Configuring expected wait time_____________________________
The queue continuously calculates the expected wait time for each caller. You can use expected 
wait time in the following ways:

� Announce it to callers as a courtesy to inform them of the expected wait. See “Creating 
Hold prompts” on page 2-36.

� Use it to determine whether or not a conditional Hold prompt plays to a caller. See 
“Creating conditional Hold prompts” on page 2-38.

� Automatically redirect new callers when the expected wait time is too high. See 
“Redirecting calls when the queue is too busy” on page 2-30.

About the expected wait time estimate
Expected wait time is an estimate based on how many agents are currently ready to take queue 
calls and the average length of a call. The formula is as follows:

6 + MinWaitTime + AvgCallLnth * (CallerPosition -1) / (max(AgentsAvailable, MinimumAgents))

Note: The formula uses whichever is larger, AgentsAvailable or MinimumAgents.

Parameter Description

MinWaitTime Minimum wait time if entered (see the next section)

AvgCallLnth Estimated average call length (see the next section)

CallerPosition Position of the caller in the queue (includes priority)

AgentsAvailable Number of agents currently signed in and in the personal status 
Available or Available (Queue Only).

MinimumAgents Minimum agent count if entered (see the next section)
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Example: in a queue with 10 available agents and an estimated average call length of 300 
seconds, with MinWaitTime of 60, the expected wait time for the fifth caller in the queue would 
be:

6 + 60 + 300 * (4 / 10) = 186 seconds (about 3 minutes).

This calculation is most reliable in a call center with many agents and short calls, and in which 
agents take calls from only one queue at a time. Though you can improve the estimate (see the 
next section), you should consider not using expected wait time if your call center has very few 
agents and long calls, or if most of your agents work in multiple queues at once.

Expected wait time and overflow tier levels
When calculating the expected wait time, TeleVantage includes overflow tiers if the wait time 
among primary agents only is longer than the overflow wait time. For example, if the expected 
wait time among primary agents is 5 minutes, and tier 1 overflow agents are activated after 3 
minutes, TeleVantage recalculates the expected wait time including primary and tier 1 agents. 
The process is then repeated for each overflow tier until the expected wait time is less than an 
overflow wait time or until all overflow tiers are included. The final expected wait time is then 
presented to the caller.

Improving the expected wait time estimate
You can improve the expected wait time estimate, and make queue behavior based on it 
smoother. To do so:

1. Choose the Distribution \ Expected Wait Time tab in the Queue dialog box.

2. Enter the following parameters:

� Minimum agent count. If you enter a minimum agent count, the expected wait time 
estimate will never be based on fewer available agents than this number, even if 
there are in fact fewer available agents. A minimum agent count makes the 
calculation more accurate over brief drops in agent availability.

For example, if the queue is redirecting calls based on expected wait time, it can be 
vulnerable to agents taking short breaks or a general shift changeover. With fewer 
available agents, even for a moment, the expected wait time rises and incoming 
calls may be redirected when there would have been agents available in a few 
minutes to take them. Entering a minimum agent count overcomes that problem.
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� Estimated average call length. This number is crucial to the accuracy of the 
expected wait time calculation. Enter the average length of a call in this queue, in 
seconds. Include only the talk time plus wrap-up time, not the wait time. To get the 
best estimate, use the Queue Monitor’s Avg. Talk Time statistic at the end of a 
period or shift (see “The Queue Statistics pane” on page 6-9), and the Activity 
History by Queue report (see “Activity History by Queue worksheet totals” on 
page 8-22). More importantly, base the number on your overall experience with the 
queue.

If you have agents who work in multiple queues, make this number higher to 
account for the time they spend in calls from other queues. In general you can adjust 
this number to correct for expected wait time inaccuracies. See the next section.

� Minimum wait time. If you enter a minimum wait time, the calculated expected wait 
time will never be less than this number, even when it otherwise would have been. 
Using a minimum wait time can avoid inaccurate results for the first callers into a 
queue. Note that if an agent is ready when a call enters the queue, the expected wait 
time is still 0 and the call is sent immediately to that agent.

3. Click OK to save the queue as you have defined it so far or go to the next section.

Correcting expected wait time inaccuracies
Various factors may cause the expected wait time calculation to consistently be too high or too 
low. For example, agents working in multiple queues at once can cause it to be too low. 

You can easily adjust the expected wait time result by adjusting the Estimated average call 
length number (see the previous section). Raising this number makes the expected wait time 
result higher; lowering it makes the result lower.

You can also adjust the 6 seconds that is added to the expected wait time (displayed at the 
beginning of the expected wait time calculation on page 2-27). To do so, add the following 
registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Artisoft\Televantage\Server\Settings\ExpWaitRingCycleLength

Specify the added time in milliseconds.

Announcing expected wait time in minutes and seconds
By default, the expected wait time prompt announces the wait time in minutes only. To have 
TeleVantage announce the expected wait time in minutes and seconds, add the following 
registry key to the TeleVantage Server and set it to 1:

HKeyLocalMachine\Software\Artisoft\TeleVantage\Server\Settings\PlayInSeconds
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Configuring the queue to redirect calls _______________________
You can define how incoming calls to the queue are handled in the following situations:

� When the queue is too busy (next section)

� When a call exceeds the maximum wait time (page 2-32)

� When the queue is closed (page 2-33)

� When there are no agents with matching skills (page 2-34)

Note: You can follow how many calls a queue is redirecting using the Redirection statistic in the 
Queue Monitor. See “The Queue Statistics pane” on page 6-9.

Redirecting calls when the queue is too busy
You can have the queue automatically divert new calls out of the queue when the queue hits a 
certain level of traffic that you define. For example, if the expected wait time is longer than 30 
minutes, you can play a message to callers telling them that the queue is currently too busy to 
accept new calls, then transfer them to another destination such as voicemail or your auto 
attendant.

To define redirect options when the queue is too busy 

1. Click the Redirection \ Queue Too Busy tab of the Queue dialog box.

2. To have the queue redirect calls when it becomes too busy, check Redirect callers if 
queue is too busy. If this field is unchecked, all incoming calls enter the queue 
regardless of how busy it is.
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3. To define the “too busy” threshold at which the queue begins to redirect new calls, 
choose any combination of the following options. New calls are redirected if any of 
the checked thresholds are met.

� If the number of waiting callers would exceed __. Check this option to redirect 
new calls if they would cause the number of calls in the queue to exceed the number 
you enter. Calls in the queue include those connected with agents as well as those 
waiting.

� If the expected wait time is more than __ seconds. Check this option to redirect 
calls when the expected wait time meets or exceeds the number of seconds you 
enter. For information on how the expected wait time is calculated and how to 
improve its accuracy, see “Configuring expected wait time” on page 2-27.

� If the number of queued callers exceeds __ times the number of available 
agents. Check this option to redirect calls when the number of calls waiting in the 
queue is greater than the number of available agents by the factor you enter. For 
example, if you enter 2 then redirection begins when there are twice as many calls 
waiting in the queue as available agents. Available agents are signed-in agents in 
the personal status Available or Available (Queue Only).

4. To play a message to callers who are about to be redirected, check Play this prompt 
before redirection. Use the audio controls to record or import the message.

5. To define how calls are redirected, choose one of the following options under Perform 
this action:

� Transfer the call to. Redirected calls are transferred to the extension you select.

� Send to voicemail. Redirected calls are transferred directly to the voicemail of the 
extension you select.

Note:If you chose to play a redirection message in step 4, the caller will hear the 
redirection message followed by the voicemail greeting. You can use the 
combination to create full messages. For example, the redirection message can say 
“I’m sorry, we’re temporarily closed,” and the voicemail greeting can add, “Please 
leave a message.”

� Hangup. Redirected calls are disconnected. 

6. Click OK to save the Queue as you have defined it so far or go to the next section.
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Defining a maximum wait time
You can have individuals calls automatically redirected when they have waited on the queue for 
a length of time that you define.

1. Click the Redirection / Maximum Wait Time tab of the Queue dialog box.

2. To redirect calls that meet the maximum wait time, check Redirect callers when they 
have waited too long. If unchecked, the maximum wait time has no effect.

3. Enter the maximum wait time in Maximum wait time.

4. To play a message to callers who are about to redirected, check Play this prompt 
before redirection. Use the audio controls to record or import the message.

5. To define how calls are redirected, choose an option under Perform this action:

� Transfer the call to. Redirected calls are transferred to the extension you select.

� Send to voicemail. Redirected calls are transferred directly to the voicemail of the 
extension you select.

� Hangup. Redirected calls are disconnected. 

6. Click OK to save the Queue as you have defined it so far or go to the next section.
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Redirecting calls when the queue is closed
This section describes how to redirect incoming calls when the queue is closed. To close the 
queue, use the Queue is closed checkbox on the Distribution tab (see “Closing the queue” on 
page 2-8). You can also have the queue close automatically whenever there are no agents signed 
in, as described in the following steps.

1. Click the Redirection \ Queue Closed tab of the Queue dialog box.

2. To have the queue close automatically when no agents are signed in, check Close 
queue if no agents are signed in. 

Note: Agents On Break will not cause the queue to close. For the queue to close, all 
agents must be either signed out, or in a personal status other than Available, Available 
(Queue Only), and On Break.

If the queue closes for this reason, it will reopen automatically when an agent signs in. 
You can also reopen it manually by unchecking this field.

Note: This field does not affect the Queue is closed checkbox on the Distribution tab. 
For example, if that field is checked the queue remains closed regardless of how many 
agents are signed in or out.

3. To play a message to callers who are about to redirected, check Play this prompt 
before redirection. Use the audio controls to record or import the message.

4. To define how calls are redirected, choose an option under Perform this action:

� Transfer the call to. Redirected calls are transferred to the extension you select.

� Send to voicemail. Redirected calls are transferred directly to the voicemail of the 
extension you select.

� Hangup. Redirected calls are disconnected. 

5. Click OK to save the Queue as you have defined it so far or go to the next section.
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Redirecting calls when there are no matching skills
This section describes how to redirect incoming calls when none of the signed-in agents in the 
queue have skills that match that call’s skill requirements. For more about using skills-based 
routing, see Chapter 3.

Note: If you have set the queue to reduce calls’ skill requirements over time (see “Adjusting skill 
requirements over time” on page 3-9), then calls are not redirected for lack of matching skills. 

1. Click the Redirection \ No Matching Skills tab of the Queue dialog box.

2. To have the queue redirect callers for whom no agents with matching skills are signed 
in, check Redirect call if all signed-in agents do not meet the call’s skill 
requirements.

3. To play a message to callers who are about to redirected, check Play this prompt 
before redirection. Use the audio controls to record or import the message.

4. To define how calls are redirected, choose an option under Perform this action:

� Transfer the call to. Redirected calls are transferred to the extension you select.

� Send to voicemail. Redirected calls are transferred directly to the voicemail of the 
extension you select.

� Hangup. Redirected calls are disconnected. 

5. Click OK to save the Queue as you have defined it so far or go to the next section.

Setting up the caller’s hold experience _______________________
You can configure the following aspects of the caller’s experience while waiting on the queue:

� Setting up hold music

� Configuring hold and park ringback

� Offering the caller options while waiting on the queue

� Creating Hold prompts
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Setting up hold music
By default, callers waiting on this queue hear the hold music that you have specified for the 
system as a whole (see Administering TeleVantage). Optionally, you can have each queue play 
hold music from a different music-on-hold device. To do so:

1. Click the Hold tab of the Queue dialog box.

2. Check Change hold music to and select a music-on-hold source from the dropdown 
list. See Administering TeleVantage for instructions on adding music-on-hold sources.

If unchecked, callers hear the system hold music while they are waiting.

3. Click OK to save the Queue as you have defined it so far or go to the next section.

Configuring hold and park ringback
If an agent places a queue call on hold or parks it, you can have TeleVantage automatically ring 
the agent’s phone after a certain amount of time to reconnect him or her with the call. To do so:

1. Click the Hold tab of the Queue dialog box.

2. Check Ring back if an agent leaves a call on hold or parked for over __ seconds, 
and enter the number of seconds before ringback occurs.

3. Click OK to save the Queue as you have defined it so far or go to the next section.

Offering the caller options while waiting on the queue
You can give waiting callers the ability to redirect themselves out of the queue to another 
extension or voicemail. To do so:

1. Click the Hold \ Special Keys tab of the Queue dialog box.

2. Under Special keys, check any of the following options to offer them to waiting 
callers:

� Leave voicemail key. Available only if the queue has a voice mailbox (see “Setting 
up the queue’s voice mailbox” on page 2-40). Callers can press a key to stop 
waiting and be transferred to the queue’s voice mailbox. Select the key that you 
want callers to press.

� Transfer out of queue key. Callers can transfer out of the queue to a destination 
you define. This destination can be a supervisor’s voice mailbox, an auto attendant, 
another queue, or any other extension. Select the key that you want callers to press 
and then select the transfer destination under The caller will be transferred to.

Note: If you offer callers these options, you should mention them in your queue’s 
Welcome prompt or in a Hold prompt.

3. Use the Conserve voice resources on supported telephony boards check box to 
reduce voice resource use by making the special keys active only while Hold prompts 
are playing. 

Note: This field does not apply if your system uses Springware analog trunk boards, 
including the D/120JCT, D80SC4LS, D160SC8LS, D41ESC, D41JCT, and VFX41 
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boards. On all other telephony boards, the field works as described.

When checked, if a caller presses special keys between prompts—for example, during 
hold music—the system does not respond. A voice resource is allocated to a waiting 
caller only while a prompt plays for that caller. Because prompts play to different 
callers at different times, only a few voice resources are needed to support several 
waiting callers.

If you check the field, be sure to record a few seconds of silence at the end of each 
prompt so that callers have enough time to press the keys before the keys become 
inactive. See “Creating Hold prompts” on page 2-36.

If unchecked, the special keys are active at all times, even during hold music and 
silence. The system allocates one voice resource to each waiting caller for the entire 
wait time, and callers can press the special keys at any time.

For more information about voice resources, see Appendix A of Installing 
TeleVantage.

4. Click OK to save the Queue as you have defined it so far or go to the next section.

Creating Hold prompts
You can make one or more recordings for callers to hear while waiting, for example, to reassure 
them that they are still in the queue. You can choose to have a Hold prompt play only once, play 
on a repeating basis, or play only when a certain condition has been met. A Hold prompt might 
say, “Your call is very important to us. Please wait for the next available representative.”

Hold prompts are listed on the Hold tab under Hold prompts. They are listed in the order that 
they play to callers. While the caller is waiting, TeleVantage plays the Hold prompts from the 
top to the bottom of the list—with customizable pauses between them—and then repeats the 
cycle, starting at the top again. The cycle of Hold prompts repeats as long as the caller remains 
waiting.

You can choose whether a Hold prompt is part of the repeat cycle or whether it is played to the 
caller only once. If it is played only once, TeleVantage plays it the first time through the cycle 
and then skips it on subsequent cycles.

Note: If the system hardware has no voice resources available when a prompt would normally 
play to a caller, the prompt is delayed slightly until a voice resource becomes available. An entry 
appears in the Windows Event Log if this occurs (see Administering TeleVantage).

For instructions on recording a Welcome prompt, which plays callers once when they first enter 
the queue, see “Creating a Welcome prompt for the queue” on page 2-46.
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To create a Hold prompt

1. Click the Hold \ Prompts tab in the Queue dialog box. The tab shows existing Hold 
prompts in the order that they play to the caller.

2. Click Add. The Hold Prompt dialog box opens.

3. Under General, enter the following information about the Hold prompt:

� Prompt name. A descriptive name for the prompt.

� Seconds before this prompt. The amount of time between the end of the previous 
prompt and the playing of this prompt. If you set this to 0, callers will not hear hold 
music before this prompt, even if it is the first prompt.

� Play this prompt every repeat cycle. Check to have this prompt play every time 
in the repeat cycle. Uncheck to have the prompt play only once. If unchecked, the 
prompt will play only the first time through the cycle (unless it is a conditional 
prompt that does not play at all because the required condition has not been met).

4. Under Play this audio, choose one of the following options for the Hold prompt 
recording:

� Prompt. Record the Hold prompt yourself using the audio controls. See 
Administering TeleVantage for instructions. Enter the text of the prompt or a 
description in the text field.

Note:If you are offering special-key options in this queue, with the special keys 
active only during prompts, then you should record a few seconds of silence at the 
end of each Hold prompt to give callers time to press the special keys before they 
become inactive. See “Offering the caller options while waiting on the queue” on 
page 2-35.
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� Sentence: Queue length. Choose this option to play the prerecorded message: 
“There are <number> callers waiting ahead of you,” where <number> is the number 
of callers that TeleVantage detects are ahead of a caller in the queue. If there is no 
one ahead of the caller in the queue, the message changes to: “Your call will be 
handled by the next available agent.”

� Sentence: Wait time. Choose this option to play the prerecorded message: “The 
expected wait time is <number> minutes” where <number> is the number of 
minutes that TeleVantage estimates will elapse before the call is answered. For 
information on how TeleVantage calculates this number, and how to make it more 
accurate, see “Configuring expected wait time” on page 2-27.

Note:You can have the expected wait time announce minutes and seconds instead 
of just minutes. See “Announcing expected wait time in minutes and seconds” on 
page 2-29.

5. Optionally, select or create a condition under which this Hold prompt plays. See the 
next section, “Creating conditional Hold prompts.” 

6. Click OK to add the Hold prompt to the list on the Hold \ Prompts tab.

7. Click OK to save the queue as defined so far or go to the next section.

Creating conditional Hold prompts
You can create Hold prompts that play only when a certain condition is met. For example, if the 
estimated wait time on the queue is 10 minutes or longer, you could play a prompt that says, 
“We are currently experiencing a heavy volume of calls. We recommend that you call back later 
or leave a voice message.” 

Conditional Hold prompts can either repeat in the repeat cycle or play only once. If they repeat, 
the condition is checked each time through the cycle. For example, a prompt that played when 
the estimated wait time was over 10 minutes would repeat until the wait time dropped below 10 
minutes and then stop playing.

To create a conditional Hold prompt

1. On the Hold \ Prompts tab in the Queue dialog box, click Add. The Hold prompt dialog 
box opens.

2. Enter the general information and create the audio for the Hold prompt as shown in the 
previous section. 

3. Check Use the following condition.

4. From the Condition variable dropdown list, select the custom data variable whose 
value the system will use to determine if the prompt plays. 

TeleVantage comes with two predefined custom data variables to be used as Hold 
prompt conditions:

� Number of people ahead. Returns the number of waiting callers who entered the 
queue before this one.
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� Expected Wait Time. Returns the estimated number of seconds until the call is 
answered. For information on how TeleVantage calculates this number, and how to 
make it more accurate, see “Configuring expected wait time” on page 2-27.

You can also create your own condition variable by clicking  next to the Condition 
variable field. See the next section, “Using custom data variables to play conditional 
Hold prompts.” 

5. In Minimum variable or value and Maximum variable or value, enter the minimum 
and maximum values that will cause the prompt to play. The prompt plays if the value 
is >= the minimum and <= the maximum.

For example, to play the prompt when the expected wait time is 10 minutes or more, 
select Expected wait time and set Minimum variable or value to 600 (600 
seconds=10 minutes). If you are using a custom variable of Account Number (see the 
example in the next section), you could set the prompt to play for callers with a 
Account Number value within a specific range.

6. Click OK.

Using custom data variables to play conditional Hold prompts
Whatever variable you select in the Condition variable field of the Hold prompt dialog box is 
the one whose value is used to determine whether the prompt plays. You can create your own 
custom data variables and use them to trigger Hold prompts. For instructions on creating a 
custom data variable, see “Creating a custom data variable” on page 2-55.

Example: By creating a variable called Account Number, you can play a Hold prompt only for 
certain customers, such as your newest customers. First, you prompt callers to enter their 
account numbers, which you store in the Account Number variable (see “Setting up caller data 
entry” on page 2-42). Then you create a conditional Hold prompt that plays only if Account 
Number is within a certain range. A range of 1000 to 2000 might represent your newest 
customers, and you could specify that range for your Hold prompt, which would play only for 
your newest customers.

Note: Text variables are sorted alphabetically and so can have a “range,” for example A-E. A 
range of A-E means that the Hold prompt will play if the variable value begins with an A, B, C, D, 
or E.

You can also use auto attendant menu choices and IVR Plug-ins to pass custom variables to a 
queue and use those variables as Hold prompt condition variables. See “Using IVR Plug-ins 
with a call center queue” on page 2-53. For more information, see Administering TeleVantage.
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Setting up the queue’s voice mailbox ________________________
The queue can have its own voice mailbox and can receive voice messages if you give callers 
the option of leaving voicemail instead of waiting in the queue (see “Configuring call 
distribution” on page 2-18). 

With the proper permissions, agents can see the queue’s voice mailbox (in addition to their own 
mailboxes) using ViewPoint’s voicemail folders. See Using TeleVantage for instructions. Users 
can also log on to the queue’s account over the phone by using the telephone commands.

Note: To access the queue’s voice mailbox, agents must have the Access queue mailbox 
privilege. See “Agent permissions” on page 2-14.

If you do not want queue callers to leave voicemail, select No mailbox on the Voice Mail tab 
(see the next section).

Setting mailbox size and maximum message length
To define size limits for the voice mailbox and individual voice messages, do the following:

1. Click the Voice Mail tab of the Queue dialog box.

2. To give the queue a voice mailbox, click Mailbox with __ minutes max size, and enter 
the size of the mailbox.

To have a queue without a voice mailbox, click No mailbox.

3. Enter the maximum amount of voice message minutes that the queue’s mailbox can 
hold in Maximum size of mailbox (minutes). A minute of voice recording occupies 
roughly .5 MB of disk space. If the voice mailbox is full, it cannot accept new voice 
messages. The maximum size is 999,999 minutes.

Note: If you expect to keep thousands of voice messages in the queue’s mailbox you 
should configure TeleVantage to automatically archive the recordings in the queue 
mailbox, and use the Archived Recording Browser instead of ViewPoint to manage and 
listen to the recordings.  See Chapter 4 of Administering TeleVantage for instructions on 
archiving recordings, and Appendix E of Using TeleVantage for instructions on using the 
Archived Recording Browser.

4. Enter the maximum length in seconds for any voice message in Maximum message 
length (seconds). When a voice message reaches the maximum, it is cut off and the 
caller hears the message option prompts.

5. Click OK to save the queue as defined so far or go to the next section.
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Synchronizing with Microsoft Exchange server
To enable synchronization of the queue’s voice messages with the corresponding e-mail 
notifications in Microsoft Exchange, do the following:

1. Click the voicemail tab of the Queue dialog box.

2. Check Synchronize with Exchange server mailbox. If this control is disabled, you 
must first set up Exchange server notification (see Administering TeleVantage).

3. Enter the name of the queue’s Exchange server mailbox. You can obtain this name 
from Microsoft Exchange.

Note: Exchange server mailboxes should not be confused with the e-mail address 
supplied when setting up e-mail notification for the queue (see “Setting up voicemail 
notifications” on page 2-41). One of the e-mail addresses specified for the queue for 
e-mail notification must route e-mail to the Exchange server mailbox that you specify 
here.

4. Click OK to save the queue as defined so far or go to the next section.

For more information about synchronization with Microsoft Exchange, see Administering 
TeleVantage.

Setting up voicemail notifications
TeleVantage can automatically notify you by e-mail, pager, or call whenever the queue receives 
a new voice message. Click the voicemail \ Notification tabs to set up notification of new queue 
voice messages. The feature is identical to the notification feature for users (see Administering 
TeleVantage or Using TeleVantage).
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Setting up caller data entry _________________________________
You can set up the queue to prompt callers to enter data by using the keys on their telephones. 
Data entry prompts play immediately after the Welcome prompt. You can, for example, prompt 
callers to enter their customer identification numbers. The data is stored in a custom data 
variable that you define. The data accompanies the call, and you can then use the data in the 
following ways:

� As a condition for a Hold prompt to play. See “Using custom data variables to play 
conditional Hold prompts” on page 2-39.

� As a column displayed in agents’ Call Monitors.

You can create as many data entry prompts as you want. They play in the order that they are 
listed on the Entry tab of the Queue dialog box. To move a data entry prompt up or down in the 
list, click the arrows to the right of the list.

To prompt the caller to enter data

1. Click the Caller Entry tab in the Queue dialog box.

2. Click Add. The Queue Entry dialog box opens.

3. In Name, enter a name for the data that you are collecting.

4. Under Prompt that explains the digits to enter, type the text of the prompt or a 
description of it.
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5. Use the audio controls to record the prompt that tells the caller to enter data. See 
Administering TeleVantage for instructions. For example, “Please enter your customer 
ID number followed by the pound key. If you don’t have a customer ID number, just 
press the pound key.” 

Note: While callers are entering data, they can press * and they will return to the 
previous data entry prompt. If callers press * during the first data entry prompt, they can 
choose to end the call or stay on the line. If they choose to stay on the line, they are 
transferred either to the auto attendant (if they started there) or to the queue operator 
(if they dialed the queue directly). You can optionally describe these options in your data 
entry prompts.

6. Specify the following optional information about the data entry:

� Terminate after an exact number of digits. If the data must be an exact length, 
check this box and enter the number of digits.

� The following digit will terminate input. To speed up data entry, check this box 
and select a key for callers to press when they have finished entering digits. The 
terminate key is usually #. Be sure to mention this key in the prompt that you record. 
If you do not specify a terminate key, TeleVantage assumes the data is complete 
whenever the caller exceeds the Maximum number of seconds between digits 
setting.

� Number of seconds allowed for input. Specify the length of time within which the 
caller can enter the data. If the caller does not complete data entry within that time, 
TeleVantage attempts to validate the data. If you are not validating the data (see 
“Validating caller data” on page 2-43), the call proceeds into the queue without any 
data.

� Maximum number of seconds between digits. Specify how long callers can 
pause while entering digits. If the caller exceeds that pause, TeleVantage assumes 
that the data entry is complete.

7. In the Store digits in custom variable dropdown list, select the custom variable that 
will hold the data entered by callers. To create a new custom variable, click  next 
to the list (for instructions see “Creating a custom data variable” on page 2-55). 

8. Click OK to return to the Entry tab in the Queue dialog box. 

9. Click OK to save the queue as defined so far or go to the next section.

Validating caller data
The queue can validate the data or accept it exactly as the caller enters it. When you validate 
data, you are checking it for accuracy.
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To set up validation for data entry

1. Click the Caller Entry tab in the Queue dialog box.

2. Click Add. The Queue Entry dialog box opens. Click the Validation tab in the Queue 
Entry dialog box.

3. In Minimum number of digits, enter a number. The length of the data must be equal 
to or greater than the number that will be validated. If the length of the data is less than 
the number in this field, the caller will be prompted to enter the data again.

4. In Maximum number of retries, enter the maximum number of times the caller can 
reject an entry and enter it again. For what happens to callers who fail the maximum 
number of retries, see step 6.

5. Choose either or both of the following methods of validating data:

� Check Ask the caller to confirm the digits entered to have TeleVantage repeat the 
caller’s entry back to them and prompt the caller to confirm that the number is 
correct. If the entry is incorrect, the caller can enter it again.

� Check Validate data according to range to compare the entry made to an 
acceptable range of values. To use this method, enter the minimum acceptable value 
in The minimum value allowed is, and enter the maximum acceptable value in The 
maximum value allowed is. If the entry falls within the range, it is validated. If it 
falls outside the range, the caller is prompted to enter it again.

6. Choose how to handle callers whose data is not validated after a specific number of 
attempts. Under After the maximum number of retries, choose one of the following 
options:

� Continue. Continue with the next data entry prompt. If this is the last data entry 
prompt, place the caller on the queue without any data associated with the call.

� Hangup. Terminate the call.
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� Transfer to. Select the destination to which the caller is transferred.

7. Click OK to return to the Entry tab in the Queue dialog box. 

8. Click OK to save the queue as defined so far or go to the next section.

Note: If you need more validation or data entry options, use the TeleVantage Call Classifier, 
which can prompt callers for any numeric information, validate it based on any ODBC database, 
then send the resulting profile information to the agent. See “Using the Call Classifier” on 
page 2-53. 

Managing the queue’s security _____________________________
Use the options on the Security tab of the Queue dialog box to protect the queue’s account and 
your TeleVantage system from unauthorized access and toll fraud. For more information about 
toll fraud, see Appendix C of Administering TeleVantage.

The following security options are available:

� Password never expires. If checked, the queue’s password does not expire, although 
you can always manually change it or force it to be changed. If unchecked, the password 
may expire as determined by your system settings (see Administering TeleVantage). 

Note: Checking this field is a security risk, as long-standing passwords are easier to 
guess.

� Password must be changed on next logon. If checked, the system requires the 
password to be changed the next time someone logs on to the queue’s account, using any 
workstation application or the telephone commands.

� Queue is locked out. If checked, the queue’s account cannot log on to the system, even 
with the correct username and password. Depending on your system settings, lockout 
can occur automatically if someone repeatedly tried and failed to log on to the account. 
Uncheck the field to unlock the account and permit normal logging on.
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Managing the queue’s audio recordings ______________________
In addition to Hold prompts (see “Creating Hold prompts” on page 2-36), you can configure and 
record the following audio messages for the queue:

� Telephone prompts. You can choose the language in which the system’s telephone 
prompts play for callers to the queue. 

� Voice Title. A queue can have a voice title like a user, a recording of its name that 
TeleVantage plays to callers during transfers and other operations.

� Welcome prompt. A Welcome prompt is a message played once to all callers when they 
first reach the queue.

� Greetings. You can record greetings for the queue’s voice mailbox.

Choosing the language for the queue’s telephone prompts
1. Click the Audio tab of the Queue dialog box.

2. From the Telephone prompts dropdown list, choose the language in which the 
telephone prompts play to callers to the queue. The list shows the languages that you 
have installed with TeleVantage. For information about installing new languages, see 
Installing TeleVantage.

3. Click OK to save the queue as defined so far or go to the next section.

Recording a voice title for the queue
1. Click the Audio \ Voice Title tab of the Queue dialog box.

2. Use the audio controls to record the voice title. See Administering TeleVantage for 
instructions. The voice title should be a short recording of only the queue’s name.

3. Click OK to save the queue as defined so far or go to the next section.

Creating a Welcome prompt for the queue
Callers hear the Welcome prompt once when they reach the queue. It might say, “Thank you for 
calling Julep technical support. Please hold. The next available agent will be with you shortly.”

To record a Welcome prompt for the queue

1. Click the Audio \ Welcome Prompt tab of the Queue dialog box.

2. Type the text of the prompt or a description of it.

3. Record the Welcome prompt using the audio controls. See Administering TeleVantage 
for instructions.

4. Click OK to save the queue as you have defined it so far or go to the next section.
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Warning callers that their calls may be recorded
In some U.S. states it is illegal to record a call without notifying the caller. TeleVantage provides 
a professionally-recorded prompt, MayBeMonitored.vox, that you can import as a Welcome 
prompt. It says, “Your call may be monitored or recorded.” By default the prompt is in the 
following location:

C:\Program Files\Televantage Server\vfiles\EN00\MayBeMonitored.Vox

You can also include a beep on calls that are being recorded. See Chapter 4 of Administering 
TeleVantage.

Creating voicemail greetings for the queue
You can create and store as many different voicemail greetings as you want, and you can easily 
change the active greeting, which is the one played to callers who reach the queue’s voicemail. 
The greetings appear on the Audio \ Greetings tab of the Queue dialog box. The active greeting 
appears in bold.

Enabling callers to leave a callback phone number
While leaving voicemail, callers can press 7 and then enter a phone number at which an agent 
can call them back. If callers use this feature, agents can call them back quickly by selecting the 
message in any Voice Messages folder and choosing Speed Dial. This method of getting 
callback numbers is often a better alternative to asking callers to record their own phone 
numbers on the voice message.

If you want callers to enter a callback phone number, record instructions for how to do so in your 
voicemail greeting. For example, your greeting might say, “We’re sorry no one was available to 
take your call. To leave a message and have an agent call you back, press 7." Callers can press 
7 during your greeting, while recording their message, or after recording their message.

Note: Entering a callback number while recording the message ends the message. However, 
the caller can then add more to the message by pressing 4.

To create a voicemail greeting

1. Click the Audio \ Greetings tab of the Queue dialog box.

2. Click Add. The Greeting dialog box opens.
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3. Under Name, enter a name for the greeting.

4. Under Contents, type the text of the greeting or a description of it.

5. Record the greeting using the audio controls. See Administering TeleVantage for 
instructions.

6. Click OK to save the greeting, which will now appear in the list on the 
Audio \ Greetings tab.

7. To make this greeting the active greeting, click Set Active on the Audio \ Greetings 
tab.

8. Click OK to save the queue as you have defined it so far or go to the next section.

Setting a maximum size of greetings
In Maximum size of greetings (minutes) on the Audio \ Greetings tab, enter the maximum 
number (in minutes) for all voicemail greetings for the queue.

Automatically recording queue calls _________________________
You can have TeleVantage automatically record a queue’s calls on a periodic basis. The 
recorded calls appear as new voice messages in the voice mailbox that you select. The system 
records both inbound and outbound queue calls.

To automatically record all calls in the TeleVantage system, queue or otherwise, use system call 
recording as described in Administering TeleVantage.

Notes

� In some U.S. states, it is illegal to record a call without notifying the caller. If you are using 
TeleVantage in such a state, your queue’s Welcome prompt should inform callers that 
their calls may be recorded. See “Warning callers that their calls may be recorded” on 
page 2-47.

� You can include a repeating beep on queue call recordings to indicate to the agent and 
caller that the call is being recorded. See Chapter 4 of Administering TeleVantage.

� If you expect to keep thousands of voice messages in the queue's mailbox you should 
configure TeleVantage to automatically archive the recordings in the queue mailbox, and 
use the Archived Recording Browser instead of ViewPoint to manage and listen to the 
recordings.  See Chapter 4 of Administering Administering TeleVantage for instructions 
on archiving recordings, and Appendix E of Using TeleVantage for instructions on using 
the Archived Recording Browser.

To record a queue’s calls

1. Click the Recording tab of the Queue dialog box.

2. Check Automatically record queue calls.
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3. In Record 1 call out of every, enter a number. Enter 1 to record every call, 2 to record 
every other call, 3 to record every third call, and so on.

Note: A call is considered a “queue call” for counting purposes only if the call was 
placed or answered by an agent in that queue. Calls transferred into that queue, for 
example, are not counted.

4. From the Recording direction dropdown list, select whether to record inbound calls 
only, outbound calls only, or both. Selecting both means that you get one recording per 
n calls regardless of the calls’ direction.

5. From the Send queue call recordings to dropdown list, select the mailbox that will 
receive the call recordings as new voice messages.

6. From the When mailbox is full dropdown list, select what happens if the destination 
mailbox is full when TeleVantage attempts to store a new recorded message there:

� Discard new call recording. TeleVantage deletes the new call recording instead of 
storing it.

� Delete oldest call recording. TeleVantage deletes the oldest call recording in the 
mailbox to make room for the new recording. Only call recordings can be deleted 
by this method. Voice messages are never deleted this way.

7. Click OK to save the queue as you have defined it so far or go to the next section.

You can also automatically record an individual agent’s calls. See “Automatically recording an 
agent’s calls” on page 2-13.

Stopping recording for calls transferred out of the queue
By default, when the queue is set to record calls, incoming queue calls that are then transferred 
out of the queue continue to be recorded. You can change this behavior so that recording stops 
as soon as the call leaves the queue.

To stop recording calls when they leave the queue

1. Add the following new (DWORD) registry key:

HKLM\Software\Artisoft\TeleVantage\Server\Settings\6E23WK 

2. Set the value of this key to 1.

3. Restart the TeleVantage Server.
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Collecting queue statistics _________________________________
TeleVantage call centers record a wide variety of statistics that measure caller experience and 
agent effectiveness. Agents with the required permission can view real-time queue statistics by 
using ViewPoint’s Queue Monitor folder. See “Monitoring queue statistics” on page 6-3.

In the TeleVantage Administrator, you can set the following options for how statistics are 
displayed:

� The statistics period

� Shifts

Both are used for display purposes only, to compare previous with current performance. The 
Queue Monitor displays statistics for the previous period and current period, and for the 
previous shift and current shift. 

Defining the statistics period
Click the Statistics tab of the Queue dialog box and use the Statistics period dropdown list to 
select how often the statistics period changes. The statistics period defines a length of time that 
you use to compare performance throughout the day. For example, if you set the statistics period 
to one hour, the Queue Monitor displays totals for the previous hour and the current hour.

Configuring shifts
ViewPoint shows agent statistics by shift. It shows queue statistics for the current shift and the 
previous shift. These shifts are arbitrary divisions of the workday that you define for the sole 
purpose of grouping statistics for display. For example, you can break the workday into a 
morning shift and an afternoon shift. During the afternoon you can then view the statistics for 
the ongoing afternoon shift and compare them to the statistics for the morning shift.

Defining shifts is unrelated to scheduling agent work periods, which is something you do outside 
of TeleVantage. It can be helpful to define your shifts that govern statistics display so that they 
match your company’s actual work schedules, but it is not required.

To break the workday into shifts for statistics display

1. Click the Statistics \ Shifts tab of the Queue dialog box.

2. Click Add. The Shift dialog box opens.

3. Enter the beginning time and end time of the shift in Start time and End time. 

Note: The duration of a shift must be greater than the statistics period of the queue.
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4. Click OK.

5. Repeat to add as many shifts per day as you want. 

6. When you are done adding shifts, click OK to close the Queue dialog box.

Note: It is recommended that you configure one shift to begin on the same minute that another 
one leaves off, for example a 9:00 AM - 12:00 PM shift followed by a 12:00 PM - 5:00 PM shift. If 
you leave a gap between shifts, calls that begin and end in the gap will not be included in the 
Queue Monitor totals.

Setting up a menu choice for a queue _______________________
When your queue is ready to be used by the public, you can create a menu choice that transfers 
callers to the queue from your company’s main auto attendant. For example, your menu choice 
could be, “For sales, press 2."

You can also give the queue a full phone number, so that callers can dial it directly. To do so, 
give it a DID number on the General tab (see “Entering general information about a queue” on 
page 2-7). Your phone lines must support DID to use this option. You can also direct a trunk 
line to the queue (see Administering TeleVantage). 

To set up a menu choice in an auto attendant for a queue

1. In the Administrator, open the Auto Attendants view and double-click the auto 
attendant that you want to use to offer the queue to callers. The Auto Attendant dialog 
box opens.

If you have multiple auto attendants, perform these steps for each one on which you 
want to offer callers the choice of transferring to the queue.

2. Click the Menu Choices tab.
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3. Click Add. The Edit Menu Choice dialog box opens. 

4. Record the prompt that you want callers to hear as part of your main menu, for 
example, “For the Sales department, press 2.”

5. From the When Caller Presses dropdown list, select the key that you want callers to 
press to be transferred to the queue. 

6. Do one of the following in the Perform Action dropdown list:

� Select Transfer to Queue and select the queue to which you want to transfer callers.

� If you are using a utility user to transfer calls to the queue, select Transfer to user 
and select the utility user. See Chapter 4 for instructions on using a utility user. 

7. Click OK in the Edit Menu Choice dialog box.

8. Click OK in the Auto Attendant dialog box.
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Using IVR Plug-ins with a call center queue___________________
An IVR Plug-in is a custom application that acts as an extension on the TeleVantage system. 
You can use an IVR Plug-in to answer incoming calls to a call center queue. You also can 
capture caller information such as customer ID, address, and so forth by using an IVR Plug-in. 
You can then pass that information to the queue in the form of custom variables. The queue can 
use that information in the following ways:

� The information can be presented to agents in their Call Monitor folders.

� You can pass call priority to the queue. See “Giving some calls higher priority” on 
page 2-23.

� You can create conditional Hold prompts that play based on the information. See “Using 
custom data variables to play conditional Hold prompts” on page 2-39.

Passing information from an IVR Plug-in to a queue
TeleVantage passes information from an IVR Plug-in to a queue by means of custom variables. 
As long as the same variable exists in both the IVR Plug-in and the TeleVantage queue, the 
information is automatically passed to the queue from the IVR Plug-in. 

To pass information from an IVR Plug-in to a queue

1. Create an IVR Plug-in that answers calls to the queue and then passes them to the 
queue.

For instructions, see TeleVantage Developer’s Guide, available as a PDF file, 
TvSDK.pdf. The default location of the file is C:\Program Files\TeleVantage 
SDK\TvSDK.pdf on the TeleVantage Server computer.

2. Create a custom variable in the IVR Plug-in and set its value using the 
SetCustomPartyData or GetCustomPartyData methods. Make a note of the custom 
variable’s name.

For instructions, see TeleVantage Developer’s Guide.

3. Create a custom variable in the queue that has the same name as the variable in the IVR 
Plug-in. When you type the name, match uppercase and lowercase letters. 

For instructions, see “Creating a custom data variable”  in the next section.

Using the Call Classifier
The TeleVantage Call Classifier is a powerful TeleVantage Add-on Solution that can greatly 
improve the productivity of call centers. It connects with TeleVantage as an IVR Plug-in and 
can identify callers, intelligently route calls, and present call center agents with scripts and 
related caller information before they answer the phone.
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To display detailed caller information on agents’ screens, the Call Classifier can query any 
ODBC-compliant database (for example, Microsoft Access, SQL Server, Excel, Oracle, etc.) or 
the ThinkDirectMarketing DigitalDATA service of more than 120 million North American 
businesses and residences. In addition the Call Classifier can verify caller data and route callers 
to the optimal agent using custom business rules.

For more information about the Call Classifier, see www.artisoft.com or contact your 
TeleVantage provider.

Managing custom data variables ____________________________
Custom data variables let you attach any kind of information to incoming calls. Each custom 
data variable represents a different field of information—for example, caller priority—and the 
value of that variable can be set individually for each incoming call—for example, each call can 
have a different priority value. 

You can use custom data variables with a call center queue in the following ways:

� To determine whether a Hold prompt plays. See “Creating conditional Hold prompts” 
on page 2-38.

� To give high-priority callers less wait time. See “Giving some calls higher priority” on 
page 2-23.

� To prompt callers to enter information that is then displayed to agents. See “Setting up 
caller data entry” on page 2-42.
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Creating a custom data variable
Use the following procedure to create a custom data variable for any of the above uses:

1. Choose Tools > System Settings. The System Settings dialog box opens.

2. Choose the Call Data \ Custom Data tab. The tab shows any existing variables.

Note: TeleVantage comes with two pre-defined custom data variables, Expected wait 
time and Number of people ahead. For instructions on using them with conditional Hold 
prompts, see “Creating conditional Hold prompts” on page 2-38.

3. Click Add. The Custom Data dialog box opens.

4. Enter the following information:

� Name. Enter the variable’s name. If you are using a variable that is passed from an 
IVR Plug-in, be sure to spell the variable name correctly. Upper and lower case 
letters are important.

� Description. Enter a description that helps you remember the purpose of the 
variable.
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� Data type. Choose one of the following:

� Long. The variable holds integer numbers only.

� Double. The variable can hold integer numbers or decimal point numbers.

� Boolean. The variable can hold the numbers 0 or 1 only.

� String. The variable holds text. 

Note:If you are creating a custom data variable to set caller priority, select type 
Long.

� Default value. The variable will be set to the value you enter for every caller that 
enters the queue, if it has not received a value elsewhere.

5. Click OK. The variable appears in the list.

6. Click OK to close the System Settings dialog box. 
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About skills-based and custom routing_______________________
Skills-based and custom routing let you go beyond the predefined algorithms for distributing 
calls to agents. You can define your own system for how a queue chooses an agent for a given 
call, based on any combination of the following:

� Skills. Calls have varying skill requirements attached and are routed to agents with the 
matching skills. For example, Spanish callers within a queue are routed to 
Spanish-speaking agents. Skills are a powerful way to maximize your call center 
resources by making sure calls go to the agents who are best equipped to handle them.

� Cost. You can factor the cost of an agent into call distribution. For example, you may 
want your most expensive agents to take fewer calls, freeing them to work on other tasks. 
Alternatively, you may want your most expensive agents to take the most calls, since 
they have the most expertise.

� Other agent attributes. You can define custom attributes for agents that affect call 
distribution. For example, you can have an attribute that represents “Time with 
company” so that your newest agents take fewer calls, giving them space to learn the 
workflow.

� Predefined distribution algorithms. You can blend your custom distribution choices 
with the predefined algorithms. For example, you can use the Least talk time algorithm 
while factoring in Cost.

Do I need to use skills-based or custom routing?
The predefined distribution algorithms are easier to use and in many cases will be sufficient for 
your call center needs. You should use skills-based or custom routing only if you want to 
distribute calls based on the following characteristics:

� Two or more caller requirements within a single queue. For example, Spanish and 
English calls are all sent to one queue, where your Spanish-speaking agents are mixed 
in with your English-speaking agents.  If you use different queues, you do not need to 
use skills-based routing because each queue can be staffed by the appropriately skilled 
agents, and you can use an auto attendant to send the caller to the right queue for that 
skill.

� Two or more relevant agent skills or attributes within a single queue. For example, some 
callers require either Spanish-speaking agents, or experts in South American travel, or 
both. If only one skill was relevant—for example, South American travel—you could 
create a separate queue for South American travel that uses the top-down distribution 
algorithm to reflect agents’ skill.
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Overview of skills-based routing____________________________
The bulk of this chapter describes defining and using agent skills to route calls.

How skills-based routing works
When a call arrives, you can attach skill requirements to it at the auto-attendant or an IVR 
Plug-in before sending the call to the queue. The queue then tries to route the call to the available 
agent with the best matching skill. You define to what degree skill is emphasized in the routing 
algorithm—you can have the call wait indefinitely for an agent with the right skill, or be 
eventually routed to a less-skilled or unskilled agent.

You can attach multiple skill requirements to calls, and agents can have multiple skills at 
different values. You define how important each skill is in routing calls.

Example: Your queue routes calls based on two skills: Spanish and Product Expertise. Your 
auto attendant has menu prompts separating Spanish from English callers; calls that choose the 
Spanish prompt have a Spanish skill requirement attached to them. Also, all calls start with a 
high Product Expertise requirement. You have defined that calls requiring Spanish can never be 
routed to an agent without the Spanish skill. However, the longer a call waits, the lower the 
Product Expertise requirement becomes, so that after 15 minutes of waiting a call can be sent to 
agents with the lowest Product Expertise skill.

Setting up skills-based routing
Setting up skills-based routing involves the following procedures:

1. Define one or more skills. See the next section.

2. Assign skills to users. See “Assigning skills and attributes to users” on page 3-4.

3. Set up an auto attendant to define skill requirements for incoming calls. See “Adding 
skill requirements to calls” on page 3-6. 

Note: Skill requirements can also be defined by IVR Plug-ins. 

4. Select which skills are relevant to the queue. See “Selecting and weighting relevant 
skills for a queue” on page 3-7.

5. Configure the queue to use skills-based routing based on settings you define. See 
“Setting up skills-based routing for a queue” on page 3-8.

Tools to prepare for and analyze skills-based routing
TeleVantage provides an Excel spreadsheet that you can use to quickly see the impact of using 
different skills and weights, and calculate what would happen to calls in various scenarios. See 
“Experimenting with agent and call scoring” on page 3-15 for details.

TeleVantage’s easy-to-read queue logs show the routing and scoring decisions queues make 
while they are handling calls. See Appendix B.
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Defining skills____________________________________________
As the first step to using skills-based routing you must define a set of skills, that you can then 
assign to users, calls, and queues.

To define skills

1. Choose Tools > System Settings, and go to the Queue \ Agents Skills tab.

2. Click Add. The Agent Skill dialog box opens.

3. Under Name, enter the name of the skill. Spaces and colons (:) are not legal characters. 
Letters, numbers, and other characters are legal as long as a letter is the first character. 
Skill names are not case sensitive, so you cannot use the same skill name twice with 
different case.

4. If necessary, enter any Comments to help identify the skill.

5. Click OK.

Note: You cannot delete a skill from that list if that skill is assigned to a user or queue.

6. When you are done entering skills, click OK to close the System Settings dialog box.

Assigning skills and attributes to users ______________________
Skills can be defined at the queue level or the user level.  When a user has a skill, it overrides 
the queue’s default value for that skill. If a queue uses a skill that the agent does not have, the 
agent is treated as though he or she had the skill at the queue’s default value. For example, if a 
queue uses Spanish with a default value of 50, then an agent without the Spanish skill is treated 
as though he or she had a Spanish skill of 50. To represent an agent with no skill in Spanish, you 
should add the Spanish skill to the user with a value of 0.
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You can also assign attributes other than skills to users, for example the cost of the agent, and 
have them factor into a custom routing algorithm. 

The skill value scale
The scale for skills and attributes is 0-100, where 0 represents no skill and 100 represents the 
highest possible skill. This scale balances skills with other factors if you use custom routing (see 
“Using custom agent scoring” on page 3-12).

Assigning skills to a user
1. Double-click the user in the User’s view to open the User dialog box, and go to the 

Queue \ Skills tab.

2. Click Add. The Queue Skill dialog box opens.

3. Select the skill from the Skill dropdown list. To add another skill at the system level, 
click the star icon, and see the previous section.

4. Under Proficiency, enter the user’s skill value (0-100).

5. Click OK.

Assigning attributes to users
You can assign users the following non-skill attributes for call routing purposes:

� Cost. A measure of how expensive an agent is to you. For example, you may want your 
most expensive agents to take fewer calls, freeing them to work on other tasks. 
Alternatively, you may want your most expensive agents to take the most calls, since 
they have the most expertise.

� Custom attributes. You can define up to three custom attributes for agents and have 
them affect call distribution. For example, you can define an attribute that represents 
“Time with company” so that your newest agents take fewer calls, giving them space to 
learn the workflow.

To assign attributes to users

1. Double-click the user in the User’s view to open the User dialog box, and go to the 
Queue \ Attributes tab.

2. To define the user’s level in Cost and any of the Custom attributes, enter a value 
(0-100).

3. Click OK.
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For the queue to route calls based on an attribute, you must configure the queue to use it in agent 
scoring. See “Setting up custom agent scoring” on page 3-13.

Adding skill requirements to calls ___________________________
This section describes configuring an auto attendant to add skill requirements to incoming calls. 
An auto attendant can attach skill requirements to a call in the following ways:

� To all callers who enter the auto attendant.

� To callers who select a particular menu choice.

You can also attach skill requirements to calls using the following methods other than auto 
attendants:

� IVR Plug-ins. See Installing TeleVantage.

� The TeleVantage Call Classifier add-on. This requires Call Classifier version 3.5 or 
higher.

To have an auto attendant attach skill requirements to calls

1. Edit the auto attendant by double-clicking it in the Auto Attendants view to open the 
Auto Attendant dialog box.

2. Do one of the following:

� To attach skill requirements to all callers who enter the auto attendant, click the 
Advanced tab of the Auto Attendant dialog box.

� To attach skill requirements based on a particular menu choice, go to the Menu 
Choices tab, Add or Edit that menu choice, and click the Advanced tab of the Menu 
Choice dialog box.

3. Click Add. The Custom Data / Skill Requirement dialog box opens.

4. Click Agent skill, and select the skill that you want to attach as a requirement to the 
call. You can click the star icon to create a new skill at the system level (see “Defining 
skills” on page 3-4).

5. Under Minimum value and Maximum value, enter the range (from 0 to 100) that an 
agent’s skill value must be within to qualify for taking the call. 

Note: You can set up skills-based routing to ignore Maximum value, so that no agent 
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is considered “overqualified” for a call. You can also set up skills-based routing to 
gradually relax the minimum requirements as the caller’s wait increases. See “Defining 
how skills are used in routing” on page 3-9.

6. Click OK.

7. When you are done adding skill requirements, click OK to close all dialog boxes and 
return to the Auto Attendants view.

For complete instructions on setting up and using auto attendants, see Chapter 10 of 
Administering TeleVantage.

Selecting and weighting relevant skills for a queue ____________
For each queue that will use skills-based routing, you must select which skills are relevant to the 
queue, and define the relative weight of those skills in selecting agents for a call. Skills in your 
system that are not assigned to the queue play no part in routing the queue’s calls, even if calls 
require these skills and agents have them.

To select and weight a queue’s skills

1. Edit the queue by double-clicking it in the Queues view to open the Queue dialog box, 
and go to the Skills tab.

2. Click Add. The Queue Skill dialog box opens.

3. Select the skill from the Skill dropdown list. To add another skill at the system level, 
click the star icon, and see “Defining skills” on page 3-4.

4. Under Default proficiency, enter a default value for this skill in this queue. Agents 
without the skill will be treated as though they had the skill at this value. Agents with 
this skill override the default.

The best value scale is 0-100, where 0 represents no skill and 100 represents the 
highest possible skill. This scale balances skills with other factors if you use custom 
routing (see “Using custom agent scoring” on page 3-12).

5. Under Proficiency weight, enter a number to define how important this skill is relative 
to other skills and factors when routing calls to matching agents in this queue. The 
agent’s skill value is multiplied by this number and added to the agent’s total score (see 
“The agent scoring formula” on page 3-14). 

Example: By giving Spanish a weight of 1 and Expertise a weight of 5, you make 
Expertise five times as valuable when selecting an agent for a call. An agent with 
Spanish 50 and Expertise 20 will get 50 points for Spanish and 100 points (20 * 5) for 
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Expertise.

Weight can have a range from -1000 to 1000. With a negative weight, the agent’s skill 
is multiplied by the weight and then subtracted from the agent’s score, meaning 
aptitude makes the agent less eligible to receive matching calls. 

6. Click OK.

7. When you are done adding the relevant skills for the queue, click OK to close the 
Queue dialog box.

Setting up skills-based routing for a queue____________________
Before setting up a queue for skills-based routing, you should have already defined skills and 
assigned them to the queue and to the users who will be agents in it. See the previous sections 
in this chapter.

To begin setting up a queue for skills-based routing, edit the queue by double-clicking it in the 
Queues view to open the Queue dialog box. Then perform the following procedures as needed:

� Choose skills-based or custom routing as the distribution algorithm. See the next section.

� Define how skills are used in routing. See page 3-9.

Choosing skills-based or custom routing
To select skills-based or custom routing, click the Distribution \ Agent Scoring tab.

Choose the following settings:

� Under Agent scoring algorithm select “Skills-based or custom routing.”

� In the Determine which agent... table, check the Use column for Proficiency in call 
skills. For more information on Weight and the rest of this table, see “Using custom 
agent scoring” on page 3-12.
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Defining how skills are used in routing
To define how the system uses each skill to filter out unqualified agents, click the Distribution 
\ Agent Filtering tab.

Using skill minimum and maximum requirements
A skill requirement on a call includes a minimum and maximum required value (see “Adding 
skill requirements to calls” on page 3-6). You can choose whether the queue filters out agents 
who are “underqualified” only (they fail to meet the minimum skill requirement), or whether it 
also filters out “overqualified” agents (they exceed the maximum skill requirement).

Under Send calls to agents, select one of the following:

� If the agent meets the minimum skill requirements. Calls will be routed only to agents 
whose skill values meet or exceed the calls’ minimum proficiency requirements for 
those skills. Calls’ maximum proficiency requirements are ignored, so no agents are 
considered “overqualified” for a call.

� If the agent’s skills are between the minimum and maximum requirements. Calls 
will be routed only to agents whose skill values are within the range of the calls’ 
minimum and maximum proficiency requirements for those skills.

Selecting Ignoring the call’s skill requirements disables the filtering step. If you select this, 
calls are distributed to agents whether or not the agents meet the call’s skill requirements. 
Routing is based entirely on non-skill factors, such as the weight of agents’ attributes and the 
queue’s standard agent scoring algorithms (see “Using custom agent scoring” on page 3-12).

Adjusting skill requirements over time
You can define whether minimum skill requirements get reduced as the caller waits, so that 
eventually the call may be sent to a less-skilled or unskilled agent. If you are using maximum 
skill requirements (see the previous section), you can have those increase over time, allowing 
more highly-skilled agents to take the call. Choose one of the following:

� Wait indefinitely for a matching agent. Calls with skill requirements wait indefinitely 
until an appropriately skilled agent is available. They are never sent to agents who do 
not meet those requirements.
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� Reduce call’s skill requirements after __ seconds. One or more skill requirements get 
adjusted as callers wait. You determine which skill requirements get adjusted and how 
quickly using the following options:

� Reduce call’s skill requirements after __ seconds. Enter a time (in seconds) to 
define an initial threshold of waiting, during which the call’s skill requirements 
remain intact. As soon as the initial threshold is passed, skill requirements are 
adjusted once.

� Change them again every __ seconds. Enter an interval (in seconds) to determine 
how often the skill requirements are adjusted, after the first adjustment following 
the initial waiting threshold. 

� In the table, define by how much each skill requirement is adjusted whenever the 
system makes an adjustment pass. You can have the system adjust different skill 
requirements at different rates. For each skill, click the Reduce minimum by 
column to enter a number by which the skill minimum will be reduced. If you are 
using skill maximums (see the previous section), then you can click the Increase 
maximum by column and enter a number by which the skill maximum will be 
increased.

Entering a value of 0 means that skill requirement is never adjusted, and the call 
waits indefinitely for an agent who has the required skill value. (Setting all skills to 
0 is equivalent to selecting Wait indefinitely for a matching agent above).

Redirecting calls when there are no agents with matching skills
You can have the queue automatically redirect calls when there are no signed-in agents with 
skills that match the call’s skill requirements. See “Redirecting calls when there are no matching 
skills” on page 2-34 for instructions.

Note: If you have set the queue to reduce calls’ skill requirements over time (see the previous 
section), then calls are not redirected for lack of matching skills. 
3-10 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



Viewing an agent’s skills within a queue _____________________
To see an agent’s skills within a queue, edit the agent (see “Adding agents to the queue” on 
page 2-11) and click the Skills tab. 

The Skills tab lists all the agent’s skills that are relevant within this queue. This user may have 
other skills, but they do not appear if they are not relevant to the queue. To view or edit a 
complete list of the user’s skills, click Edit User’s Skills, and see “Assigning skills and 
attributes to users” on page 3-4.

To change which skills are relevant to the queue, see “Selecting and weighting relevant skills 
for a queue” on page 3-7.

The source of an agent’s skill value
The Proficiency column displays the agent’s ability in that skill. It also indicates whether the 
agent’s skill value comes from his or her own native skill set at the user level (“user”), or the 
queue’s default value for that skill (“queue”). A user’s native skill value always overrides the 
queue default value. Queue default values are used only if the user does not have a skill that is 
relevant to the queue. 

Reducing wait time for calls with skill requirement matches _____
By default, calls are routed to agents in the order received, regardless of skill requirements. In 
fact, calls with skill requirements may wait longer, since they are waiting on a smaller pool of 
agents who have the required skills. You can counterbalance this by sending a call ahead in the 
queue when an appropriately skilled agent for that call becomes available. In essence, you are 
giving calls higher priority when their skill requirements are met by an available agent.
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Example: Your queue uses the skills Spanish, Japan Travel, and China Travel. Only one agent 
has all three skills, so that by default a call requiring all three skills would have to wait in the 
queue for that one agent, while in the meantime the agent might be taking calls that could be 
handled by other agents. If you reduce wait time based on skill, then as soon as the matching 
agent became available, the call would jump ahead in the queue, increasing the efficiency of 
your queue.

To reduce wait time for calls with skill requirement matches

1. Click the Distribution \ Call Scoring tab.

2. Check Add the agent’s average proficiency times __ to the call’s score. Enter a 
number that determines how much a call moves ahead in the queue when one or more 
of its skill requirements find a matching available agent. When an agent with a 
matching skill becomes available, his or her skill value is multiplied by that number 
and added to the call’s score. The higher the multiplier, the more matching calls are 
advanced in the queue. 

In cases where the call has multiple skill requirements, the agent’s applicable skill 
values are averaged, and that average value is multiplied by the number you enter.

3. Click OK.

Note that this setting applies only when comparing calls with skill requirements to calls with no 
skill requirements. In cases where different calls have different skill requirements, this setting 
is ignored, and skills change the call’s score based only on their weight in the queue (see 
“Selecting and weighting relevant skills for a queue” on page 3-7).

Using custom agent scoring________________________________
A queue uses agent scoring when a call arrives and several agents are available to take it, to 
determine which agent gets the call. For each incoming call with more than one agent available, 
the queue does the following:

1. Filters out those agents who are unable to take the call, for example, because they do 
not meet the call’s skill requirements.

2. Calculates scores for the remaining agents.

3. Sends the call to the agent with the highest score.

Note: When two or more agents tie for the highest score, the call always goes to the longest idle 
of the tied agents.

When you use a predefined routing algorithm, agent scores are calculated from 0 to 100. For 
example, when using the “Top down” algorithm, the topmost agent gets a score of 100, the 
bottom agent gets a score of 0, and those in between get percentage scores representing how 
close they are to the top. 
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You can create your own customized agent scoring system that scores agents according to a 
variety of factors. You determine how much weight each factor carries in determining the 
agents’ scores. With custom agent scoring you can do the following:

� Blend two or more predefined algorithms. For example, you could blend “Round 
robin” and “Longest idle,” so that the randomness of round-robin distribution doesn’t 
leave an agent waiting too long.

� Incorporate agents’ skill values. If a call requires Spanish and several agents with 
Spanish are available, the agent with the highest Spanish skill will get a higher score. 
You can weight individual skills differently, for example, a 20 skill in Kazakhstan 
Travel could increase the agent’s score by more than a 100 skill in Spanish.

� Incorporate agents’ cost and custom attributes. See “Assigning attributes to users” 
on page 3-5. After assigning cost and custom attributes to agents, you can weight them 
appropriately and use them in routing. For example, you could blend “Least talk time” 
with a negative “Cost,” so that your most expensive agents take fewer calls, freeing them 
for other tasks.

Setting up custom agent scoring
To set up custom agent scoring, do the following:

1. Go to the Distribution \ Agent Scoring tab of the Queue dialog box.

2. In the Determine which agent gets the next call using the following agent 
attributes table, expand the categories and do the following:

� Check Use for each factor that you want to include in the agent’s score. Note that 
checking “Proficiency in call’s skills” makes all skills a factor. To adjust the weight 
of individual skills, see “Selecting and weighting relevant skills for a queue” on 
page 3-7. 
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� To change the weight of a factor, click the Weight column for that factor and enter 
the new number. The factor’s value will be multiplied by that number and added to 
the agent’s score. Weight has a range of -1000 to 1000. To choose a negative 
weight, meaning the value will be subtracted from the agent’s score, use the minus 
sign to enter a negative number (for example, “-1”). Setting Weight to 0 is 
equivalent to unchecking Use, as it will always add 0 to an agent’s score. 

3. Click OK.

The agent scoring formula
Agents are scored as follows:

Required skill proficiency weighted average (see below) * skill factor weight
plus Cost * cost weight
plus Custom 1 * custom 1 weight
plus Custom 2 * custom 2 weight
plus Custom 3 * custom 3 weight
plus Idle time algorithm rank * idle time weight
plus Talk time algorithm rank * talk time weight
plus Number of calls algorithm rank * number of calls weight
plus Top down algorithm order * top down weight
plus Round robin algorithm order * round robin weight

equals Agent score

The Required skill proficiency weighted average is as follows:

Required skill 1 proficiency * that skill’s proficiency weight
plus Required skill 2 proficiency * that skill’s proficiency weight
plus ... the same for each skill required by the interaction
over  The sum of all proficiency weights

Example

Agent 1 Agent 2

Factor Value Weight Score Factor Value Weight Score

Round robin 100 1 100 Round robin 0 1 0

Longest Idle 33 2 66 Longest Idle 100 2 200

Spanish 50 1 50 Spanish 100 1 100

Kazakhstan 20 10 200 Kazakhstan 0 10 0

Cost (neg) 50 1 -50 Cost (neg) 100 1 -100

Total 366 Total 200
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Experimenting with agent and call scoring
TeleVantage provides a sample Microsoft Excel spreadsheet, SkillsWorksheet.xls, that you can 
use to experiment with different values for agent proficiencies, queue configurations, and call 
skill requirements. You can use it to see how much different factors affect agent and call scores. 

The spreadsheet is installed on any PC with the TeleVantage Administrator in the following 
directory:

C:\Program Files\TeleVantage\Administrator\SkillsWorksheet.xls

After opening it in Excel, follow the on-screen instructions to input different agent scoring 
parameters, then view the results. Note that there are three tabs along the bottom of the 
spreadsheet, that you can use to fill out information on agent scoring and call scoring, and read 
summary data.

Note: The cells governing the worksheet formulas are locked. To unlock them for editing, 
choose Tools > Protection > Protect/Unprotect Sheet for each worksheet you want to edit. Be 
aware that editing or rearranging protected cells can cause the worksheet to malfunction.

Viewing agent and call scoring decisions
You can use the queue logs to review and analyze the step-by-step logic used by the queue to 
route calls to your agents, including how it followed your custom agent scoring setup. See 
Appendix B, “Troubleshooting Queue Behavior.” 
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About using contacts and call rules with a queue ______________
This chapter describes how to use contacts and call rules with a queue. This procedure is 
optional—you can run a call center queue without using contacts and call rules.

For complete information about contacts and call rules, see Using TeleVantage.

To use contacts and call rules with a queue, you create a utility user, which is a dummy user 
whose routing list contains only a final action of transferring calls to the queue. The utility user 
does not represent a real person. Its function is to receive queue calls, identify the callers if 
possible, apply call rules when appropriate, and then transfer the calls to the queue for 
distribution to agents. Callers are not aware of the utility user.

Benefits of using contacts with a queue
By setting up contacts for the queue that represent important customers or business contacts, you 
can enjoy the following benefits:

� TeleVantage can identify the queue’s contacts when they call, so that calls appear in the 
agents’ Call Monitors labelled with the contact’s name.

� All agents in the queue can view the queue’s contacts in their Shared Folders lists and 
place calls to them if necessary.

� After a call, an agent can update a contact’s record with notes that all other agents can 
see.

Benefits of applying call rules to queue calls
By applying call rules to incoming queue calls, you can handle individual calls based upon the 
caller and the time of day. For example, you can:

� Greet important customers with a special message before they enter the queue.You can 
record a Welcome message that gives callers a code for a special discount, and you can 
play the message only to favored customers.

� Change greetings and automatically transfer calls based upon the time of day. For 
example, instead of using the manual Queue is closed field (see “Closing the queue” 
on page 2-8), you can use your Business Hours schedule to have the queue automatically 
play a “We’re closed” greeting and route calls to a voice mailbox when your business is 
closed. You can use different schedules for different queues.

You can use an auto attendant as well as a utility user to play greetings and transfer calls 
based on time of day (see Administering TeleVantage).
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Setting up a utility user for a queue__________________________
To set up a utility user for a queue, you must complete the following tasks, which are described 
in detail in the next two procedures in this section:

� Creating the utility user

� Editing the utility user’s routing list

Creating the utility user
Use the following procedure to create a utility user:

1. In the Administrator, choose File > New > User. The User dialog box opens.

2. Under Type, choose User.

3. Give the user a Last Name that identifies the queue for anyone transferring calls to it. 
For example, “Sales.” Users who transfer calls to the queue will do so by transferring 
them to this user.

4. Give the user an Extension and Password.

5. Give the user a Station ID of 0. The utility user has no phone associated with it.

6. Click the Recordings tab.

7. Select No Mailbox. Voice messages for the queue will be stored in the queue’s voice 
mailbox, so the utility user does not need one.

8. Under Voice title, use the audio controls to record the queue’s name, for example, 
“Sales queue.”

9. Click the Call Handling tab.

10. Under Call handling, uncheck all options. 

11. Check List in dial-by-name directory if you want callers and users to be able to find 
the queue by name. If you do, you should uncheck this field for the queue itself, so 
users do not hear two entries for the queue.

12. Click OK.

Editing the utility user’s routing list
1. Log on to ViewPoint using the utility user’s name and password.

2. Choose File > New > Routing List. The Routing List dialog box opens.

3. Give the Routing List a Name to help you identify it with the queue, such as “To 
Sales.”

4. Select the action “Call Me Where I Am” and click Delete. The Actions list should be 
empty. If it is not, delete all other actions in the list.
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5. Under Final action if the call is not answered, do the following:

� Uncheck Play greeting.

� Under Action, select Transfer to an extension.

� Under Extension, select the queue to which you want the utility user to send calls.

6. Check Active routing list for this extension.

7. Check Default personal status routing list.

Your dialog box should look similar to the following example:

8. Click OK.

When you are finished editing the utility user’s routing list, make sure the utility’s user’s 
personal status is set to Available. See Using TeleVantage for instructions on selecting a personal 
status.

Creating and sharing queue contacts _____________________________

You create contacts for the queue by creating contacts for the utility user and then sharing these 
contacts with the agents, as follows:

1. Log on to ViewPoint as the utility user.

2. Choose File > New > Contact to add a contact. See Using TeleVantage for instructions. 
Repeat this step to add as many contacts as you want.

3. Choose File > Folder > Share “Contacts.” The Contacts Properties dialog box opens 
at the Sharing tab.

4. In the Available Users pane, select the agents or other users to whom you want to give 
access to the queue’s contacts. Press CTRL as you click users to select multiple users. 
4-4 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



The users with whom you share access to the queue’s contacts do not need to be the 
users who are the agents in the queue. 

5. Click Add to move the selected users to the Share with these users pane.

6. Use the Permission dropdown list to determine each user’s level of access to the 
queue’s contacts. The options are:

� View only. The user can view the queue’s contacts, place calls to them, and 
associate calls with them.

� View and Edit. The user can view, edit, and delete shared queue contacts.

7. Click OK.

For instructions on how users access shared queue contacts, see Using TeleVantage.

Setting up call rules for a queue___________________________________
You set up call rules for a queue by creating call rules for the utility user, as follows:

1. Log on to ViewPoint as the utility user.

2. Choose File > New > Call Rule. The Call Rule dialog box opens.

3. Define the call rule as described in the next section, “Using routing lists to define 
queue call rules.” See Using TeleVantage for complete information about defining call 
rules.

To activate call rules based on individual callers, define those callers as contacts for 
the utility user. See “Creating and sharing queue contacts” on page 4-4. 

4. Make sure that Enable this call rule is checked.

5. Click OK. Repeat this procedure to create other call rules.

Using routing lists to define queue call rules
Each call rule that you define for a queue must handle calls by using a particular routing list. Use 
only the call rule’s Routing List field and custom non-active routing lists to determine how calls 
are handled. Do not use the call rule’s Personal Status or Taking Calls fields. If you use these 
fields, calls may be lost. 

Example: To define a call rule that plays certain callers (contacts) a special Welcome message 
before they enter the queue, you would create a call rule that sends calls to a custom routing list 
(a routing list created for the utility user) that has the following features: 

� No actions

� A greeting that plays the Welcome message before the final action

� A final action of Transfer to Extension that transfers calls to the queue
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Whether this chapter applies to you _________________________
This chapter provides instructions for working as an agent in a TeleVantage call center. Whether 
or not this chapter applies to you depends on the TeleVantage call distribution method that your 
office uses, as follows:

� Use this chapter if you are an agent in a TeleVantage call center queue that was set up 
using separately licensed call center agent licenses.

� Do not use this chapter if you are an agent in a TeleVantage ACD workgroup that was 
set up by using an ACD workgroup user and a routing list that sends calls to agents who 
are members of a workgroup. If you are an agent in an ACD workgroup, see 
“Participating in an ACD workgroup” on page 7-14.

Starting and ending your shift, and taking breaks ______________
Important: Do not use this section if you are disallowed from changing your own personal 
status. In that case, a supervisor will control your workflow. Talk to your queue manager or 
administrator about how to work in the queue.

As a call center agent, you control your workday by changing your personal status. At the 
beginning of your shift, you make yourself ready. At the end of your shift, you make yourself 
unavailable. While you are ready, you receive calls from all queues for which you are signed in. 
When you make yourself unavailable, queues stop sending calls to you. 

Note: If you have to temporarily leave your phone during your shift, choose TeleVantage’s On 
Break personal status. 

The following sections describe which personal statuses to use to make yourself ready and 
unavailable. For instructions on changing your personal status, see Using TeleVantage.

Starting your shift
To start your shift and begin receiving queue calls, make yourself ready by doing either of the 
following:

� Using your telephone keypad, press either of the following at a dial tone:

� *50. This selects the Available personal status.

� *51. This selects the Available (Queue Only) personal status.

� In ViewPoint, select either of the following personal statuses:

� Available. You receive personal calls (calls to your extension) as well as queue 
calls.

� Available (Queue Only). You receive only queue calls. Personal calls are sent 
directly to your voicemail.

If you will be making outgoing calls from the queue, see “Placing calls from a queue” on 
page 5-8.
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Ending your shift
Note: Use this procedure at the end of your shift only. To take a break during your shift, use the 
On Break personal status to ensure the integrity of call center statistics. See the next section, 
“Taking a break.” 

To end your shift and stop receiving queue calls, make yourself unavailable by doing either of 
the following:

� Using your telephone keypad, press *52 at a dial tone. This selects the personal status 
Available (Non-Queue).

� In ViewPoint, select any personal status whose Queue calls preference is set to No, 
other than On Break. For example, select the Personal status Available (Non-Queue) to 
receive personal calls without receiving queue calls.

Important: If you have marked your outbound calls as being from the queue, you must switch 
back to calling as yourself. Otherwise your outbound calls will continue to be marked as coming 
from the queue (and may be monitored), even though you have ended your shift. See “Placing 
calls from a queue” on page 5-8.

Taking a break
To take a break from answering queue calls during your shift, do one of the following:

� Pick up the phone and press *53.

� In ViewPoint, select the personal status On Break.

Note: Select the On Break personal status whenever you leave your phone during your shift, 
even for a short time. If you leave your phone without selecting On Break, queue calls might be 
sent to your phone, and callers will hear an interval of ringing before they are placed back on the 
queue. 

When you finish your break and are ready to receive calls again, make yourself ready again. 
Press *51 on your phone or select the personal status Available or Available (Queue Only). 

What call center agents need to know to get the job done _______
If you are working as a call center agent, you should be aware of the following:

� While you are ready, always take queue calls that are sent to you. If a queue call 
rings your phone and you do not answer, the caller will hear ringing and then be placed 
back on the queue. Also, if you do not pick up a ringing queue call, or decline it using 
the call announcing options, the queue might automatically place you in the On Break 
personal status.

� Use the On Break personal status only to leave your phone during your shift. 
Making yourself unavailable by using other statuses, such as Available (Non-Queue) or 
Do Not Disturb, signals TeleVantage that you are ending your shift (these statistics are 
reset daily). 
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� Your personal status can be changed by others. If you do not answer queue calls that 
ring your phone, the queue can automatically place you in the On Break personal status. 
Also, a supervisor can change your personal status at any time. 

Agents, call forwarding and routing lists
Queue calls sent to you do not use your routing list, so they cannot try you at multiple locations. 
Queue calls do follow your call forwarding / Where I Am settings.

Working at different phones ________________________________
If you need to work at a phone other than your default station, or if you have no default station 
and always work at a variety of phones, add the following steps to your routine:

1. When you first sit down at a new phone to receive calls, before marking yourself as 
Available, log on and forward your calls to your current location. Otherwise, your call 
center performance might be logged under another agent’s name. Use either of the 
following methods:

� Pick up the phone and log in by pressing # <extension> # <password> #. Once 
logged in, press 5 1 to forward calls to your current location.

� Start ViewPoint. The Select Your ViewPoint Phone dialog box opens. Select the 
second logon option, Use station <x> to place and answer calls as <your name>. 
Check Forward my calls to this station.

2. After you have logged on, make yourself ready as described in “Starting your shift” on 
page 5-2.

3. When you are finished using a phone, log off by either picking up the phone and 
pressing *0 0, or by exiting ViewPoint.

Note: When you are logged in at a station other than your own, voice message indicators apply 
to you. For example, if you hear stutter dial tone or see a message waiting light on the phone, it 
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means you have new voice messages.

Note: When an agent at a phone other than his or her own logs out with *0 0, the agent’s hook 
state can remain red (off-hook) indefinitely. To correct this issue, use the registry setting 
HKEY_LOCAL_MACHINE\Software\Artisoft\TeleVantage\Server\Settings\MonitorLocPbe. For 
instructions on advanced settings see Appendix J of Installing TeleVantage.

Signing in and out of a queue ______________________________
You can be either signed in or signed out of each queue to which you belong. Only when you 
are signed in do you receive calls from the queue. When you are signed out of a queue, you can 
see and affect its calls in the Call Monitor, but the queue does not send calls to your phone.

As an agent, you might be signed out for the following reasons:

� You are a supervisor who wants to observe a queue and manually take calls if necessary, 
but you do not want queue calls to ring your phone.

� You are an agent who is a member of multiple queues, and you periodically change 
which queue you receive calls from. You receive calls only from the queues to which 
you are signed in.

Note: Other agents with permission can sign you in or out of a queue.

To sign in or out of a queue
You must have permission to sign yourself in or out of queues. If you do not have permission, 
talk to your TeleVantage system administrator about signing in and out.

Using ViewPoint
1. Choose Tools > Queue Sign In/Out. The Queue Sign In/Out dialog box opens, 

displaying all queues for which you are a member. A check mark for a queue indicates 
that you are signed in to that queue.

2. Check the box next to a queue’s name to sign in to that queue, or clear the checkbox 
to sign out.

3. Click OK.

Note: In the Queue Monitor or Call Monitor folder, you can also right-click a queue tab to sign in 
or out of that queue. 

Using the telephone
Using your telephone keypad, press *56 at a dial tone. Enter the extension of the queue for which 
you want to sign in or out followed by #, for example, “*56 102 #”.
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Seeing whether you are signed in or out of a queue
In the Queue Monitor and Call Monitor views, the tab for a queue displays an asterisk (*) if you 
are signed out from that queue. 

Receiving and handling queue calls _________________________
You can receive and handle queue calls by using either the telephone commands or ViewPoint. 
When the queue sends a call to you, your phone rings and the call appears in ViewPoint’s Call 
Monitor folder. Queue calls ignore your routing list and only ring your “Where I Am” location 
(your station or call forwarding number).

To answer a call, do either of the following:

� Pick up the phone.

� Click the incoming call in the Call Monitor and choose Actions > Take Call. If your 
phone is on-hook, it rings to connect you to the call.

After you are connected to a queue call, you can use most TeleVantage call-handling features 
such as transfer, park, mute, and so forth. For instructions on handling calls using the phone or 
TeleVantage ViewPoint, see Using TeleVantage. 

Notes

� You cannot use the Hold command on a ringing queue call. You can only put a queue call 
on hold after answering it.

� Your queue calls are not shared, even if you are sharing your Call Monitor folder.

Viewing your position in the queue
If you have permission to see ViewPoint’s Queue Monitor folder, you can use it to monitor your 
position in the queue, and determine when you are likely to receive the next call. See 
“Monitoring the position of agents in the queue” on page 6-14.

Being monitored or coached by a supervisor
Call Center supervisors have the ability to supervise your queue calls on the following levels:

� Monitoring. A supervisor may listen in on any of your calls without you or the caller 
hearing. You will be unaware of the monitoring unless you have the permission View 
agents being monitored. If you do, the monitor appears in the Call Monitor as an 
indented line under the call.

� Coaching. A supervisor may speak to you during a call without the caller hearing. 
Coaching appears in the Call Monitor as a separate line under the call. If you are being 
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coached, try not to speak to the coach, as the caller will not be aware of the coach’s 
presence on the line.

� Joining. A supervisor may join your call, essentially creating a three-way conference 
call in which all parties can hear each other. For more about conference calls, see Using 
TeleVantage.

By default, only queue calls are susceptible to being supervised. This includes inbound queue 
calls and outbound calls that you have associated with a queue (see “Placing calls from a queue” 
on page 5-8). 

Having your calls recorded
The queue may be configured to record some or all of your queue calls. You receive no 
indication that a call is being recorded. The queue may be configured to place call recordings in 
your Inbox as new voice messages.

Your non-queue calls will not be recorded unless the TeleVantage system has been configured 
to record all calls.

Using the Call Monitor tabs
When you are an agent in a call center queue, your Call Monitor folder displays the following 
tabs:

� A tab that shows the queue’s calls, with the name of the queue on it. If the tab name 
appears with an asterisk, it means that you are signed out from that queue.

Note: You must have permission to see this tab. If you do not see it, see your 
TeleVantage system administrator.

� The My Phone tab, which shows all the calls that are being handled by your phone, 
including any queue calls you have taken.

� The All tab, which shows all your queue and personal calls together.

If you are an agent in multiple queues, the Call Monitor displays a tab for each queue.

Click the My Phone tab or a queue tab to view only the calls for that tab. Click the All tab to 
view all calls at once.

Note: Your Call Monitor folder may display other tabs than the ones described in this section. 
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See Using TeleVantage for a full description of the Call Monitor.

Wrap-up time
After you finish a queue call, you are given wrap-up time to complete any work relating to the 
call. During your wrap-up time you will not receive any queue calls. Your TeleVantage system 
administrator sets how much wrap-up time you have. 

While you are in wrap-up time,  appears in the ViewPoint status bar.

Terminating your wrap-up time early
To terminate your wrap-up time early and mark yourself as ready to take queue calls again, do 
either of the following:

� Click  in the ViewPoint status bar.

� Using your telephone keypad, press *54 at a dial tone.

Viewing queue activity
The Queue Monitor  in ViewPoint displays a list of agents in the queue and up-to-date queue 
statistics. You can use it to see the status of other agents in the queue and your current position 
in the queue, among other things.

To see the Queue Monitor folder in your ViewPoint, you must have the appropriate permission. 
For a description of the Queue Monitor folder, see “Monitoring queue statistics” on page 6-3.

Placing calls from a queue _________________________________
If you are a call center agent and you place a call at your desk using the telephone or ViewPoint, 
by default TeleVantage treats the call as one made by you. You can choose instead to place calls 
as a queue, which may be necessary for your work as a call center agent. When you place calls 
as a queue, TeleVantage treats the call as if the queue placed it. Other agents can see it in their 
Call Monitors, it can be monitored by supervisors, and statistics and reports can accurately 
reflect queue activity. 

When calling as a queue, your calls appear on both the My Phone tab and the queue tab in your 
Call Monitor. The calls are logged both in your personal Call Log and the queue’s Call Log, with 
the queue name in the From column. 

Important: When you are done placing calls as a queue, be sure to switch back to calling as 
yourself. If you don’t, your personal calls will be treated as queue calls, meaning they will be seen 
by all agents and will throw off queue statistics.
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To place calls as a queue using ViewPoint

On the ViewPoint status bar, your name and extension are a dropdown list. Pull down the list 
and select the queue as which you want to place calls.

To switch back to calling as yourself, select yourself from the dropdown list.

To place calls as a queue using the telephone

Pick up your phone and press *14<queue’s extension># at a dial tone. 

To switch back to calling as yourself, press *14# at a dial tone. 

Determining who you are calling as
ViewPoint’s status bar displays whether the system is treating outbound calls from its station as 
being from you or from someone else.

You can also learn from whom a station is placing outbound calls by picking up the station and 
pressing *0. The station information recording includes the line, “The current extension is 
<Ext.> calling as <Queue>.” 

� <Ext.> is the extension of the last user who logged in at the station.

� <Queue> is the name of the queue that outbound calls are marked as being from.

For example, the recording might say, “The current extension is 555, calling as Sales Queue.”

Popping up caller information ______________________________
You can use the TeleVantage Contact Manager Assistant to pop up information about callers 
that you have in another contact manager application. Callers must be contacts in one of the 
following contact manager or customer relationship management applications:

� Act! 3.0, 4.0, 6.0, and 2000

� Goldmine 4.0 and 5.0, and Goldmine Business Contact Manager 5.7

� Goldmine FrontOffice 2000

� Microsoft Outlook 98, 2000, 2003, and XP

For instructions on configuring the TeleVantage Contact Manager Assistant, see its online Help. 

Act! can pop up contact information on its own, without the Contact Manager Assistant.

Note: Your office might also use a custom screen pop application created with the ViewPoint 
API. If this is the case, see your TeleVantage system administrator for instructions on using it.
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Working remotely_________________________________________
If you have an external station, you can work remotely using that station.

You can work at remote phone that is not a remote station by forwarding your calls. For 
instructions on using ViewPoint remotely, see Using TeleVantage.

Call center agents and H.323 Gateways
If an H.323 Gateway user is added to a call center queue, by default the corresponding user on 
the remote Server does not have access to the call center personal statuses (Available Queue 
Only, Available Non Queue, and On Break). To give the user access to those statuses, do the 
following:

1. Edit the full user (not the H.323 Gateway user) in the TeleVantage Administrator to 
open the User dialog box, and click the Queue tab.

2. Check Show queue-related personal statuses.

3. Click OK.
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About supervising queues _________________________________
You can assign agents any number of queue permissions that give them the ability to supervise 
a queue. Supervisors are merely agents with extra permissions. Supervisory tasks include the 
following:

� Configuring the queue in the Administrator, including the agents that belong to it

� Signing agents in or out for the queue

� Viewing real-time queue statistics in TeleVantage ViewPoint

� Changing an agent’s personal status

� Managing a queue’s voice mailbox

� Supervising agent conversations by monitoring or coaching

You assign permissions separately for each queue. To give an agent supervisor permissions in 
more than one queue, you must edit the agent separately in each queue.

For instructions on adding agents to a queue and setting their permission levels, see “Defining 
agents for the queue” on page 2-10. For a list of queue permissions, see “Agent permissions” on 
page 2-14.

Exempting supervisors from receiving queue calls
Because supervisors are agents in the queue, by default they receive queue calls when they are 
ready, just as other agents do. To exempt an agent from receiving calls from a queue, sign the 
agent out for that queue, or configure the agent as an Observer (see “Adding agents to the queue” 
on page 2-11).

When supervisors are signed out from a queue, the queue does not send calls to them. However, 
supervisors can watch queue calls in the Call Monitor folder and answer them if necessary using 
the Take call command. They can also perform all other queue monitoring and managing tasks 
when they are signed out.

For instructions on signing a supervisor out, see “Signing agents in or out of a queue” on 
page 6-19.

Viewing current queue calls ________________________________
Agents with the permission Access Queue call monitor can view all current queue activity on 
the queue’s tab in ViewPoint’s Call Monitor folder. Note that only calls associated with the 
queue appear in the queue’s tab. If the agent is on a personal call or a call from another queue, 
it does not appear in the queue tab.

For more information, see “Using the Call Monitor tabs” on page 5-7.
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Monitoring queue statistics ________________________________
Agents who have the permission Monitor queue statistics set to Allow can monitor a queue’s 
performance by using either the telephone commands or the Queue Monitor folder in 
ViewPoint.

Viewing queue statistics in the Queue Monitor folder
To open the Queue Monitor folder, click Call Monitor > Queue Monitor in the navigation pane. 

Each queue for which you have permission to view statistics appears as a tab at the bottom of 
the folder. Click a queue’s tab to see statistics for that queue and the agents in that queue.

For a detailed description of when Queue Monitor statistics reset to zero, see “When statistics 
are reset” on page 6-13.

Note: You can continue to use the Call Monitor while you are in the Queue Monitor. Choose 
View > Calls Pane to add the Call Monitor to the Queue Monitor folder as a separate pane.

The Agents pane
At the top of the Queue Monitor folder, the Agents pane displays the names of all agents in the 
queue, their current statuses, and their performance, including inbound and outbound calls.

You can have the Agents pane display statistics by day or by shift. Choose Actions > Show 
agent statistics by day/shift. For information about shifts, see “Configuring shifts” on 
page 2-50.

Note: The Agents pane’s statistics are those for the selected queue only. For example, the Calls 
answered field shows the number of calls an agent has answered for this queue. The agent may 
have answered other calls such as personal calls or calls from other queues.
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The Agents pane displays the information shown in the following table. Some columns may be 
hidden by default. To show them, choose View > Current View > Show Columns.

Agents Pane Information

Availability

Icon showing the agent’s phone as on-hook or 
off-hook.

Personal Status icon

Icon for the agent’s current personal status.

Distribution Order

The order in which agents are scheduled to 
receive calls. The order is dependent on the 
queue’s distribution algorithm. The agent who 
will receive the next call is the agent with the 
lowest number among currently Ready 
agents.

This column may be disabled. See “Enabling 
and disabling the Distribution Order column” 
on page 6-16.

Name Agent’s name.
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Agent State Agent’s current level of availability to take 
calls from this queue. Note than an agent can 
be in different states for different queues at 
the same time. The possible states are:

Ready. The agent is signed in, and in the 
personal status Available or Available (Queue 
Only), and the phone is on-hook. The agent is 
ready to take a call.

Active Inbound. The agent is on an inbound 
call from this queue.

Active Outbound. The agent is on an 
outbound call associated with this queue.

Wrap-up Inbound. The agent is in the 
wrap-up period immediately following the end 
of an inbound call associated with this queue.

Wrap-up Outbound. The agent is in the 
wrap-up period immediately following the end 
of an outbound call associated with this 
queue.

Dialing. The agent is in the process of dialing 
an outbound call as the queue.

Standby. The agent is On Break, or is in a 
non-queue call (such as a personal call or a 
call from another queue.)

Signed out. The agent is signed out of this 
queue and so is not taking calls from this 
queue.

Unavailable. The agent is in a personal status 
other than Available or Available (Queue 
Only), and so is not taking queue calls.

No answer. The agent did not answer the last 
queue call. The queue does not send calls to 
agents in the No Answer status. TeleVantage 
automatically removes the agent from No 
Answer status after a certain time based on 
what caused the No Answer status.

Offering. The agent's phone is ringing with a 
call from this queue, but the agent has not 
accepted the call yet.

Agents Pane Information
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Time in State The length of time that the agent has been in 
the current state for this queue. Times are 
displayed in the following format: days: 
hours:minutes:seconds.

Calls answered Number of incoming calls from this queue that 
the agent has answered since the beginning 
of the queue’s current display period. Does 
not include calls the agent participated in but 
did not answer (see Total Calls - All)

Calls placed Number of outbound calls associated with this 
queue that the agent has placed since the 
beginning of the queue’s current display 
period. Does not include calls the agent 
participated in but did not place (see Total 
Calls - All)

Time on calls The total time the agent has spent on this 
queue’s calls since the beginning of the shift.

You can show this column separately for 
inbound calls, outbound calls, and all calls.

Longest call The length of time of the longest queue call 
(including wrap-up time) that the agent 
handled since the beginning of the shift.

You can show this column separately for 
inbound calls, outbound calls, and all calls.

Avg. call Average length of the agents' queue calls 
(including wrap-up time) since the beginning 
of the shift.

You can show this column separately for 
inbound calls, outbound calls, and all calls.

Longest talk The length of time of the longest single call 
the agent handled (not including wrap-up 
time). 

You can show this column separately for 
inbound calls, outbound calls, and all calls.

Agents Pane Information
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Away A check mark indicates that the agent has 
been automatically placed in On Break status 
by the queue for having let his or her most 
recent queue calls ring unanswered. See 
“Placing agents on break if they do not 
answer calls” on page 2-21.

Forced Break Number of times the queue has automatically 
placed the agent in On Break status for letting 
queue calls ring unanswered, since the 
beginning of the current display period. See 
“Placing agents on break if they do not 
answer calls” on page 2-21.

Inbound Calls Number of incoming queue calls that the 
agent has participated in since the beginning 
of the queue's current display period, 
including inbound calls transferred from other 
agents in the queue.

Longest wrap-up The length of time that the agent spent in the 
longest wrap-up after a call.

No Answer Number of queue calls to the agent that rang 
unanswered, since the beginning of the 
current display period.

Outbound Calls Number of outbound queue calls that the 
agent has participated in since the beginning 
of the queue's current display period, 
including outbound bound calls placed by 
other agents in the queue and then 
transferred to this agent.

Overflow The agent’s overflow tier. If no number is 
listed the agent is a primary agent (assuming 
the overflow skill default is set to 0).

Personal Status 
Name

Name of the agent’s current personal status.

Queue Name of the agent’s queue. 

Signed in A check mark indicates that the agent is 
signed in to this queue.

Agents Pane Information
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Total calls - All The total number of calls associated with this 
queue in which the agent has participated 
since the beginning of the queue’s current 
display period. Includes inbound and 
outbound calls, and calls where the agent did 
not answer or place the call (for example, 
joining another agent in a conference call or 
having another agent transfer a call to him)

Agents Pane Information
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The Queue Statistics pane
At the bottom of the Queue Monitor folder, the Queue Statistics pane displays statistics for the 
queue as a whole. To show or hide the Queue Statistics pane, choose View > Queue Statistics 
Pane. 

You can display queue statistics for inbound calls only, outbound calls only, or all calls, by 
clicking the appropriate button above the Queue statistics by day section.

Note: For outbound calls to appear in the Outbound Statistics section, agents must place calls 
as the queue. See “Placing calls from a queue” on page 5-8.

The Queue Statistics pane is divided into the following sections:

� Current status. Statistics for the number of agents and calls currently in the queue.

� Queue statistics by day. Statistics for calls since the beginning of the current day. 
These statistics automatically reset to zero at midnight.

� Queue statistics by period and shift. Statistics for calls during the current period and 
shift, compared to the previous period and shift. When the current period or shift ends, 
the current statistics automatically reset to zero, and the totals that had accumulated are 
moved into the Previous column.

For instructions on defining the statistics period and shifts, see “Collecting queue statistics” on 
page 2-50. For detailed descriptions of when day, period, and shift statistics reset to zero, see 
“When statistics are reset” on page 6-13.

Note: Queue statistics by shift are not updated during gaps between shifts. For example, if one 
shift ends at noon and the next shift begins at 12:30, queue activity between 12:00 and 12:30 is 
not reflected in the shift totals. 

The Queue Statistics pane displays the statistics shown in the following table.

Queue Statistics Pane

Current Status

Queue status Whether the queue is currently distributing 
calls to agents. The possible statuses are:

Open. The queue is distributing its calls 
to ready agents as normal.

Closed. The queue is closed. No calls 
are being distributed to agents.

Closed - No agents. All agents in the 
queue are currently signed out, so the 
queue is automatically sending its calls 
directly to voicemail.
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Agents on break Number of agents currently signed in and in 
the On Break personal status.

Agents ready Number of agents waiting to receive queue 
calls. Ready agents are those who are signed 
in, have their personal statuses set to 
Available or Available (Queue Only), and are 
not currently off hook or in a wrap-up period.

Signed in and 
available

Number of agents eligible to receive queue 
calls, including those currently on a call or in 
wrap-up period. To receive queue calls an 
agent must be signed in and in a personal 
status whose Queue calls field is set to “Yes,” 
such as Available or Available (Queue Only.)

% agents ready The percentage of agents eligible to receive 
queue calls who are currently waiting for a 
call. The others are either off hook or in a 
wrap-up period.

Calls waiting
Number of calls currently waiting on the 
queue.

Calls being placed
Number outbound calls in the process of 
being placed. (Connected outbound calls are 
not counted.)

Agents wrap-up
Number of agents currently in the wrap-up 
period following a queue call.

Inbound Statistics

Calls answered Number of calls answered by an agent.

Calls transferred out

Number of calls transferred out of the queue 
without being handled by an agent, as a result 
of callers pressing the transfer key. (See 
“Offering the caller options while waiting on 
the queue” on page 2-35.)

Calls received Total number of calls received, including 
abandoned calls.

Calls abandoned Number of callers who hung up without talking 
to an agent.

Queue Statistics Pane
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Calls completed Number of completed calls in which a caller 
finished talked with an agent. Completed calls 
are calls that ended by hanging up or 
transferring.

Avg. talk time Length of the average time that callers spent 
talking with agents. 

Calls to voice mail Number of calls that went to voicemail without 
being handled by an agent, as a result of 
callers pressing the key to leave voicemail. 
(See “Offering the caller options while waiting 
on the queue” on page 2-35.)

Total talk time Total number of minutes that callers have 
spent talking with agents.

Longest time Length of the longest time in each of the 
following categories (by day only):

Talk time. Time spent talking with an 
agent.
Wait time. Time spent waiting on the 
queue.

Average wait time Average length of time callers waited on the 
queue for each of the following categories:

All calls. All inbound calls to the queue.

Answered calls. All calls to the queue in 
which the caller spoke with an agent.

Abandoned calls. All calls to the queue 
in which the caller hung up or left a voice 
message.

Queue Statistics Pane
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Redirection Number of calls that have been automatically 
redirected by the queue, for each of the 
following categories:

Maximum hold. Calls that reached the 
maximum wait time without being 
answered (see page 2-32).

Queue busy. Calls that were redirected 
because the queue was too busy (see 
page 2-30).

Queue closed. Calls that were redirected 
because the queue was closed (see 
page 2-8).

Outbound Statistics

Calls placed Number of outbound calls placed by this 
queue. 

Calls completed Number of connected calls that are now over.

Calls connected Number of calls that have connected with the 
called party.

Longest time* Length of the longest time by one call.

Average time* Length of the average time over all calls.

Total time* Total number of minutes from all calls.

* Talk time = Time spent talking with an agent.

Combined Statistics

Calls attempted Total number of inbound calls received and 
outbound calls placed.

Calls completed Total number of inbound and outbound calls 
completed.

Calls connected Total number of inbound calls that were 
answered and outbound calls that were 
connected with the called party.

Longest time* Longest talk time counting both inbound and 
outbound calls.

Average time* Average talk time counting both inbound and 
outbound calls.

Queue Statistics Pane
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When statistics are reset
Statistics are reset to zero at the following times:

Note: When a call overlaps a reset time, some statistics for it will appear in the first grouping, 
some in the second, depending on when the statistic is counted. For example, Calls Answered is 
counted as soon as the call is answered, while Calls Completed is counted when the call ends. 
Therefore, if a call lasts from 11:58 PM to 12:20 AM, it would be counted as a Call Answered in 
Day 1, and a Call Completed in Day 2.

Total time* Total talk time adding inbound and outbound 
calls.

* Talk time = Time spent talking with an agent.

Queue Statistics Pane

Statistic type When reset

Statistics by day At midnight, or when the Server is restarted.

Statistics by period On 15, 30, or 60 minute intervals, depending 
on your configuration for Statistics period 
interval (see “Defining the statistics period” on 
page 2-50). The intervals are counted from 
midnight, so a 15-minute interval would reset 
at 12:15, 12:30, 12:45, etc.

All queues that share the same statistics 
period interval reset at the same clock time.

Note: Period statistics are always reset 
counting from midnight, not from the time of a 
Server restart. This could result in a short 
period. For example, if the Server was started 
at 9:50, the period would still end at 10:00, 
resulting in a 10-minute period.

Statistics by shift At the end of the shift, as you defined it (see 
“Configuring shifts” on page 2-50). 
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When statistics are refreshed
By default the Queue Monitor folder refreshes with new statistics as soon as they become 
available, providing a real-time picture of queue activity. You can enter a slower refresh rate to 
improve the responsiveness of agents’ ViewPoint applications. You should change this setting 
if you find that agents’ ViewPoint applications are responding too slowly.

To change the Queue Monitor refresh rate

1. In the TeleVantage Administrator, choose Tools > System Settings. The System 
Settings dialog box opens.

2. Choose the Queue tab.

3. Enter the refresh rate you want (in milliseconds) in Queue statistics refresh interval.

4. Click OK.

About agents’ personal status and state
It is important to distinguish between an agent’s personal status and state.

� Personal status. Determines whether the agent receives queue calls. An agent's 
personal status is the same across all queues. 

� State. Displays the agent's current activity, for example, whether the agent is currently 
in a queue call. An agent's state can be different in different queues. For example, if an 
agent is a member of Queue A and Queue B, and the agent is currently in a call for Queue 
A, his state would be Active in Queue A and Standby in Queue B.

For a description of agent states, see the Agent State column in the Agents pane table on 
page 6-4.

Monitoring the position of agents in the queue
The Queue Monitor’s Distribution Order column—displayed as  in the Agents pane—shows 
the order in which ready agents are scheduled to receive calls. The agent with a 1 in the column 
is scheduled to receive the next call, followed by the agent with a 2 in the column, and so on. 
Unavailable agents do not receive a position number. Unavailable agents include agents who are 
signed out or in a personal status that makes them unavailable such as Do Not Disturb or 
Available (Non-Queue).

Note: You can enable or disable the Distribution Order column. See the next section.

The agent with a 1 in the distribution order will not necessarily receive the next call. The 
distribution order reflects the scheduled order according to the queue’s distribution algorithm, 
but it does not reflect which agents are currently Ready. A Ready agent might have 5 in the 
Distribution Order column and yet receive the next call because all other agents are busy at the 
moment. The agent who will receive the next call is the agent with the lowest distribution order 
number among Ready agents.
6-14 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



Distribution order numbers for overflow agents follow those for primary agents. For example, 
if a queue has 10 ready primary agents, the first scheduled overflow agent will display 11 in the 
Distribution Order column. The distribution order of overflow agents is determined first by tier, 
and then within each tier by the queue’s distribution algorithm. For more about overflow agents, 
see “Setting up overflow agents” on page 2-25.

The following table shows how agent positions are calculated for each distribution algorithm. 
The descriptions apply separately to primary agents and to each tier of overflow agents.

Algorithm Agent positions

Top down Agents’ positions are ordered by their order in 
the queue and do not change.

Round robin Agents’ positions are reordered according to 
which agent answered the previous queue call. 
Whenever an agent answers a queue call, the 
next agent down in the list becomes 1, the agent 
after that becomes 2, and so on. When the 
bottom of the queue is reached, the order 
continues from the top down until it meets the 
agent who answered the most recent call.

Longest idle agent Agent positions are ordered according to the 
length of time without being in an Active state. 
The agent who has gone the longest without 
being Active inbound is in position 1. 

Note that talking on non-queue calls and being 
in the On Break personal status place an agent 
in the Standby state, so that the time since the 
agent was Active continues to increase. 
Likewise, Wrap-up is not an Active state, so 
agents' wrap-up time also increases their “idle” 
time. Only receiving a queue call makes an 
agent Active and resets the agent's “idle” time.

An agent's position is reduced by 1 whenever an 
agent with a longer time since being Active 
receives or places a queue call. The only way 
for an agent's position to increase is for the 
agent to receive a queue call.
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Note: The distribution algorithms Longest idle, Fewest calls, Least talk time count inbound 
queue calls only.

Enabling and disabling the Distribution Order column
You can enable or disable the Distribution Order column in the Agents pane of the Queue 
Monitor. Disabling the column can speed up system performance. 

To enable or disable the Distribution Order column

1. In the Administrator, choose Tools > System Settings. The System Settings dialog 
box opens.

2. Choose the Queue tab.

3. Check or uncheck Update Agent Distribution Order column in Queue Monitor.

4. Click OK.

Fewest calls Agent positions are ordered according to which 
agent has received the fewest queue calls 
during the current display period. The agent who 
has received the fewest queue calls since the 
beginning of the shift is at position 1.

Note that the length of time spent on a queue 
call is not significant for adjusting position, only 
the number of queue calls participated in.

Least talk time Agent positions are ordered according to which 
agent has spent the least time on inbound 
queue calls during the current display period. 
The agent who has spent the least time on 
inbound queue calls since the beginning of the 
shift is at position 1.

Note that only calls from a queue count as talk 
time in that queue. An agent working in two 
queues will have a different talk time in each.

Simultaneous ring Agents have no position, as each call rings all 
agents’ phones simultaneously.

Skills-based or 
custom routing

Agent positions are ordered according to their 
agent score, to select the best-qualified agent 
for each call. See “Using custom agent scoring” 
on page 3-12.

Algorithm Agent positions
6-16 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



Monitoring queue statistics using the phone
Agents who have permission to monitor queue statistics can hear the current statistics for a 
queue at any time by picking up a TeleVantage phone and dialing *55. The system prompts them 
to select the queue for which they want to hear statistics.

Dialing *55 plays the queue statistics shown in the following table. Statistic totals are kept since 
midnight at the beginning of the current day.

Supervising other agents’ calls _____________________________
You can assign agents permission to supervise other agents’ calls in the following ways:

� Monitoring an agent’s call. The supervisor can listen to another agent’s call without 
being heard by the other agent or the caller.

� Coaching an agent on a call. The supervisor can coach another agent without being 
heard by the caller. The agent hears the supervisor but the caller does not. The 
supervisors can hear all parties.

� Joining an agent’s call. The supervisor can be conferenced in to another agent’s call as 
a full participant and be heard by both parties.

 *55 Queue Statistics

Callers waiting Number of callers waiting on the queue.

Expected wait time Rough estimate of how long callers can 
expect to wait if they called right now. The 
formula used is <total wait time of all 
answered calls so far this day> / <number of 
answered calls so far this day>.

Active agents Number of agents currently available. This 
includes all agents who are signed in and in 
the personal status Available or Available 
(Queue Only).

Total calls Total number of calls received today (since 
the last midnight).

Abandon rate Abandoned calls as a percentage of total 
calls.
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Supervising in a call center is a separate feature from supervising personal calls, and the two are 
controlled by different permissions, as follows:

� Supervising personal calls. Supervising personal calls requires TeleVantage user 
permissions set up by your system administrator. Users with only these permissions 
cannot supervise call center calls.

� Supervising call center calls. To supervise call center calls, you must be a call center 
agent with agent permissions set up per queue by your queue administrator. As a call 
center supervisor, you can supervise only other agents in your queue, and only their 
queue calls, not their personal calls.

Note: You can supervise an agent’s outbound queue calls only if the agent has associated his 
or her outbound calls with the queue. See “Placing calls from a queue” on page 5-8.

If the agent whose call you are supervising transfers the call to another party, or parks it and it 
is unparked by another party, you are disconnected.

How monitoring and coaching appear in the Call Monitor
When you are monitoring or coaching an agent on a call, the call appears in your Call Monitor 
showing all three parties to the call. Your row, the top row in the call, is labelled “Monitoring” 
or Coaching.”

If you are coaching an agent, the agent sees you as a party in the call. If you are monitoring an 
agent, the agent does not see you as a party, unless that agent has the permission View agents 
being monitored set to Allow. See the next section.

Note: When you join another agent’s call, the call appears as a normal conference call.

Viewing when agents are being monitored
Agents who have the permission View agents being monitored set to Allow can see when an 
agent is being monitored by another agent. The monitoring agent appears in the Call Monitor as 
another party in the call, identified by the Status “Monitoring.”

Agents who have the permission set to Disallow (the default) cannot see when they or other 
agents are being monitored.
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Notes

� When a supervisor begins supervising a queue call, any call notes disappear from the Call 
Monitor. This is because the notes are stored for the queue, not the agents. To see the 
call notes, look at the queue’s Call Log.  Agent notes made after the call will show in the 
agent’s Call Log.

� The Call Log does not keep a record of whether agents were monitored.

Managing agents’ status __________________________________
With supervisor permissions, agents can directly control the status of other agents in the queue 
in the following ways:

� Signing agents in or out of a queue

� Changing an agent’s personal status

Signing agents in or out of a queue
An agent who is signed in to a queue receives calls from that queue when ready. When signed 
out, the agent is still a member of the queue, but does not receive queue calls. An agent who is 
signed out can still view queue calls in the Call Monitor folder and answer them if necessary by 
using the Take Call command.

Supervisors with the Sign In/Out other agents permission can use sign other agents in or out 
of a queue. You can use this feature to move agents among queues without having to delete them 
from one queue and add them to another. For example, if Kim works as an agent in the Sales 
queue in the morning and in the Support queue in the afternoon, a supervisor can sign Kim out 
for the Sales queue at midday and sign her in for the Support queue.

Note: Agents with the Queue Sign In/Out permission can sign themselves in and out of the 
queue. See “Signing in and out of a queue” on page 5-5.

You can sign agents in or out using either ViewPoint or the Administrator.

Signing agents in or out using ViewPoint
To use this procedure you must have the agent permission Sign In/Out other agents (see 
“Agent permissions” on page 2-14) and the general TeleVantage permission Access Queues 
folder (see Administering TeleVantage).

1. Open the Queue Monitor folder by clicking its icon in the Folder List.

2. If there are tabs for more than one queue, click the tab of the queue for which you want 
to sign the agent in or out.

3. In the Agents pane, select the agent.

4. Choose Actions > Sign this agent into queue or Sign this agent out of queue. The 
command signs the agent in or out. 
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Signing agents in or out using the Administrator
To use this procedure you must have the general TeleVantage permission Access Queues 
Folder (see Administering TeleVantage).

1. Open the Queues folder and double-click the queue for which you want the agent to 
be signed in or out. The Queue dialog box opens.

2. Click the Agents tab and double-click the agent’s name in the Agents in this queue 
list. The Agent dialog box opens.

3. Check or uncheck This agent is signed in.

4. Click OK to close the Agent dialog box.

5. Click OK to close the Queue dialog box.

Changing an agent’s personal status
A agent who has the permission Change an agent’s personal status set to Allow can directly 
change the personal statuses of agents in the queue. A supervisor can use this feature in the 
following situations:

� When agents are prevented from changing their own personal status. In this case you 
must manage their workflow for them, changing their personal status to begin and end 
their workday and to let them take breaks.

� When agents leave their phones and forget to change their personal statuses themselves. 
In this case, you can set the personal statuses of the agents to On Break.

� When the queue is configured to automatically place agents On Break if they let calls 
from the queue go unanswered. In this case, you ensure that agents become ready when 
they return to their desks.

� When agents leave for the day and are still ready. In this case, you can change their 
personal statuses to make the agents unavailable.

Important: If agents leave at the end of their workday without making themselves unavailable, 
you must make them unavailable before the start of the next workday, or the reports data will be 
inaccurate.

To change an agent’s personal status

1. In ViewPoint, select the agent on the appropriate tab in any of the following locations:

� The Extensions folder

� The Extensions pane in the Call Monitor folder

� The Agents pane in the Queue Monitor folder

2. Choose Actions > Apply Personal Status, and then select a personal status.

For more information about how to use personal statuses, see Using TeleVantage.
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Managing a queue’s voice mailbox__________________________
Agents who have the permission Access queue mailbox set to View and Edit can manage voice 
messages that callers leave in the queue’s voice mailbox. They can listen to messages, reply to 
them, and delete them. They also can create voice mailbox folders and move messages among 
those folders.

Agents who have the permission set to View Only can see and listen to voice messages, but not 
perform any other commands on them.

To access the queue’s voice mailbox, click voicemail in the navigation bar, then click the folder 
with the queue’s name in the Favorite Folders list.

For complete instructions on managing voice messages using ViewPoint, see Using 
TeleVantage.

Managing queue voice messages on the telephone 
You can also manage a queue’s voicemail using the telephone by logging in as the queue. When 
logging in, use the queue’s extension and password. 

For instructions on logging in and managing voice messages using the telephone commands, see 
Using TeleVantage.
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About ACD workgroups ___________________________________
This chapter provides instructions for setting up and using an Automatic Call Distribution 
(ACD) workgroup. ACD workgroups enable you to distribute incoming calls among several 
agents. If all agents are busy, calls remain on hold until agents become ready to answer them. 
You can use an ACD workgroup in a sales department, a customer support organization, or any 
department in which multiple agents answer calls to a single number. 

ACD workgroups are an alternative to the separately-licensed TeleVantage call center queues 
system (see Chapter 2 through Chapter 6). It is recommended that you use call center queues as 
your call center system, since they provide more features. However, you can use either system 
with TeleVantage.

TeleVantage ACD features
For a full list of ACD features, and a comparison with call center features, see “Call center queue 
and ACD workgroup features” on page 1-3.

What agents experience
Ready ACD agents can wait for their phones to ring or they can answer calls by choosing 
Actions > Take Call in the Call Monitor folder in ViewPoint. Taking calls in this way does not 
affect their position if they are in a round-robin workgroup. To use ViewPoint with the ACD 
workgroup, agents log on to their own accounts and view ACD workgroup calls in a shared Call 
Monitor folder tab. All agents can see the ACD workgroup’s calls. After an agent answers a call, 
the other agents continue to see it in their Call Monitor views, but they cannot interrupt or affect 
it.

For instructions on participating as an agent in an ACD workgroup, see “Participating in an 
ACD workgroup” on page 7-14.

What callers experience
Callers choose an option from the auto attendant main menu to go to a department (for example, 
“For Sales, press 2”). If all agents in the ACD workgroup are busy, callers are placed on hold. 
They hear a recorded message periodically that you can customize. While they are on hold, 
callers can enter 1 to stop waiting and leave a voice message. They can also enter 0 to transfer 
to the Operator, or they can remain on hold indefinitely until the call is answered.

You also can create an overflow workgroup that handles calls when all agents are busy, and you 
can create multiple groups that handle different work shifts. Both of these options are described 
in “Creating an overflow workgroup” on page 7-11.

Important: It is highly recommended that you use music-on-hold for callers who are waiting for 
an agent. If you do not have a station set up to play music-on-hold, callers hear the ringing tone 
as they wait for an agent.
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Overview of setting up an ACD workgroup
To set up an ACD workgroup, you must create the following items:

� A new TeleVantage user of the type ACD workgroup user. This user does not represent 
a real person. It functions as a mechanism for distributing calls to agents.

� A new TeleVantage workgroup whose members are the users who will work as agents. 

� A routing list for the ACD workgroup user that directs incoming calls to the workgroup. 

Note: The term ACD workgroup refers to the complete system that exists after the three items 
in the previous list have been created.

How to direct calls to the ACD workgroup
You direct incoming calls to the ACD workgroup by sending them to the ACD workgroup user. 
The ACD workgroup user’s routing list then automatically distributes the calls to agents (see the 
next section).

You can send calls to the ACD workgroup user in any of the ways that you send calls to a normal 
user, as follows:

� Give the ACD workgroup user’s extension a menu option from the auto attendant, so 
that callers can choose, for example, “Press 1 for Technical Support.” The option 
transfers the call to the ACD workgroup user.

� Give the ACD workgroup user a DID number, which allows callers to dial a complete 
phone number and reach the ACD workgroup user directly. Your phone lines must 
support DID to use this option.

� Dedicate a trunk to the ACD workgroup user, so that all incoming calls on the trunk are 
sent to the ACD workgroup user.

� Give the ACD workgroup user an extension, so that other users in the company can 
transfer calls to the ACD workgroup.

How calls are distributed to agents
Calls to the ACD workgroup are automatically distributed to agents by means of the ACD 
workgroup user’s routing list. When calls are sent to the ACD workgroup user (see the previous 
section), its routing list automatically puts them on hold until an agent becomes ready, plays 
them any messages that you record for that purpose, and finally transfers them to a ready agent. 

You can customize several aspects of the routing list, such as what messages play to callers 
while they wait on hold and how calls are distributed among ready agents.
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Creating an ACD workgroup________________________________
To set up an ACD workgroup, you will use both the TeleVantage Administrator and 
TeleVantage ViewPoint. 

Creating an ACD workgroup involves the following steps. The first sentence in each step 
corresponds to the heading of a section in this chapter that explains the step in detail.

1. Creating the ACD workgroup user. In the Administrator, create a new user of the 
type ACD workgroup user. Name it for the ACD workgroup (for example, “Sales”). 
See page 7-5.

2. Creating the workgroup for the ACD agents. In ViewPoint, create a workgroup that 
contains the agents who will participate in the ACD workgroup. You can create more 
than one workgroup of agents if you want a primary workgroup and backup groups. 
See page 7-6.

3. Creating the ACD workgroup user’s routing list. In ViewPoint, give the ACD 
workgroup user an active routing list with the “Call me at multiple locations” action. 
This routing list then distributes calls to the agents in the workgroup. Give the routing 
list a final action of Hold/Restart, so that if all agents are busy, the caller remains on 
hold until an agent is ready. See page 7-7.

4. Sharing the ACD workgroup user’s Call Monitor, voice message folders, Call Log, 
and Contacts folders. In ViewPoint, share these folders to the workgroup of agents, 
so that the agents can manage incoming queue calls, the queue’s voicemail, the 
queue’s call history, and the queue’s contacts. See page 7-11.

5. Creating the menu choice in the auto attendant. In the Administrator, create an auto 
attendant menu choice that transfers callers to the ACD workgroup user’s extension 
(for example, “For Sales, press 2”). See page 7-13.
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Creating the ACD workgroup user
The ACD workgroup user does not represent a real person with a phone. It is a mechanism that 
keeps calls on hold and then sends them to members of one or more workgroups.

To create the ACD workgroup user

1. In the Administrator, choose File > New > User. 

2. From the Type dropdown list, select ACD workgroup user.

3. Name the user after the workgroup that you will create. In the example given here, the 
workgroup represents the Sales department, so the name “Sales” has been entered in 
the Last name field.

4. Accept the extension suggested or enter a different one. Give the user a password. 
Assign a station ID of 0. The workgroup user does not have a phone and calls to this 
extension are routed to the agents’ phones by the user’s routing list in ViewPoint.

Note: You can also give the ACD workgroup user a Direct Inward Dial (DID) number 
if you want a dedicated phone number for the workgroup. This number can be instead 
of or in addition to a menu choice from the auto attendant. Your phone lines must 
support DID to use this option.

5. Click the Recordings tab. As a voice title for the ACD workgroup user, record the 
name of the workgroup (for example, “Sales”). Callers who choose the workgroup 
from the main menu will hear “Transferring to” followed by the voice title.

6. On the Recordings tab you can give the ACD workgroup user a mailbox so that callers 
can leave a voice message instead of waiting on hold. It is recommended that you 
increase the size of the mailbox if the number of agents in the workgroup or the volume 
of calls is high. 
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7. Click the Call Handling tab. Under Screen and announce the caller for these types 
of calls, uncheck Internal, External, and External Direct. If these types of calls are 
left checked, callers receive prompts to state their names.

8. Click OK.

Agent vs. workgroup user call screening settings
A TeleVantage advanced setting, Server\UseUserScreeningSetting, governs how call 
screening settings interact with ACD workgroups when an agent is forwarding calls. For 
example, an ACD workgroup agent might have Prompt recipient to accept or decline call 
checked in his forwarding options, while the ACD workgroup user has call screening unchecked 
for all calls.  The advanced setting governs which call screening settings are used in case of 
conflicts. For more information on advanced settings, see Appendix J of Installing TeleVantage.

Creating the workgroup for the ACD agents
1. Log on to ViewPoint as the ACD workgroup user.

2. Choose File > New > Workgroup. The Workgroup dialog box opens.

3. Name the workgroup after the ACD workgroup, for example, “Sales.”

4. Build the workgroup by selecting each agent in the Available Extensions list, and 
then clicking Add. Press CTRL to select multiple agents. Added agents appear in the 
Members list.

To have agents answer calls from home, have them forward their calls to the external 
phone. You could also define them as contacts and add them to the workgroup here.
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Note: Contacts in an ACD workgroup and users with call forwarding are ignored if you 
use the Simultaneous distribution method.

5. Use the arrows next to the Members list to change the order of agents in the 
workgroup. The Top Down method of distributing calls starts at the top of the 
workgroup, so if you are using that method you might want your most skilled agent 
listed first. The Round Robin method is also slightly affected by the order of the 
workgroup. For the Simultaneous method, workgroup order is ignored.

6. Click Apply or OK.

Repeat the steps above if you need to create other workgroups. You might create more than one 
workgroup if you are defining overflow agents or shifts. See “Using multiple groups for specific 
shifts” on page 7-10 and “Creating an overflow workgroup” on page 7-11.

Note: Agents can answer incoming calls for a workgroup whether or not they are in the 
workgroup. As long as you have shared the ACD workgroup user’s Call Monitor folder with them, 
they can answer incoming calls by using the Actions > Take Call command in the Call Monitor 
folder. The Take Call command overrides the first-in, first-out hold sequence. In this way their 
phones do not ring with ACD calls, but they can relieve the burden on workgroup members if 
several callers are waiting on hold. 

Creating an Extensions folder tab that shows the agents
You can have the agents of the ACD workgroup appear in a separate tab in ViewPoint’s 
Extensions folder. The tab shows the members of the workgroup, making it easy to see all agents 
and their current status. The tab is visible to all agents.

To create an Extensions folder tab for the agents

1. Using the Administrator, create a new public workgroup.

2. Populate the workgroup with the ACD workgroup agents, just like the personal 
workgroup that you created in the previous section. Include in the public workgroup 
all the ACD workgroup’s agents, even if you had split them between multiple personal 
workgroups to create overflow agents or shifts. 

Because the workgroup is public, it automatically appears as a tab in the Extensions folder of its 
members. The ACD workgroup does not use this workgroup to distribute calls—the 
workgroup’s only function is to provide the Extensions folder tab.

Note: If you add or remove agents from the personal workgroup attached to the ACD workgroup 
user’s routing list, remember to add or remove the same agents from the public workgroup.

Creating the ACD workgroup user’s routing list
The ACD workgroup user’s routing list takes incoming calls to the ACD workgroup user and 
distributes them to the agents. To do this, the routing list uses the action Call a workgroup, 
which rings agents in a workgroup.
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If an agent is already on the phone, the routing list skips that agent and proceeds to the next agent 
in the workgroup. If an agent does not answer the phone, the routing list rings it for the number 
of seconds that you specify and then proceeds to the next agent. If all agents are unavailable, the 
call continues to the next action in the routing list, if there is one. You can configure the next 
action to send calls to a second, overflow workgroup.

If no one in the workgroup is ready, TeleVantage plays the caller a hold message, and the routing 
list begins at the first action again. The call continues to cycle until it is answered or until the 
caller chooses to stop waiting.

Important: It is highly recommended that you use music on hold for callers waiting for an agent. 
If you do not have a station set up to play music on hold, callers hear the ringing tone as they wait 
for their calls to be answered. For more information about playing music for callers on hold, see 
Administering TeleVantage.

To create the ACD workgroup user’s routing list

1. Log on to ViewPoint as the ACD workgroup user.

2. In the Routing Lists folder, choose Routing Lists > New Routing List. The Routing 
List dialog box opens. 

3. Enter a name for the routing list.

4. Delete the action Call me where I am from the Actions list. You will add the new 
action in step 7.

5. Under Final action if the call is not answered, set the following options:
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� Under Action, choose Pause and Repeat. This setting ensures that if all agents are 
busy, callers remain on hold and cycle through the routing list again. The result is 
that they remain on hold until their calls are answered.

� Optionally, change the greeting in the Play Greeting dropdown list, or uncheck the 
field to have no greeting play. Note that if all agents are busy, callers hear the 
greeting multiple times, separated by the Pause Duration setting, until their calls 
are answered. This recording can be a special one that you make that assures callers 
that their calls are important and will be answered. You can choose the System Hold 
Greeting, which says, “The person you are calling is unavailable. To hold, please 
stay on the line. To leave a message, press 1.” To record a new greeting directly 
from this dialog box, click the button next to the field. See Using TeleVantage for 
instructions on how to record greetings.

Note:The caller options of pressing 0 or 1 (to transfer out of hold or leave voicemail) 
work only while the greeting is playing. After the caller goes back on hold, key 
presses are inactivated. Therefore, be sure to record a few seconds of silence at the 
end of your greeting so that the caller has enough time to press a key.

� Under Pause Duration, specify how long calls pause after each cycle before 
beginning the routing list again. If you play a greeting, you should set this to at least 
30 seconds, because if all agents in the routing list are busy, callers will hear the 
greeting over and over again, separated only by the time you enter here.

6. Check Active routing list for this extension and Default personal status routing 
list.

7. Click Add to add a new routing list action to the Actions list that will distribute calls 
to the ACD agent workgroup. The Routing List Action dialog box opens. 

8. From the Action dropdown list, select Call a workgroup. 

9. From the Workgroup dropdown list, select the workgroup that contains the ACD 
agents. Be sure to select the ACD workgroup user’s personal workgroup, not the 
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public workgroup that you created for purposes of showing Extensions folder tabs (see 
“Creating the workgroup for the ACD agents” on page 7-6). 

You can create a new workgroup directly from this dialog box by clicking the button 
next to the field.

10. Choose one of the following distribution methods:

� Sequentially from the top down. Calls try the agents in a fixed sequence. Each call 
goes to the agent at the top of the list first. If that agent is busy, the call goes to the 
next agent on the list, and so on. 

� Individually in a round robin. Calls try the agents in the same sequence as with Top 
Down, but starting with the next agent each time. If the first call was answered by 
the first agent on the list, the next call starts by trying the second agent on the list, 
and so on. This option distributes calls equally throughout your workgroup.

� Simultaneously. All phones ring at once, and the first agent to answer the call takes 
it. This feature is especially handy for small offices or departments. Call forwarding 
is ignored, so that only the agents’ default phones are tried. Any contacts in the 
workgroup are ignored, unlike the other two methods. 

Note: For information about reordering a workgroup, see “Creating the workgroup for 
the ACD agents” on page 7-6.

11. In the Ring duration field, set the minimum number of seconds that TeleVantage 
should ring each agent. TeleVantage rings each ready agent in the workgroup for the 
amount of time entered here. External contacts ring for at least 30 seconds even if you 
specify a lower number.

12. Under When calling an external number, uncheck Prompt recipient for password. 
This setting ensures that agents working at external phones can answer ACD calls 
without any delay.

13. Uncheck Prompt caller before trying this action.

14. Click OK to close the Routing List Action dialog box.

15. In the Routing List dialog box, click OK.

See Using TeleVantage for more information about routing lists.

Note: Always set the routing list to send calls to a workgroup as described here. If you set the 
routing list to send calls to individual agents, first-in, first-out (FIFO) hold will not work.

Using multiple groups for specific shifts
If your ACD workgroup has different agents that replace each other in shifts, you can create 
multiple groups to represent the different shifts of agents. When a shift changes, you can edit the 
routing list so that it points to the new workgroup, as follows:

1. In the Routing List folder in ViewPoint, double-click the active routing list for the 
ACD workgroup user.

2. Double-click the action Call workgroup.
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3. Under Workgroup, select a different workgroup.

4. Click OK to close the Routing List Action dialog box.

5. Click OK to close the Routing List dialog box.

You can also create different routing lists for the ACD workgroup user, each of which points to 
a different workgroup, then create a call rule for the ACD workgroup user that automatically 
switches routing lists at the times of day when the shifts change. For more about call rules, see 
Chapter 17 of Using TeleVantage.

Creating an overflow workgroup
You can create one or more overflow groups of agents that receive ACD calls if all agents in the 
primary ACD workgroup are busy. 

1. Create a second workgroup that contains the agents that you want to be in the overflow 
workgroup. See “Creating the workgroup for the ACD agents” on page 7-6 for 
instructions.

2. Create a second action in the ACD workgroup user’s routing list that is similar to the 
first action, but that points instead to the overflow workgroup. A call cycles through 
all agents in the first workgroup. If they are busy, the call proceeds to the overflow 
workgroup. 

Continue creating the routing list action as shown in “Creating the ACD workgroup 
user’s routing list” on page 7-7.

Sharing the ACD workgroup user’s folders to the agents
You can share the following folders from the ACD workgroup user’s account to the agents, 
giving the agents the ability to access the folders in their ViewPoints.
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� The Call Monitor. Agents can see a separate tab in their Call Monitor views that displays 
ACD workgroup calls. Agents can switch between that tab and the All tab, which shows 
their ACD and non-ACD calls together.

� Voice message folders. If you share the Inbox, agents can listen to and manage the 
queue’s new voice messages. If you share the Deleted folder, agents can delete the 
queue’s voice messages. If you share other voice message folders, such as the Saved 
folder, agents can move the queue’s messages between folders.

� The Call Log. Agents can view and respond to the queue’s call history.

� Contacts folders. Agents can view and edit the queue’s contacts.

To share an ACD workgroup user’s folder to the agents

1. Log on to ViewPoint as the ACD workgroup user.

2. If the Folder List is not showing, choose View > Folder List.

3. Right-click a folder that you want to share and choose Share. The Folder Properties 
dialog box opens to the Sharing tab.

4. In the Available users list, select the ACD workgroup.

5. Click Add. The members of the workgroup are added to the Share with these users 
list.

6. Click OK.

7. Repeat steps 3-6 to share other folders.

Notes

� You do not have to share every folder with every agent. For example, you could share the 
voice message folders only with certain agents, so that only they would be able to manage 
the queue’s voicemail. To remove an agent from the Share with these users list, select 
the agent and click Remove.

� You can share a folder with other users in addition to agents by adding them to the Share 
with these users list. Because the other users are not in the workgroup, they will not 
receive ACD workgroup calls. However, they will be able to see and manage the ACD 
workgroup folders. If you share the Call Monitor to other users, they will see ACD 
workgroup calls in their Call Monitor views, and they will be able to answer a call using the 
Take Call command. 
7-12 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



Creating the menu choice in the auto attendant
This step adds a choice to your company’s auto attendant main menu that transfers callers to the 
ACD workgroup user.

Important: When you complete the following procedure, your ACD workgroup will be available 
to callers, and you might start receiving calls. For information about taking the ACD workgroup 
temporarily offline, so that calls to it are sent directly to voicemail, see “Taking the ACD workgroup 
offline” on page 7-17.

For other ways to direct calls to the ACD workgroup user, see “Overview of setting up an ACD 
workgroup” on page 7-3.

To create the menu choice in the auto attendant

1. In the Administrator, open the Auto Attendants view and double-click your auto 
attendant. The Auto Attendant dialog box opens.

If you have multiple auto attendants, perform these steps for each auto attendant in 
which you want to offer callers the menu choice of transferring to the ACD 
workgroup.

2. Click the Menu Choices tab.

3. Click Add. The Edit Menu Choice dialog box opens. 

4. Record the prompt that you want callers to hear as part of your main menu, for 
example, “For the Sales department, press 2.”
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5. From the When caller presses dropdown list, choose the key that the caller must press 
to be transferred to the ACD workgroup. 

6. From the Perform action dropdown list, choose Transfer to user, and then click the 
name of the ACD workgroup user in the list of users.

7. Click OK to close the Edit Menu Choice dialog box and then click OK in the Auto 
Attendant dialog box to close it.

Participating in an ACD workgroup __________________________
This section describes how agents participate in an ACD workgroup.

Important: This section covers instructions for working in an ACD workgroup only. For 
instructions on working in a call center queue, see Chapter 5.

Enabling personal status for ACD workgroup agents
By default, agents in an ACD workgroup must begin and end their shifts by checking and 
unchecking the Accept ACD Workgroup calls field in ViewPoint (see the following sections). 
However, if you enable the advanced setting Server\UseGroupMemberDNDSetting, ACD 
workgroup users can use begin and end their shifts by placing themselves in the Available and 
Do Not Disturb personal statuses, which they can do using either ViewPoint or the telephone 
commands.

If Server\UseGroupMemberDNDSetting is enabled, when an ACD workgroup agent places 
himself or herself in the Available personal status, it automatically checks the Accept ACD 
Workgroup calls field, letting the agent receive ACD workgroup calls. Likewise, selecting the 
Do Not Disturb personal status automatically unchecks Accept ACD Workgroup calls, 
preventing the agent from receiving ACD workgroup calls.

Note: With Server\UseGroupMemberDNDSetting disabled, the Do Not Disturb personal 
status does not prevent ACD workgroup calls, unless the agent also manually unchecks Accept 
ACD Workgroup calls.

For instructions on enabling Server\UseGroupMemberDNDSetting, see Appendix J of 
Installing TeleVantage. For instructions on using personal status, see Using TeleVantage.

Marking yourself ready and unavailable
To mark yourself as ready to receive ACD workgroup calls:

1. Log on to ViewPoint using your own name and password.

2. Click Tools > Options.

3. Click the Incoming calls tab.

4. Check Accept ACD Workgroup calls.

5. Click OK.
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To mark yourself as unavailable, which stops ACD workgroup calls from being sent to you, 
uncheck Accept ACD Workgroup calls. 

Note: If your ACD workgroup uses the simultaneous ring method, you cannot make yourself 
available while a call is ringing and answer it. Because you were not available when the call 
started ringing, your phone will not be rung for that call.

Using the Call Monitor
To use the Call Monitor to handle ACD workgroup calls, agents log on to ViewPoint using their 
own names and passwords. They can view incoming ACD workgroup calls by using the ACD 
workgroup tab in their Call Monitor views.

Call Monitor folder tabs work as follows:

� My Phone. Displays non-ACD calls.

� <ACD workgroup user name>. Displays ACD workgroup calls only.

� All. Displays all calls together.

Important: For agents to see the ACD workgroup tab in their Call Monitor views, you must have 
shared the ACD workgroup user’s Call Monitor with them. See “Sharing the ACD workgroup 
user’s folders to the agents” on page 7-11.

Receiving a call
When a call to the ACD workgroup arrives, the phones in the workgroup ring according to the 
method specified by the routing list. Calls continue to ring agents until they are answered or until 
the caller chooses to leave a message or hang up.

Incoming calls appear in all participating agents’ Call Monitor views immediately. Agents do 
not have to wait for their phones to ring to take a call. As soon as an incoming call appears, they 
can click it in the Call Monitor folder and choose Actions > Take Call.

The status of a call in progress appears in agents’ Call Monitor views as “Active.” Agents cannot 
affect other agents’ active calls. However, they can perform any action on their own calls, such 
as Hold, Transfer, Mute, and so forth.
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Placing ACD workgroup calls
If you are an ACD workgroup agent and you place a call at your desk using the telephone or 
ViewPoint, by default TeleVantage marks the call as a call made by you. However, you may 
need to place outgoing calls as part of your work as an ACD workgroup agent. Such calls in 
TeleVantage can be marked as calls from the ACD workgroup—not as calls from your 
extension—so that reports on ACD workgroup activity accurately reflect agent performance. 

To mark all subsequent outbound calls as ACD workgroup calls, use your telephone keypad to 
press *14<ACD workgroup user’s extension># at a dial tone. All calls that are made from your 
station are now logged as calls that are made by the ACD workgroup user. The calls appear in 
the Call Monitors of all agents in the workgroup. The calls do not appear on the My Phone tab 
in your Call Monitor. The calls are logged both in your personal Call Log and the ACD 
workgroup user’s Call Log, with the queue name in the From column.

To switch back, and mark subsequent outbound calls as being from you, press *14# at a dial tone 
again. All subsequent calls from your station are now marked as being placed by you. These 
calls appear only in your Call Monitor and only in your Call Log.

Taking a break
To take a break during your work shift, uncheck Accept ACD Workgroup calls as described in 
“Marking yourself ready and unavailable” on page 7-14.

Note: The Do Not Disturb personal status does not stop ACD workgroup calls from ringing your 
phone.

Listening to the ACD workgroup’s voicemail
If you have shared the ACD workgroup user’s Inbox with other agents, and given those agents 
the required permission, they can play and respond to the ACD workgroup’s voice messages. 
To do so, they go to the ACD workgroup’s Inbox under Shared Folders in the Folder List.

Agents can play and respond to the ACD workgroup’s voice messages exactly as they work with 
their own voice messages.

Viewing the ACD workgroup’s contacts and Call Log
If the ACD workgroup’s contacts and Call Log have been shared with you, you can view those 
folders under Shared Folders in the Folder List.
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Taking the ACD workgroup offline __________________________
You can take the entire ACD workgroup offline by logging on to the ACD workgroup user’s 
account and selecting the Do Not Disturb personal status. All calls to the ACD workgroup are 
then sent directly to voicemail.

To bring the ACD workgroup back online, select the Available personal status for the ACD 
workgroup user.

Analyzing ACD workgroup traffic ___________________________
The Call Log folder in TeleVantage ViewPoint is an excellent tool for analyzing ACD 
workgroup traffic. The Call Log folder is described in detail in Using TeleVantage. This section 
focuses on the columns in the Call Log that are of particular interest when analyzing ACD 
traffic.

A more comprehensive tool for analyzing ACD traffic is the TeleVantage Call Center Reporter, 
which generates detailed reports in Microsoft Excel. For information about licensing and using 
the Call Center Reporter, see Chapter 8, “Running Call Center Reports.”  

Viewing Call Log folder columns
Some of the Call Log columns that are helpful for analyzing ACD traffic are hidden by default. 
To view them, choose View > Current View > Show Columns. 

Reading the Call Log folder
Using the Call Log folder is discussed in detail in Using TeleVantage.
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Columns of interest in analyzing ACD workgroup activity are:

� Wait Time. Shows how long the caller waited on hold beginning at the moment a menu 
choice was made that transferred the caller to the workgroup and ending at the moment 
the call was answered.

� Answered by. Shows the name of the agent who accepted the call. 

� Placed by. Shows the name of the agent who placed place an outbound call associated 
with the ACD workgroup.

� Duration. Shows how long the active call lasted, beginning at the moment the 
connection began and ending when the call was disconnected.

� Left message. If checked, the caller left a message.

� Result. Shows how the call ended. The possible results are:

� Abandoned. The caller hung up before the call was answered.

� Connected. The call was accepted by an agent.

� To voicemail. The caller was sent to voicemail. This result does not necessarily 
mean that the caller left a message. If the caller left a message, the Left Message 
column is checked.

� Blind transfer/Supervised transfer. The caller was transferred to a new party at 
some point during the call.

Sorting by column
Click a column header to sort the information according to that column. Click the header again 
to sort in the opposite direction. By sorting on different columns you can see various aspects of 
agent and workgroup performance, such as:

� The agent who handled the most calls

� The agents who had the longest calls

� The time of day during which callers wait longest on hold

� The agents who handled calls from specific callers
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About the Call Center Reporter _____________________________
The Call Center Reporter allows you to run more than a dozen detailed reports on call activity 
and telephone usage in TeleVantage. You run reports on both queue calls and activity that has 
nothing to do with queues, such as general user and trunk usage. By carefully tracking the 
relevant call activity, you can quickly identify how effectively your phone system is being used 
by agents, queues, or trunks.

With the Call Center Reporter, you can analyze data from both types of TeleVantage call 
distribution systems—call center queues and ACD workgroups—depending on the report. You 
can also analyze general system data not related to call distribution systems, such as the activity 
on your trunks.

You can configure each report to show information over any time period, from a single day to 
months or even years.

Important notes

� You cannot run reports on time periods for which you have archived the Call Log. 
Archiving removes information from the TeleVantage database and makes it unavailable 
for reports. 

� If you are running the Call Center Reporter on a computer other than the TeleVantage 
Server computer, make sure that the clocks on the two computers are synchronized. All 
report times and dates are based on the clock of the local PC.

Call Center Reporter requirements
To run the Call Center Reporter, you need the following:

� Microsoft Excel 2000, XP or 2003 installed on your system. TeleVantage uses Excel to 
display reports. Excel 97 is not supported.

� Permission to run reports. You must have the permission Access Call Center Reporter 
set to Allow. See Administering TeleVantage for instructions on setting permissions.

� One Reporter license.

Reporting on data from an earlier version of TeleVantage
Some reports cannot include data from earlier versions of TeleVantage. When you run those 
reports, you see only data since the date of your upgrade, even if you select a time range that 
begins earlier. The table in the next section shows which reports can and cannot report on data 
from earlier versions of TeleVantage.
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Running a report_________________________________________
The following steps describe how to start the Call Center Reporter and run a report.

To run some reports, you must first define general Reporter Options. See “Setting general 
Reporter options” on page 8-7.

Note: You can run reports on ACD workgroups only, not public or personal workgroups. To run 
a report on an ACD workgroup, select the name of the ACD workgroup user.

1. Do one of the following:

� In TeleVantage ViewPoint, choose Tools > Reports. 

� Run the program TVReporter.exe. If you start the Reporter using this method you 
must log on using your user name and password. By default, the full path for this 
file is: 
C:\Program Files\TeleVantage\Client\Reporter\TVReporter.exe

The TeleVantage Call Center Reporter dialog box opens.

2. In the Report column, double-click the name of the report that you want to run. The 
report template opens in Microsoft Excel and shows data according to the options most 
recently set for that report.

If the following prompt regarding macros appears while Excel is opening, check 
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Always trust macros from this source. Then click Enable Macros.

3. The Options dialog box for the selected report should appear. If not, you can click 
Report Options on the Excel Reporter toolbar. See “Using the Call Center Reporter 
toolbar in Excel” on page 8-4. Enter information in the fields of the Options dialog box 
to specify the parameters of the report. See “Using individual report options” on 
page 8-8 for more information.

4. Click OK. The report runs and appears in Excel.

5. Use Excel’s options to view the report in graphical or spreadsheet format.

The Reports dialog box remains open. To run another report, double-click another report name 
in the Reports dialog box.

Viewing report headers and footers
You must have a printer installed on your computer in order to view the headers and footers on 
reports. The headers and footers include such data as report title, agent and queue name, date 
range, date printed, and the days of the week for the report. If you do not have a printer (local or 
network) configured on your computer, the headers and footers will be blank.

Using the Call Center Reporter toolbar in Excel
TeleVantage makes Call Center Reporter options available to you from within Excel on a 
Reporter toolbar. To display the Call Center Reporter Toolbar in Excel, choose View > Toolbars 
> Call Center Reporter Toolbar.

Note: For the Call Center Reporter toolbar to be available, you must have opened a report from 
the TeleVantage Call Center Reporter dialog box.
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The Call Center Reporter toolbar offers buttons for the commands listed in the following table.

Shared and local reports
Reports can be either shared or local, as follows:

� Shared reports are stored on the TeleVantage Server computer and can be run from any 
TeleVantage ViewPoint workstation. Shared reports are indicated in the Reporter dialog 
box by  or  in the Shared/Data column.

The default path for shared reports on the Server computer is 
C:\Program Files\TeleVantage Server\Reports

� Local reports are stored on TeleVantage ViewPoint computer and can only be run from 
that computer. Local reports are indicated in the Reports dialog box by  in the 
Shared/Data column.

The default path for local reports is 
C:\Program Files\TeleVantage\Client\Reporter\Reports

The reports that come with TeleVantage are all shared reports.

Call Center Reporter toolbar buttons

New TeleVantage Report. Opens the 
Reports dialog box or brings it to the front 
if it is already open, so that you can select 
a report to run. See “Running a report” on 
page 8-3.

Export without Macros. Saves the report 
so that it can be opened in Excel on any 
PC. Reports saved with macros can be 
opened only on PCs with TeleVantage 
applications installed.

Report Options. Opens the Report 
Options dialog box for the report currently 
showing, so that you can change the 
report parameters and run the report 
again.

Refresh Report. Runs the report again 
with the same options as were used to 
generate the current report. Use to 
update the report with the latest data.

Help. Opens the TeleVantage Call Center 
Reporter online Help.
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To share a local report

1. Select the report in the Reports dialog box.

2. Choose File > Share.

After sharing a report, click the Refresh button on the Reports dialog box toolbar ( ) to see 
the shared report in the Reports dialog box. 

Do not edit local TeleVantage report templates
TeleVantage maintains template (.XLT) files for its reports on the local computer for its internal 
use. Do not modify these as a means of editing the TeleVantage reports. If you do, your changes 
will be lost, because TeleVantage regularly overwrites the reports.

To modify a report template, save the .XLT file with a different name so that it is not overwritten 
by the Reporter.

Reporting on internal calls
Whether or not your reports include internal (station-to-station) calls depends on whether you 
are logging that data. To specify whether or not you are logging internal calls, do the following:

1. In the Administrator, choose Tools > System Settings.

2. Click the Call Log and Trunk Log tab.

3. To log internal calls, select Log internal calls.

To stop logging internal calls, clear the check box.

4. Click OK.

Reporting on outbound call center calls
For agents’ outbound calls to appear in reports, the agents must mark their outbound calls as 
calls that are placed from the call center. See “Placing calls from a queue” on page 5-8 and 
“Placing ACD workgroup calls” on page 7-16.

Backups of original reports
Because a user can accidentally overwrite a shared report by sharing one of his own reports with 
the same name, backup copies of the original TeleVantage report templates are provided in the 
Reports_backup directory in the TeleVantage Server directory.
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Setting general Reporter options ___________________________
Some reports will not run unless you have set general Reporter options. To set general Reporter 
options, you must have Administrator permissions.

1. From the Reporter, choose Tools > Options. The Options dialog box opens.

2. Under Toll-free options, enter the prefixes of phone numbers that are free to dial from 
the local TeleVantage Server. These include your local area code as well as any 
toll-free area codes such as 800 and 888. Separate entries with commas. You do not 
need to enter long-distance prefix digits, such as the “1” in the U.S.

If your entire local area code is not free, you can enter each free exchange as the area 
code plus exchange, for example 508452, 508673. 

3. Under In-state options, use the following fields to define how in-state calls appear on 
the outbound call reports:

� Label for in-state category. Type the name for in-state calls that will appear on the 
x-axis of reports that use this option. 

� Enter in-state... Enter a list of area code and exchanges that are in your State but 
not free, for example area codes in your State other than your local one. You do not 
need to enter long-distance prefix digits, such as the “1” in the U.S.

4. Under Criteria for counting outbound calls, use the following fields to define which 
calls are counted in various report categories:

� Minimum outbound number length. In North America this field should be left at 
10 so that the reports pick up all long-distance calls. Further filtering, for example 
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for the Outbound Long Distance Summary report, will be provided by the toll-free 
and in-state fields above.

� Minimum inbound/outbound call duration. These two fields ensure that the 
reports count only calls that were connected. You can adjust the setting as desired. 
A setting of 1 second is generally sufficient to include all connected calls.

� Short call duration. Enter the number of seconds at or below which a call is 
considered a “short call” by various reports, such as the Agent Performance by Skill 
report.

5. Click OK.

Using individual report options _____________________________
The Options dialog box appears automatically whenever you run a report, letting you specify 
the parameters for the report. You can also click Report Options on the Reporter toolbar to 
change a report’s parameters and run it again, for example, with a different date range. The 
following figure shows the Report Options dialog box for the Agent Performance Trends by 
Queue report. 

The following options are available for most reports: 

� Queue. Select the queue on which you want to run the report.

� Agent. Select the agent on whom you want to run the report.

� Period. Select the time frame for which you want to report. Use the Start and End fields 
for custom time frames.

� Interval. Select the length of time reflected by the report, such as hours, days, or months. 
The time periods appear on the x-axis of the report.

Click OK in the Report Options dialog box to run the report according to the options that you 
selected.
8-8 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



Report Options for the Trunk Performance report
The Trunk Performance report has specific fields that do not appear in the Options dialog box 
for other reports.

Under Trunks, enter the TeleVantage trunk numbers of the trunks on which you want to report. 
Use hyphens to indicate a range of trunks and commas to separate individual trunk numbers or 
a series of trunk ranges. The following examples are all valid entries:

� 1, 2, 3

� 1-10

� 1-10, 15-20

� 1, 4, 5, 10-20, 25-30, 40

Do not use overlapping trunk ranges, such as 1-10, 9-15. Be sure to use commas, not semicolons, 
to separate entries.

Under Days, check each day of the week for which you want trunk usage reported. For example, 
to report on weekday trunk performance, check each day except Saturday and Sunday. 

Under Period, select a date range as with other reports (see the previous section). The report will 
cover the time from the first call through the selected trunks within the date range, to the last call 
through the selected trunks within the date range. The report ignores calls made before the 
upgrade to TeleVantage 4.0.

Using the Excel tabs______________________________________
Most TeleVantage reports contain the following tabs in Excel:

� Report. A graphical presentation of the data.

� Data. A numerical presentation of the data.

� Report Options. A worksheet showing the options selected for the report.
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Totals on the Data tab
Sometimes totals on the Data tab appear to be inaccurate. This is usually due to the way Excel 
presents numbers, rounding them to the number of displayed digits. The total is always formed 
by taking the sum of the complete numbers, then rounding. For example:

Using the Report Options tab in Excel
Most users should not try to change the report parameters by changing the data on the Report 
Options tab. Instead, click Report Options on the Reporter toolbar and enter new parameters in 
the Options dialog box, as described earlier in this section. 

The Report Options tab in Excel is for those who want to print out the full workbook, with a 
record of the selected options. Macro writers and other skilled spreadsheet users can also use the 
tab to generate reports without using the TeleVantage Report Options dialog box.

Printing and scheduling reports with the Report Runner_________
The Report Runner enables you to create a desktop shortcut for running and printing a report. 
You can then run the report just by clicking the shortcut. You can choose whether to send the 
report to a printer or a file.

You can also use the Windows Task Scheduler to run the Report Runner at any time and interval 
you choose. See Windows Online Help for the Task Scheduler for more information.

To create a Report Runner shortcut for running a report

1. Create a shortcut to the Report Runner file, Tvrrun.exe. The default location for the 
Report Runner file is:

C:\Program Files\TeleVantage\Client\reporter\Tvrrun.exe

For instructions on creating a shortcut, see your Microsoft Windows documentation.

2. Right-click the shortcut and choose Properties.

3. In the Target field, add the following after the path:

� The path to the .xls file of the report you want to run.

� (optional) -C to send the chart report to your default printer.

� (optional) -T to send the data report to your default printer.

Displayed 
numbers

Complete 
numbers

6.47
5.87

6.4650
5.8699

Totals 12.33 12.3349
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� (optional) -S <output file> to print the report to a file. If you do not specify an output 
file, the new report overwrites the source .xls file. Note: Do not use quotes around 
the file path.

See the next section for examples of the Target statement.

4. To set report options, such as queue name or selected hours, use the Report Options 
tab in your saved .xls spreadsheet file. See “Using the Report Options tab in Excel” on 
page 8-10.

5. Click OK.

Examples of the shortcut Target statement
The following are examples of how the shortcut’s Target field might look:

� C:\Program Files\TeleVantage\Client\reporter\Reports\Tvrrun.exe C:\Program 
Files\TeleVantage\Client\reporter\Reports\
Wait by Outcome1.xls -C

The chart for the Wait by Outcome1.xls report is sent to the printer.

� C:\Program Files\TeleVantage\Client\reporter\Reports\Tvrrun.exe C:\Program 
Files\TeleVantage\Client\reporter\Reports\Trunk Performance.xls -C -T

The chart and the data sheet for the Trunk Performance Report are sent to the printer.

� C:\Program Files\TeleVantage\Client\reporter\Reports\Tvrrun.exe C:\Program 

Files\TeleVantage\Client\reporter\Reports\User Activity.xls -S

The .xls file of the User Activity report is overwritten with the new report.

� C:\Program Files\TeleVantage\Client\reporter\Reports\Tvrrun.exe C:\Program 
Files\TeleVantage\Client\reporter\Reports\User Activity.xls -S C:\Program 
Files\TeleVantage\Client\reporter\Reports\Fred_Sanders.xls

The User Activity report is written to the file Fred_Sanders.xls in the Reports directory 
(Note no quotes around the file path).

Procedure for using the Report Runner
When running or scheduling reports automatically with the Report Runner, you must do the 
following:

1. Run the report manually for the user you want and for the period you want.

2. Clear all sheets except for the “Report Options” sheet. (Click the top left cell to select 
all, then press Delete.)

3. On the “Report Options” sheet, do the following:

� Clear the date range in the “Period” row (column B).

� Clear the data in the “Days” row (columns B and C).

� In “Days” row (column B ) enter 1,2,3,4,5,6,7.

� In the “Days” row (column C) enter Sunday, Monday, Tuesday, Wednesday, 
Thursday, Friday, Saturday.
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4. Save the report (name it something like “User Template.xls”).

5. Set up the Report Runner to use this template every day to generate the report. An 
example command line would look like this:

C:\Reports\User Template.xls -S C:\Reports\User3.xls

Note the following:

� If the query generates no data, the existing report will be cleared , so you won't see the 
data from the previous execution.

� The “Days” option in the template will be ignored if the period is “Today” or 
“Yesterday.” In that case the day used will be the appropriate one for the period chosen.

Running the Report Runner without a command line statement
If you run the file Tvrrun.exe without modifying its command line, the system opens a Help 
topic that explains the Report Runner commands.
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List of reports ___________________________________________
You can produce the reports listed in the following table. For detailed examples of the reports, 
see the sections referenced in the table. 

Call Center Reports

Name Description

Requires 
data from 

this version 
or higher

Queue / ACD 
workgroup

Activity History by 
Agent report
(see page 8-19)

Shows an agent’s activity history by 
displaying a row for every change in 
agent state and personal status, and 
how long the agent spent in each 
state and personal status, for all the 
queues to which the agent belongs.

5.0 Queue only

Activity History by 
Queue report
(see page 8-21)

Shows a history of all of the agent 
activity in a queue by displaying a row 
for every change in agent state and 
personal status, and how long each 
agent in the queue spent in each 
state and personal status. Shows 
data for all agent activity in the 
queue.

5.0 Queue only

Agent by Queue and 
Skill Configuration 
report
(see page 8-23)

Lists each agent, showing to which 
queues he or she belongs and which 
skills he or she possesses.

7.0 Queue only

Agent Call Trends 
report
(see page 8-24)

Shows the number of calls an agent 
made or received and the agent’s 
average talk time.

4.0 Queue only

Agent Performance 
Trends by Queue 
report 
(see page 8-25)

By hour, day, or any time interval, 
shows number of calls an agent 
made or received while working in a 
queue and average talk time. 

3.5

Agent Performance 
by Skill report
(see page 8-26)

Provides summary data showing how 
each agent in a queue performed in a 
given period by skill

7.0 Queue only

Agent State Summary 
report
(see page 8-27)

By hour, day, or any time interval, 
shows the amount of time an agent 
spent in each state for each queue to 
which he or she belonged.

4.0 Queue only
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Agent State Summary 
by Queue report
(see page 8-28)

By hour, day, or any time interval, 
shows the amount of time each agent 
spent in each state for a queue.

4.0 Queue only

Average Wait Time 
and Call Volume by 
Time of Day report
(see page 8-29)

By hour, shows average wait time 
and inbound call volume for a queue 
or workgroup. 

4.0
Queue or ACD 

workgroup

Call Center Queue 
Information report
(see page 8-30)

Lists all general information for each 
queue in your system, including a list 
of all agents and their settings.

3.5 Queue only

Call Distribution by 
Skill and Agent report
(see page 8-31)

Provides a summary of how many 
calls were answered per selected 
agents and selected skills.

7.0 Queue only

Call Distribution by 
Skill and Queue 
report
(see page 8-32)

Provides a summary of how many 
calls were answered per selected 
queues and selected skills.

7.0 Queue only

Call Log report
(see page 8-33)

By any time interval, shows all the 
information that appears in the Call 
Log for the entire system or the 
selected user or queue, in a 
spreadsheet form that is easy to sort 
or filter. 

3.5
Queue or ACD 

workgroup

Call Result by Skill 
report
(see page 8-34)

Shows comparative call results for all 
calls with skill requirements. 

7.0 Queue only

Call Transfer report
By any time interval, reports on all of 
the calls that a user or queue 
transferred to other entities.

6.0
Queue or ACD 

workgroup

Call Trends report 
(see page 8-37)

By hour, day, or any time interval, 
shows total outbound calls made by 
agents in a queue. 

3.5
Queue or ACD 

workgroup

Call Center Reports

Name Description

Requires 
data from 

this version 
or higher

Queue / ACD 
workgroup
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Call Summary report
(see page 8-35)

By extension or workgroup, shows 
the total number of calls and the 
average duration of calls placed.

5.0
Queue or ACD 

workgroup

Call Volume by 
Account Code report 
(see page 8-38)

By account code, shows the number 
of inbound and outbound calls made 
using each account code and the 
total talk time, for a user, queue, 
workgroup, or all calls in the system. 

4.0
Queue or ACD 

workgroup

Call Volume by 
Identified Caller 
report 
(see page 8-39)

By TeleVantage contact, shows total 
calls a user, queue, or workgroup 
received and average talk duration. 
For example, if you created 5 
contacts, each to track a different 
promotional advertisement code 
(using PIN numbers to identify each 
contact), this report would show how 
many people called for each 
promotion. 

4.0
Queue or ACD 

workgroup

Cumulative Calls and 
Average Talk Time by 
Agent report 
(see page 8-40)

By agent, shows total calls made and 
received and average talk time for 
any queue or workgroup. 

3.5
Queue or ACD 

workgroup

Custom Data
(see page 8-41)

Total calls and average talk time 
associated with calls from a user, 
queue, or all system calls, that are 
identified by a specific custom data 
variable. For example, an auto 
attendant could be configured to set 
the “Product” custom variable to 
“Apples” or “Oranges” based on the 
menu choice selected. This report 
would show how many callers 
selected Apples versus Oranges, and 
the average length of those calls.

4.0
Queue or ACD 

workgroup

Call Center Reports

Name Description

Requires 
data from 

this version 
or higher

Queue / ACD 
workgroup
CHAPTER 8. RUNNING CALL CENTER REPORTS 8-15



Grouped Service 
Level report
(see page 8-42)

By five-second increments, shows 
wait time for all calls that were 
answered by a user..

6.0 Neither

Inbound Call 
Outcome Trends 
report
(see page 8-43)

By hour, day, or any time interval, 
shows total calls handled by one 
agent, multiple agents, abandoned, 
sent to voicemail, and the total 
number of calls for any queue. 

4.0
Queue or ACD 

workgroup

Inbound Call Volume 
Trends report 
(see page 8-44)

By hour, day, or any time interval, 
shows the total calls a queue 
received, average wait time, and 
longest wait time.

4.0
Queue or ACD 

workgroup

Outbound Call 
Comparison report
(see page 8-45)

Shows the number and duration of 
outbound calls in the following 
categories: In-state, Toll-free, and 
Other.

5.0 Neither

Outbound Calls by 
Phone Number report
(see page 8-46)

Shows the number and duration of 
outbound calls placed to prefxes that 
you specify, for example 800 or 212.

5.0 Neither

Outbound Long 
Distance Summary 
report
(see page 8-47)

By any time interval, shows your 
outbound long-distance phone traffic 
and estimates your phone bill.

5.0 Neither

Queue Call History 
Detail report
(see page 8-49)

Shows the call history for a selected 
queue, including the skill 
requirements for each call.

7.0
Queue or ACD 

workgroup

Queue Comparison 
report
(see page 8-50)

Compares all queues on total number 
of calls, average wait time, and total 
calls handled, abandoned, and sent 
to voicemail. For example, you can 
see how well your sales queue 
performs compared to your technical 
support queue. 

4.0
Queue or ACD 

workgroup

Call Center Reports

Name Description

Requires 
data from 

this version 
or higher

Queue / ACD 
workgroup
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Queue Performance 
Summary by Agent 
report
(see page 8-51)

Lists performance information for 
each agent in a queue, including 
inbound, outbound, and internal call 
statistics, as well as the percentage 
of time spent in each agent state.

7.0 Queue only

Service Level report 
(see page 8-52)

By wait time, shows the percentage 
of calls answered, abandoned, or 
sent to voicemail during a time range 
for a queue.

4.0
Queue or ACD 

workgroup

Service Level by Skill 
report
(see page 8-53)

By wait time, shows the percentage 
of calls with a single skill requirement 
in a single queue that were 
answered, abandoned, or sent to 
voicemail.

7.0 Queue only

Skill Assignment by 
Agent report
(see page 8-54)

Shows which agents have which 
skills within which queues. 7.0 Queue only

Trunk Performance 
report 
(see page 8-55)

By hour, shows the average number 
of inbound and outbound calls 
handled by the trunks you specify 
and the percentage of these trunks in 
use. Tells you if you need to add or 
remove trunks from your TeleVantage 
system, and can also help you predict 
future trunk performance.

4.0 Neither

Trunk Usage report
(see page 8-57)

By any time interval, reports on all 
trunks within a dialing service in 
terms of the amount of time the 
trunks were busy.

5.0 Neither

Unanswered Calls 
During Business 
Hours report
(see page 8-58)

By any time interval, shows inbound 
calls during your TeleVantage 
business hours that were not 
answered by a user..

5.0 Neither

Call Center Reports

Name Description

Requires 
data from 

this version 
or higher

Queue / ACD 
workgroup
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User Activity report 
(see page 8-59)

Pie charts showing the percentage of 
an agent’s time spent in active versus 
other statuses. Shows the kinds of 
calls that make up the active calls. 

4.0 Neither

User Call Trends 
report
(see page 8-60)

Shows the number of calls a user 
made or received and the user’s 
average talk time..

5.0
Queue or ACD 

workgroup

Wait by Outcome 
report 
(see page 8-61)

By hour, day, or any time interval, 
shows how long callers waited before 
their calls were handled, abandoned, 
or sent to voicemail. 

4.0
Queue or ACD 

workgroup

Call Center Reports

Name Description

Requires 
data from 

this version 
or higher

Queue / ACD 
workgroup
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Activity History by Agent report ____________________________
The Activity History by Agent report displays a row for every change in agent state and personal 
status, and how long the agent spent in each state, for all the queues to which the agent belongs.

Note: This report can return a very large amount of data, so you should run it for only the date 
range that you need, otherwise it could affect network performance.

Reading this report
This report is in data form only. It shows the following data by column:

� Time. Date/time at which the agent changed state.

� Personal Status. The agent’s history of personal status changes. 

� Time in personal status. The amount of time spent in each instance of a personal status.

� Queue. Name of the queue in which this state change was made. A blank cell indicates 
that the change applied to all queues in which the agent was a member.

� State. The state to which the agent changed. For an explanation of states see “The 
Agents pane” on page 6-3.

� Duration. How long the agent remained in the state.

Filtering the report
To view all the entries of one type only, click the arrow button in any column header and select 
the element you want to view. The report is filtered to display only the records for that element. 
For example, you could filter the State column for “Standby” to see how many times the agent 
was checking voicemail, or filter the Personal Status column for “On Break.”
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Activity History by Agent worksheet totals
To view performance subtotals for the agent, click the Totals tab at the bottom of the report.

The worksheet for the Activity History by Agent report displays the following statistics for the 
agent for each date in the date range:

Calls answered. Total inbound calls answered.

Calls placed. Total outbound calls placed.

Inbound calls. Total number of inbound calls

Outbound calls. Total number of outbound calls.

Total calls. Total number of calls including inbound and outbound.

Time on calls. Total time on queue calls for inbound, outbound, and all calls.

Avg. call. The average length of a call, for inbound, outbound, and all calls.

First Activity. Time of the agents’ first state change that day.

Last Activity. Time of the agents’ last state change that day. 

First Queue Call. Time of the agent’s first queue call that day.

Last Queue Call. Time of the agent’s last queue call that day.
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Activity History by Queue report ____________________________
The Activity History by Queue report shows a row for every change in agent state and personal 
status, and how long each agent in the queue spent in each state.

This report can return a very large amount of data, so you should run it for only the date range 
that you need, otherwise it could affect network performance.

Reading this report
This report is in data form only. It shows the following data by column:

� Time. Date/time at which the agent changed state or personal status.

� Agent. Agent’s name. The first and last activity of each day is displayed in bold face for 
each agent.

� Personal status. The personal status that the agent selected.

� Time in personal status. The length of time the agent spent in that iteration of the 
personal status.

� State. The state to which the agent changed. For an explanation of states see “The 
Agents pane” on page 6-3.

� Time in state. The length of time the agent spent in that iteration of the state.

� Duration. How long the agent remained in the state.

� Signed in/out. Displays when an agent signed in or out of the queue.

Filtering the report
To view all the entries of one type only, click the arrow button in any column header and select 
the element you want to view. The report is filtered to display only the records for that element. 
For example, you could filter by The Agent column for “Melody Altan” to see the activity of 
that agent only.
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Activity History by Queue worksheet totals
To view performance subtotals for each agent and totals for the queue as a whole, click the 
Totals tab at the bottom of the report.

The Totals sheet for the Activity History by Queue report displays the following statistics for 
each agent and for the queue as a whole:

Calls answered. Total inbound calls answered.

Calls placed. Total outbound calls placed.

Total calls. Total number of calls including inbound and outbound.

Time on calls. Total time on queue calls for inbound, outbound, and all calls.

Avg. call. The average length of a call, for inbound, outbound, and all calls.
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Agent by Queue and Skill Configuration report________________
The Agent by Queue and Skill Configuration data report lists each agent, showing which queues 
he or she belongs to and which skills he or she possesses. There are no report options for this 
report.
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Agent Call Trends report___________________________________
The Agent Call Trends report displays the number of inbound and outbound calls an agent 
handled, with the average talk time for each category.

Reading this report
The following fields appear in this report:

� Time interval. Displays as the x-axis of the report.

� Calls. The number of calls. Displays as the y-axis of the report.

� Inbound calls / Outbound calls. Displays as different-colored bars.

� Average talk time Inbound/Outbound. In minutes. Displays as two lines.
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Agent Performance Trends by Queue report __________________
The Agent Performance Trends by Queue report shows the number of calls a user made or 
received for a particular queue and the average talk time. Personal calls—those sent directly to 
or made from the user’s extension—are not included. Station-to-station calls are not included in 
this report unless the Administrator selects the Log Internal Calls option.

Reading this report
The following fields appear in this report:

� Interval. Displays as the x-axis of the report.

� Total number of calls. Displays as stacked bars, one bar for inbound calls and one bar 
for outbound calls. Read against the left y-axis of the report.

� Average talk time. Displays as two lines, one for inbound calls and one for outbound 
calls. Read against the right y-axis of the report.
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Agent Performance by Skill report___________________________
The Agent Performance by Skill report provides summary data showing how each agent in a 
queue performed in a given period by skill. This report allows setting various thresholds on 
Report Options tab in Excel that are colored on the Report and Data tabs if those values exceed 
the thresholds you specify

Reading the report
This report is in data form only. For each skill, it shows the queue performance of each agent 
with that skill as follows:

� Short Calls Answered. A call is considered short call if wait time is less or equal to the 
short call threshold (see “Setting general Reporter options” on page 8-7).

� Answered. The number of calls answered including short calls.

� Wrap Up Time. The time between calls to finish up paper work.

� Talk Time. The total talk time on the answered calls.

� Average Talk Time. Talk Time / (Answered + Short Calls Answered).

� Work Time. Talk Time + Wrap Up Time.
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Agent State Summary report _______________________________
The Agent State Summary report shows how much time an agent spent in each state, with 
separate displays for each queue to which the agent belonged. For an explanation of agent states, 
see page 6-5.

Reading this report
The Total duration (minutes) chart, on the y-axis of the report, shows the total length of time 
the agent spent in all states for each queue. 

The x-axis of the report shows each queue as a bar with a color breakdown representing the time 
spent in each state within that queue. Use the Data tab of the report to see a precise breakdown 
of how much time the agent spent in each state per queue.
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Agent State Summary by Queue report_______________________
The Agent State Summary by Queue report shows how much time each agent in a queue spent 
in each state. For an explanation of agent states, see page 6-5.

Reading this report
The Total duration (minutes) chart, on the y-axis of the report, shows the total length of time 
that each agent spent in all states for the queue. 

The x-axis of the report shows each agent in the queue as a bar with a color breakdown 
representing the time spent in each state. Use the Data tab of the report to see a precise 
breakdown of how much time each agent spent in each state.
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Average Wait Time and Call Volume by Time of Day report ______
The Average Wait Time and Call Volume by Time of Day report shows the average time that 
callers waited and the average call volume for all inbound calls to a queue or workgroup, 
displayed by time of day.

Reading this report
The following fields appear in this report:

� Time of Day. Displays as the x-axis of the report.

� Average Call Volume. The average number of calls for each hour. Displays as a bar for 
that hour. Read against the left y-axis of the report.

� Average Wait Time. The time from arrival of the call in the TeleVantage system until 
an agent answered the call, averaged for all the calls in each hour. Displays as a line. 
Read against the right y-axis of the report.

Note: Calls are logged under the hour in which they arrive in TeleVantage, not the hour in which 
they are answered. For example, if a call arrives at 1:59 and is answered at 2:01, it is included in 
the 1:00 group.
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Call Center Queue Information report ________________________
The Call Center Queue Information report shows general information about each queue in your 
system, including a list of agents and their current settings. Use this report to get a snapshot of 
a queue’s setup without using the Administrator.

Reading this report
This report is in data form only. For each queue, it shows general information about the queue 
on the top line. Below the queue line, it shows the following information for each agent in the 
queue:

� Extension. The agents’ extension.

� Signed in. Whether or not the agent can receive calls from the queue. See “Signing in 
and out of a queue” on page 5-5.

� Observer. Whether or not the agent is an observer. Observer agents can monitor the 
queue without being seen by other agents. See “Adding agents to the queue” on 
page 2-11.

� Record Nth Call. How often TeleVantage automatically records the agent’s queue calls.

� Permissions. The agent’s permissions. See “Agent permissions” on page 2-14.

� Overflow tier. The agent’s overflow tier. See “Setting up overflow agents” on 
page 2-25. A value of 0 indicates a primary agent. 

� Skills. A list of the agent’s skills.
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Call Distribution by Skill and Agent report ____________________
The Call Distribution by Skill and Agent report provides a summary of how many calls were 
answered per agent and per skill. In the Options dialog box you can select one or many agents, 
one or many skills, and the report period. This report allows setting various thresholds on the 
Report Options tab in Excel that are colored on the Report and Data tabs if those values exceed 
the thresholds you specify.

Reading the report
Each selected agent is displayed along the x-axis. The colored bars refer to skills, with the key 
at the bottom. The bars indicate how many calls with that skill requirement were answered. A 
call with multiple skill requirements is counted for each skill.
CHAPTER 8. RUNNING CALL CENTER REPORTS 8-31



Call Distribution by Skill and Queue report ____________________
The Call Distribution by Skill and Queue report provides a summary of how many calls were 
answered per queue and per skill. In the Options dialog box you can select one or many queues, 
one or many skills, and the report period. This report allows setting various thresholds on the 
Report Options tab in Excel that are colored on the Report and Data tabs if those values exceed 
the thresholds you specify.

Reading the report
Each selected queue is displayed along the x-axis. The colored bars refer to skills, with the key 
at the bottom. The bars indicate how many calls with that skill requirement were answered. A 
call with multiple skill requirements is counted for each skill.
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Call Log report___________________________________________
The Call Log report shows all the information that appears in the Call Log for a user or a queue, 
in a spreadsheet form that is easy to sort or filter. Using Microsoft Excel’s dropdown filtering 
tools, you can filter by any column to see just the calls you want.

This report should only be run for a small number of days due to the quantity of data it can 
produce.

Note: By default you can report only on your Call Log and all Call Logs that are shown to you in 
ViewPoint (for example, a queue’s Call Log if you have permission to view it, and any Call Logs 
that have been shared with you). To report on any Call Log, you must have the TeleVantage 
permission Report on all call logs set to Allow. See Administering TeleVantage.

For a description of the columns, see the description of the Call Log in Using TeleVantage or 
Administering TeleVantage.

Filtering Call Log data by column
To filter the report by column, click the arrow on any column header. From the dropdown list, 
select the column entry that you want to display. The report shows only calls with that column 
entry. Alternately, select Custom to filter by more complex criteria.

Examples of using the filter include viewing the following:

� All calls with account code 55 (Account Code column)

� All inbound or all outbound calls (Direction column)

� All calls longer than 30 minutes (Duration column, select Custom)

� All abandoned calls (Result column)

� All calls that were automatically recorded by the queue (Recorded by Queue column)
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Call Result by Skill report __________________________________
The Call Result by Skill report shows comparative call results for all calls with skill 
requirements. In the Report Options dialog box you can select which skills to report on, and 
which queues to include in the totals, in addition to the report period. This report allows setting 
various thresholds on the Report Options tab in Excel that are colored on the Report and Data 
tabs if those values exceed the thresholds you specify.

Reading the report
Each selected skill appears as a grouping along the x-axis. Colored bars corresponding to 
different call results show how many calls had each result per skill. 
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Call Summary report______________________________________
This report shows the total number of calls and the average duration of calls placed from an 
extension or a workgroup. You can choose whether the report shows internal or external calls.

Note: When internal calls is selected, the report includes users who are calling from trunks, such 
as users with IP phones or users calling from remote phones and logging in. 

Reading this report
The following fields appear in this report:

� Number of calls. Read against the left y-axis of the report.

� Average Duration. Displays as a line. Read against the right y-axis of the report.

The Data tab of this report shows Total Duration.
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Call Transfer report _______________________________________
This report shows how many calls a user or queue transferred to whom.

Reading this report
The following fields appear in this report:

� Number of transfers. Read against the y-axis of the report.

� Transfer Target. Each entity transferred to appears as a bar along the x-axis of the 
report.
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Call Trends report ________________________________________
The Call Trends report shows total number of inbound and outbound calls for a call center queue 
or an ACD workgroup by its agents. The agents must place calls as the queue for outbound calls 
to be reported (see “Placing calls from a queue” on page 5-8). This report is useful for tracking 
calls made to customers or calls made during marketing campaigns. It does not include personal 
calls (calls made when the outbound queue-calling feature was not activated).

Reading this report
The following fields appear in this report:

� Interval. Displays on the x-axis of the report.

� Total Outbound Calls. Displays as bars. Read against the left y-axis of the report.

� Average Talk Time. Displays as a line. Read against the right y-axis of the report.
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Call Volume by Account Code report_________________________
The Call Volume by Account Code report shows the inbound calls, total calls (inbound and 
outbound), and talk time for all calls for which an agent entered an account code. This report is 
useful for billing customers for service given to them over the phone or for tracking marketing 
campaigns.

You can report on calls that used account codes from any of the following categories:

� All calls handled by a particular agent or other user

� All calls handled by a queue, regardless of the agent involved

� All calls system-wide

Reading this report
The following fields appear in this report:

� Account code. Displays as the x-axis of the report.

� Inbound Calls and Total Calls. Displays as stacked bars for each account code. Read 
against the left y-axis of the report.

� Total Talk Time for Inbound Calls. Displays as a line. Read against the right y-axis of 
the report.

� Total Talk Time for All Calls. Displays as a line. Read against the right y-axis of the 
report.

Note: The entire call is included in Talk Time, regardless of at what time the account code was 
entered during the call.
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Call Volume by Identified Caller report _______________________
The Call Volume by Identified Caller report shows the number of calls a user or queue received 
from each identified contact and the average talk time. For example, if you created 5 contacts, 
each to track a different promotional advertisement code (using PIN #s to identify each contact) 
this report would show how many people called for each promotion.

Notes

� To run the report for an ACD workgroup, select the ACD workgroup user.

� When reporting on a queue, only calls from public contacts are listed, since the queue has 
no personal contacts. 

� When reporting on a call center queue agent, all personal calls sent to the agent are listed, 
even if someone else answered the call. Calls sent to other agents are not reported on, 
even if the agent answered them.

Reading this report
The following fields appear in this report:

� Contacts. Displays on the x-axis of the report. Public and private contacts are both 
listed.

� Calls. The total number of calls from each contact. Displays as a bar for each contact. 
Read against the left y-axis of the report.

� Average Talk Time. The average time the agent spent talking with each contact. 
Displays as a line. Read against the right y-axis of the report.
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Cumulative Calls and Average Talk Time by Agent report________
The Cumulative Calls and Average Talk Time by Agent report shows the total queue or 
workgroup calls an agent received and made (inbound and outbound) and the average talk time. 
The agent’s personal calls are not included in this report. 

Reading this report
The following fields appear in this report:

� Agents. Displays on the x-axis of the report.

� Unknown agents. Calls involving users who have been deleted from TeleVantage.

� Directly to voicemail. Calls that the queue sent directly to voicemail without ringing any 
agent’s phone.

� Inbound and outbound calls. Displays as stacked bars for each agent. Read against the 
left y-axis of the report.

� Average Talk Time for Inbound and Outbound Calls. Displays as two lines. Read 
against the right y-axis of the report.
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Custom Data report_______________________________________
The Custom Data report shows the total number and average talk time of calls involving a 
specific custom data variable for a user, queue, or the whole system. 

For example, you could configure an auto attendant to set the “Product” custom variable to 
“Apples” or “Oranges” based on the menu choice selected. You could then run this report to 
show how many callers selected Apples versus Oranges, and the average length of those calls.

Reading this report
The following fields appear in this report:

� Variable values. Different values for the selected custom data variable. Displays on the 
x-axis of the report. 

� Calls. Displays as bars for each variable value. Read against the left y-axis of the report.

� Average talk time. Displays as a line. Read against the right y-axis of the report.
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Grouped Service Level report_______________________________
This report shows wait time for all calls, displayed in five-second groupings. Wait time includes 
the amount of time that the caller waited between the extension being dialed and the user picking 
up, plus any time spent in a blind transfer later in the call. Note that wait time does not include 
time that the caller spent on hold, parked, or in a supervised transfer. 

Reading this report
The following fields appear in this report:

� Wait Time. Displays on the x-axis of the report as five-second groupings

� % of Calls. Shows how each grouping compares as a percentage of the total number of 
calls. Displays on the y-axis of the report. The total number of calls is displayed at the 
bottom of the report.
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Inbound Call Outcome Trends report ________________________
The Inbound Call Outcome Trends report shows the total number of calls to a queue and how 
those calls were handled, including the total calls handled by one agent, handled by multiple 
agents, sent to voicemail, and abandoned. 

Reading this report
The following fields appear in this report:

� Period. Displays as the x-axis of the report.

� Calls handled by one agent, calls handled by multiple agents, calls sent to 
voicemail, calls abandoned. Displays as stacked bars. Read against the left y-axis of 
the report. For the total number of calls in each category, click the Data tab in Excel.

Note: If the queue was configured to send calls directly to voicemail, those calls appear in a 
separate Direct to voicemail bar. The normal voicemail category counts calls that went to 
voicemail while the queue was sending calls to agents.
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Inbound Call Volume Trends report __________________________
The Inbound Call Volume Trends report shows the number of calls that a queue received, the 
average time callers waited, and the longest time a caller waited.

Reading this report
The following fields appear in this report:

� Interval. Displays as the x-axis of the report.

� Inbound Calls. The total number of inbound calls. Displays as bars. Read against the 
left y-axis of the report.

� Average Wait Time and Longest Wait Time. Displays as two lines. Read against the 
right y-axis of the report.

Note: If the queue was configured to send calls directly to voicemail, those calls are included in 
the report and are treated as having a wait time of 0.
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Outbound Call Comparison report __________________________
The Outbound Call Comparison report separates your outbound calls into three categories: 
In-state, Toll-free, and Other. The In-state and Toll-free categories depend on your settings in 
the general Reporter Options dialog box (see “Setting general Reporter options” on page 8-7).

Standard long-distance calls (calls made to non-free area codes) are included under “Other.”

Reading this report
The following fields appear in this report:

� Interval. Displays as the x-axis of the report.

� Number of Calls. Displays as bars. Read against the left y-axis of the report.

� Total Duration. Displays as a line. Read against the right y-axis of the report.
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Outbound Calls by Phone Number report_____________________
This report counts the number and duration of outbound calls placed to a specified list of phone 
number prefixes. Enter the prefixes in the Number prefixes field of the Options dialog box for 
this report (separate prefixes with commas).

Note: If your prefixes overlap, a call can show up in more than one column. For example, if you 
enter a prefix of 6 and another of 617, calls beginning with 617 will be counted in both columns.

Reading this report
The following fields appear in this report:

� Number prefixes. The prefixes you entered appear as the x-axis of the report.

� Number of Calls. Displays as bars. Read against the left y-axis of the report.

� Total Duration. Displays as a line. Read against the right y-axis of the report.
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Outbound Long Distance Summary report ___________________
You can use this report to track your outbound long-distance phone traffic and estimate a phone 
bill for a given period. The chart displays the total number of outbound long distance calls and 
the duration of each. The Data tab shows the estimated cost of your long distance calls.

Before running this report
You cannot run this report unless your system has been set up in the following way:

� One or more Organizations are defined. See Administering TeleVantage for instructions.

� In-state area codes are defined in the Reporter Options dialog. 

When setting up the Options for this report, specify the following additional fields. Your long 
distance carrier can provide you with exact numbers.

� Cost per minute. Enter the per-minute cost in dollars of your long-distance calls. For 
example, enter .05 for five cents a minute.

� Cost interval in seconds. The length of the intervals a minute is divided into for the 
purposes of calculating the cost of the call.

Reading this report
The following fields appear on this report:

Interval. Displays along the x-axis of the report.

Long Distance Calls. All outbound trunk calls whose numbers do not begin with any of the digit 
sequences listed in the Toll free options field of the Reporter Options dialog box. Displays as 
bars. Read against the left y-axis of the report. 

Duration. Displays as a line. Read against the right y-axis of the report.
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The following fields appear on the Data tab of this report. Each is totaled at the bottom.

� Interval. The time interval chosen.

� Outbound calls. The total number of outbound trunk calls, long distance or otherwise. 
Note that to count as an outbound call, a call must match the Criteria for counting 
outbound calls defined in the Reporter Options dialog box (see “Setting general 
Reporter options” on page 8-7).

� Long distance calls. The total number of long distance calls.

� Duration. The total duration of long distance calls for each interval.

� Cost. The total cost of long distance calls for each interval, based on the Cost per 
minute and Cost interval in seconds data you entered.
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Queue Call History Detail report ____________________________
The Queue Call History Detail report shows the call history for a selected queue during the 
selected time period, including the skill requirements for each call..

Reading this report
The report shows the following information for each call:

� Date and time that the call entered the TeleVantage system.

� Call ID. The system ID number of the particular call. Call ID can be displayed as a 
column in the Call Monitor and Call Log (hidden by default), and it appears in the queue 
logs (see Appendix B).

� DID. The DID number dialed, if any.

� Result. Whether the call was abandoned, answered, or sent to voicemail.

� Agent. The agent(s) who participated in the call.

� Statistics. The call’s wait time, talk time, and warp-up time are displayed.

� Skills. The call’s skill requirements are shown.
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Queue Comparison report _________________________________
The Queue Comparison report compares the performance of all queues in terms of total number 
of calls, average wait time, and the number of calls handled, abandoned, sent to voicemail, and 
transferred out of the queue. For example, you can see how well the sales queue performs 
compared to the technical support queue. 

Reading this report
The following fields appear in this report:

� Queues. Displays on the x-axis of the report.

� Handled, voicemail, Abandoned, Redirected, Transferred out of Queue. Displays as 
stacked bars. Read against the left y-axis of the report. For the exact number of each 
category and a breakdown of voicemail and Redirected, click the Data tab.

� Average wait time. Displays as a line. Read against the right y-axis of the report.
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Queue Performance Summary by Agent report________________
The Queue Performance Summary by Agent report lists performance information for each agent 
in a queue, including inbound, outbound, and internal call statistics, as well as the percentage of 
time spent in each agent state.

Reading this report
The report displays the following information for each agent:

� Signed In. The total time the agent spent in all states other than “signed out.”

� Incoming/Outgoing/Internal. The following statistics display for each category of calls:

� Count. The total number of calls.

� Average Length. The average length of those calls.

� %. The percentage of signed-in time spent on those calls.

� Percent Time per Agent State. The percentage of signed-in time that the agent spent in 
each state.

� Work Time. The total time and the percentage of signed-in time that the agent spent in 
the Active (inbound and outbound), Wrap-up (inbound and outbound), and Dialing 
states. 
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Service Level report_______________________________________
The Service Level report tracks wait time by showing the percentage of calls to a queue that has 
been answered, sent to voicemail, and abandoned as wait time progresses. The total number of 
calls in each category is shown in parentheses at the bottom of the report.

Note: In order to plot the curve smoothly on the chart, the curve only shows 100% of the calls if 
there is not a large difference between the 95th% and the 100th%. Frequently, there are a few 
calls in a set of records that have an extremely long wait time before something happens to the 
call. These calls can cause the plotted curve to seem very long and disproportionate. In these 
cases, TeleVantage plots only the top 95th% of calls (as shown in the preceding illustration).

Reading this report
The following fields appear in this report:

� Wait time. Displays on the x-axis of the report.

� % Answered. Displays as a line. Read against the x-axis and y-axis of the report to find 
what percentage of calls reached a result by that length of wait time.
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Service Level by Skill report________________________________
The Service Level by Skill report tracks wait time for calls with a single selected skill 
requirement in a single queue by showing the percentage of calls that has been answered, sent 
to voicemail, and abandoned as wait time progresses. The total number of calls is shown in 
parentheses at the bottom of the report.

Reading this report
The following fields appear in this report:

� Wait time. Displays on the x-axis of the report.

� % Answered. Displays as a line. Read against the x-axis and y-axis of the report to find 
what percentage of calls reached a result by that length of wait time.
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Skill Assignment by Agent report ___________________________
The Skill Assignment by Agent report shows which agents have which skills within which 
queues. There is no Report Options dialog box for this report.
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Trunk Performance report _________________________________
The Trunk Performance report shows the average number of inbound and outbound calls 
handled by the trunks you specify and the percentage of those trunks that was in use. Use this 
report to see whether you need to add or remove trunks from the system. This report can also 
help you to predict future trunk performance. See page 8-9 for the report options for this report.

Note: This report is most meaningful when you run it on only the trunks in a single hunt group, 
because then the failure rate reflects a single phone number. If you run the report for multiple 
phone numbers, the failure rate is averaged between them, so a high failure rate on one phone 
number might not be apparent.

Reading this report
The following fields appear on the Chart tab of this report:

� Hour of Day. Displays as the x-axis of the report.

� Inbound and Outbound Calls. Displays as stacked bars. Read against the left y-axis of 
the report.

� % Trunk Usage. Displays as a line. Read against the right y-axis of the report.
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The following fields appear on the Data tab of this report:

� Busiest Hour. The hour of the day that had the most trunks in use based on the CCS 
calculation (see CCS in this list). 

� CCS. 100 call-seconds. One call-second is equivalent to 1 call that was 1 second long.

� Erlangs. A decimal number showing the ratio of the time during which a trunk group is 
occupied to the time that the trunk group is available for calls. The Erlangs value in this 
report is based on the Busiest Hour calculation (see Busiest Hour in this list).

� Actual Failure Rate. The percentage of calls that did not go through.

� Number of trunks. Initially this number equals the number of trunks that you entered in 
the report options. You can enter different numbers and use Excel’s calculation 
functions to predict how many trunks you will need to give a desired failure rate.

� Load Increase. An expected increase in call volume. You can combine this and the 
Number of trunks entry to decide whether you need to add or remove trunks from your 
system.

� Resulting Failure Rate. The percentage of calls that will be abandoned after calculating 
your system with the Number of Trunks and Load Increase fields. You can adjust those 
two values until you have your optimum failure rate.
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Trunk Usage report_______________________________________
The Trunk Usage report provides an easy way to report on a group of trunks, without having to 
specify individual trunk numbers as in the Trunk Performance Report. The Trunk Usage report 
shows the traffic on all trunks within a Dialing Service. You can report on your existing Dialing 
Services, or you can define special Dialing Services for the purpose of this report, that contain 
the trunks on which you want to report. 

Note: This report is not restricted to calls that use the selected Dialing Service. It includes all 
calls on all trunks that are part of the Dialing Service. For example, it includes inbound calls on 
those trunks, even though those calls used no Dialing Service.

Reading this report
The following fields appear on the Chart or data tab of this report:

� Interval. Displays as the x-axis of the report.

� Total Duration. The total duration of all calls on the selected trunks for the interval. 
Displays as stacked bars. Read against the left y-axis of the report.

� All Trunks Busy Duration. The amount of time during the interval in which all selected 
trunks were in use.

� % Interval of All Trunks Busy. The total all busy time divided by the interval in hours.

� Number of Calls.
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Unanswered Calls During Business Hours report ______________
The Unanswered Calls report shows inbound calls during your TeleVantage business hours that 
were not answered by a user. This includes calls that were answered by another extension type, 
such as a queue or an auto attendant, but never picked up by a user.

Note: The report counts calls that show a Result of “Abandoned” or “To voicemail” in the Call 
Log. Because of this, calls that a user answered and then sent to voicemail count as unanswered.

Reading this report
The following fields appear on the Report tab of this report:

� Time interval. Displays as the x-axis of the report.

� Unanswered Calls. Total number of unanswered calls. Displays as stacked bars. Read 
against the left y-axis of the report.

� % Unanswered Calls. Unanswered calls as a percentage of all calls. Displays as a line. 
Read against the right y-axis of the report.
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User Activity report_______________________________________
The User Activity report breaks down an agent’s time by activity in pie-chart form, showing 
both total activity and activity by queue. 

Note: The Active Details pie chart appears only for agents in call center queues.

Reading this report
The User Activity pie chart shows the percentage of time that the user spent in each of several 
states. The following table shows how the states correspond to personal statuses and other states 
for agents and non-agent users.

User Activity States and Personal Statuses

State Agent Personal Status
Non-Agent Personal 
Status

Unavailable Available (Non-Queue) N/A

Available
Available
Available (Queue Only)

Available

Break
On Break
In a personal call

In a Meeting
Out of the Office

Training In a Meeting N/A

Active In a queue call
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User Call Trends report ____________________________________
The User Call Trends report displays the number of inbound calls a user received and outbound 
calls the user placed, with the average talk time for each category.

Reading this report
The following fields appear in this report:

� Time interval. Displays as the x-axis of the report.

� Calls. The number of calls. Displays as the y-axis of the report.

� Inbound calls / Outbound calls. Displays as different-colored bars.

� Average talk time Inbound/Outbound. In minutes. Displays as two lines.
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Wait by Outcome report ___________________________________
The Wait by Outcome report shows how long callers waited before their calls were handled, 
abandoned, to voicemail, or transferred out of the queue.

Reading this report
The following fields appear in this report:

� Interval. Displays on the x-axis of the report.

� Average wait - Handled, Average wait - voicemail, Average wait - Abandoned, 
Average wait - Transferred out of Queue. Displays as bars. Read against the y-axis of 
the report.

Notes

� Calls in which the caller pressed a key to go to voicemail are counted under voicemail.

� Calls that are redirected to voicemail are not counted in this report.
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About custom reports _____________________________________
The database used for the TeleVantage data is Microsoft SQL Server. By using a third-party 
reporting application such as Microsoft Access®, Microsoft Excel®, or Crystal Reports® to 
query the SQL Server database, you can create your own reports that report on TeleVantage call 
center and other data.

This appendix provides the database schema in which TeleVantage report data is stored in the 
SQL Server database.

Connecting to the TeleVantage database______________________
To access TeleVantage data, use the following settings:

These settings provide read-only access.

The TeleVantage database schema __________________________
The TeleVantage database contains the following tables that are used for reporting:

� CallLog (next page)

� PartyLog (page B-5)

� QueueEncounter (page B-8)

� AgentStateChange (page B-10)

� UserStateChange (page B-10)

� TrunkLog (page B-11)

� PhoneBookEntry (page B-12)

� ExtensionSettings (page B-12)

� Agent (page B-12)

� QueueSkillDefinitions (page B-13)

� PBEQueueSkills (page B-13)

� PBEQueueAttributes (page B-13)

� PersonalStatus (page B-13)

� Queue (page B-14)

� QueueSkills (page B-14)

Server Your TeleVantage Server computer name

Database TVDB

Login ID tv_browse

Password (blank)
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� SkillReqLog (page B-14)

� UserPSChange (page B-15)

As call center agent states change and calls are completed, the TeleVantage Server uses SQL 
Server stored procedures to write the appropriate data into these tables for later reporting.  In 
some cases the stored procedures themselves calculate the values of other fields to improve the 
performance of later data retrieval.

Note: Not all columns in all tables are listed.

The CallLog table
The CallLog table contains data for each completed call. At the completion of each call, a single 
row is added to the table.  The majority of columns in the table contain redundant data that can 
be found in other tables; they are included only to speed up data retrieval for the Administrator 
and ViewPoint application Call Log views.

The following are columns are unique to the CallLog table:

Name Description

ID Unique identifier for the call.

Direction

Direction of the call from the point of view of 
the server:
0 = Inbound
1 = Outbound
2 = Internal (station to station)
3 = Conference

StartTime
Timestamp for when the call started. This is 
when the server picks up the call.

StopTime
Timestamp for when the call ended. This is 
when the server drops the call.

AssocPbeID

ID of the row in the PhoneBookEntry table 
that is associated with this call. This is 
either the user or contact that one of the 
users associated with the call.

AssocFirstName First name of the associated person.

AssocLastName Last name of the associated person.

HoldTime Number of seconds the caller was on hold.

PbeList

Separated list of all PhoneBookEntry ID 
values that were involved in the call. This is 
used to speed performance of loading the 
Call Log views.
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The following CallLog table columns are copies of data from the PartyLog table (see page B-5) 
for either the "from" party (the first party in the call), the "to" party (the last party in the call), or 
both.

PartyCount Number of parties in the call.

AnsweredBy
PhoneBookEntry ID of the person who 
answered the call.

AnsweredByFirstName First name of the person who answered the 
call.

AnsweredByLastName
Last name of the person who answered the 
call.

PlacedBy
PhoneBookEntry ID of the person who 
placed the call.

PlacedByFirstName First name of the person who placed the 
call.

PlacedByLastName
Last name of the person who placed the 
call.

FromPhoneNumber Obsolete.

"From" Column "To" Column PartyLog Column

FromID ToID PartyPbeID

FromFirstName ToFirstName FirstName

FromLastName ToLastName PrimaryName

CallerIDName CallerIDName

CallerIDNumber ToPhoneNumber CallerIDNumber

CallerIDAccessCode ServiceAccessCode ServiceAccessCode

CallerIDType ToPhoneNumberType CallerIDType

CallerIDQ931Type
ToPhoneNumberSub
Type

CallerIDQ931Type

CustomData CustomData

CallbackAddress CallbackAddress

Result Result

DIDNumber DIDNumber

Name Description
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The PartyLog table
The PartyLog table contains data for each party in a completed call. Each person in the call 
counts as a party, so there can be multiple rows in this table for a single row in the CallLog table.

The following are the columns in the PartyLog table:

DevID ToDevID DevID

MessageID MessageID

DialString DialString

AccountCode AccountCode

"From" Column "To" Column PartyLog Column

Name Description

ID Unique identifier for the party.

CallID ID of the call that owns the party row.

PartyPbeID

ID of the row in the PhoneBookEntry table 
that is associated with this party. This is 
either the user or contact that represents 
the party.  If TeleVantage does not know 
who the party is (for example, no contact 
match) the column contains 33 which is the 
"unknown" ID.

FirstName
First name of the user or contact 
represented by the PartyPbeID column.

PrimaryName
Last name of the user or contact 
represented by the PartyPbeID column.

StartTime
Timestamp for when this party was added 
to the call.

StopTime
Timestamp for when this party was 
removed from the call.

CallerIDName
Name portion (if any) for the Caller ID data 
for this party.

CallerIDNumber
Number portion (if any) for the Caller ID 
data for this party.

DevID
Device number used for this party. Positive 
values are stations and negative values are 
trunks.
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MessageID
ID of a row in the Message table for a 
message (if any) left by this party.

DialString
The exact sequence of digits dialed by the 
server for this party.

Direction
The direction for this party:
0 = Callee
1 = Caller

Role

What role the party played in the call:
0 = Peer
1 = Monitor
2 = Pupil
3 = Coach

ReasonForLeaving

The reason this party was removed from 
the call:
0 = No reason
1 = Party hung up
2 = Party was hung up on
3 = Party abandoned call before anyone 
answered
4 = Party went to voicemail
5 = Party was blind transferred
6 = Party was supervised transferred
7 = Party was merged into a conference 
call
8 = Party is a user who logged in
9 = Party was sent directly to voicemail
10 = No answer
11 = Call was abandoned on this party
12 = Maximum login attempts failed
13 = Party was redirected by the queue 
(see the next entry)
14 = Transfer key was pressed by party

ReasonForRedirecting

This clarifies item 13, “Party was redirected 
by the queue,” in the previous entry. The 
possible reasons for redirection are:

1 = Maximum Wait Time Exceeded
2 = Queue Closed
3 = Queue Closed - No agents
4 = Maximum No. of Callers Exceeded
5 = Caller to Agent Ratio Exceeded
6 = Long Expected Wait Time

Name Description
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DIDNumber
DID digits that were received from the 
device for this party.

AcceptedTime
Timestamp for when this party accepted the 
call.

AnsweredBy

ID of the user who accepted the call.  This 
can be different from PartyPbeID for an 
ACD workgroup situation: in this case the 
PartyPbeID is the ID of the ACD workgroup 
and the AnsweredBy value is the ID of the 
user who answered for the workgroup.

GroupID

ID of the workgroup that accepted the call 
(if any). In the case of a Routing List that 
calls several workgroups this will be the ID 
of the one that accepted.

CallerIDType

The type of phone number used for the 
Caller ID number:
1 = Phone number
2 = IP address
6 = Centrex or Internal (Internal if 
ServiceAccessCode is blank, otherwise 
Centrex)

CallerIDQ931Type

Whether phone number parsing rules were 
used:
0 = No
8 = Yes

ServiceAccessCode

Access code for the service used by the 
party. For outbound calls this is the dialing 
service selected. For inbound calls this is 
the service that received the call (if known).

CustomData
String containing any custom data written to 
the call for third-party applications.

CallbackAddress
ID of a row in the Address table that 
describes the callback number the caller 
left.

PartyClass

Class value that represents what type of 
party this is:
1301 = User
0901 = Queue
0501 = Contact

Name Description
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The QueueEncounter table
Each inbound or outbound call for a queue or ACD workgroup results in a record in this table. 
A call that travels from one queue to another queue will create two records in this table.

AccountCode
Account code sequence (if any) entered for 
this party.

PartyNumber
Sequence number (starting at 0) that 
determines the order the parties entered 
the call.

ACDPartyNumber
Sequence number (starting at 1) that 
determines the party in an ACD call.

WrapUpDuration
The time an agent spent in wrap up after 
the call.

Name Description

Name Description

ID Unique identifier of the encounter entry.

CallID ID of the CallLog entry for this encounter.

QueueID
ID of the Queue entry that had this 
encounter.

Time
Timestamp for when the encounter 
occurred.

WaitTime Total time in seconds the caller waited.

AgentTalkTime
Total time in seconds that agents talked to 
the caller.

NumberAgents How many agents were involved.

Result
Same as the ReasonForLeaving column in 
the PartyLog table (see p. B-6).
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ReasonForRedirecting

When the Result column is 13 (redirecting), 
this column contains information as to why 
the call was redirected, as follows:
1:max wait time reached
2: queue closed
3: queue closed - no agents in the queue
4: queue too busy - exceeded the number 
of agents
5: queue too busy - exceeded caller/agent 
ratio
6: queue too busy - expected wait time is 
too long
7: no matching skills

Direction

Direction of the call from the point of view 
of the server:
0 = Inbound
1 = Outbound
2 = Internal (station to station)
3 = Conference

Name Description
APPENDIX A. CREATING CUSTOM REPORTS A-9



The AgentStateChange table
The AgentStateChange table contains data that tracks the state of agents. 

The UserStateChange table
The UserStateChange table contains data that tracks the state of users.

Name Description

PbeID
ID of the PhoneBookEntry row that 
represents the user.

QueueID ID of the Queue row that represents the 
Queue that this change was made in.

Time
Timestamp for when the user entered the 
state.

Duration
Number of seconds the user was in the 
state before it changed.

State

The state the agent was in before the 
change.  The state values are:
0 = Logout
1 = Available
2 = Standby
3 = Wrapup
4 = Offering
5 = No answer
6 = Active
7 = Active outbound
8 = Wrapup outbound

ToState
The state the agent was in after the 
change.  The state values are the same as 
the State column values.

Name Description

PbeID
ID of the PhoneBookEntry row that 
represents the user.

Time
Timestamp for when the user entered the 
state.

Duration
Number of seconds the user was in the state 
before it changed.
A-10 TELEVANTAGE CALL CENTER ADMINISTRATOR’S GUIDE



The TrunkLog table
The TrunkLog table contains data that tracks information on trunk usage.

State

The state the user was in before the change.
The state values are:
0 = Sign out
1 = Ready
2 = Break
3 = Training
4 = Unavailable
5 = ACD Active
6 = Non ACD Active
7 = Sign out Active

ToState
The state the user was in after the change.  
The state values are the same as the State 
column values.

Name Description

Name Description

ID Unique ID of this trunk usage row.

PartyLogID
ID of the PartyLog row whose trunk usage is 
being reported on.

DeviceID Device number for the trunk being used.

StartTime
Timestamp for when the trunk started to be 
used.

StopTime
Timestamp for when the trunk stopped being 
used.

Direction
The direction for this trunk usage:
0 = Inbound
1 = Outbound

SubIntervalCount

Counter for each portion of an hour the party 
active.  For example, if a party was on a call 
from 2:45 to 4:15, there will be three TrunkLog 
rows—one with a value of 0 for the 2:00 hour, 
one with a value of 1 for the 3:00 hour, and 
one with a value of 2 for the 4:00 hour.
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The PhoneBookEntry table
Most types of TeleVantage extensions (users, auto attendants, queues, IVR Plug-ins, etc.) have 
an entry in the PhoneBookEntry table.

The ExtensionSettings table
Many types of TeleVantage extensions (users, auto attendants, queues, IVR Plug-ins, etc.) have 
an entry in the ExtensionSettings table.

Agent table
Each agent in a queue results in a record in this table.

Name Description

ID Unique identifier of a record.

Primary Name Last name.

FirstName First name.

EntryType
1: User, including an ACD workgroup user.
21: Call center queue.

Name Description

ID
Same number as the corresponding record in 
the PhoneBookEntry table.

Number Extension number.

UserType

0: normal user
1: ACD workgroup user. 
Use this column and EntryType in the 
PhoneBookEntry table to find out if a record is 
for a normal user, ACD workgroup user, or 
queue.

LastAppliedStatusID
The current personal status. Refer to the 
PersonalStatus record.

Name Description

QueueID Refer to PhoneBookEntry record.

UserID Refer to PhoneBookEntry record.

Observer
0: signed in.
1: signed out.
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QueueSkillDefinitions table
The system-wide skill list is saved in this table.

PBEQueueSkills table
Agent skills are saved in this table.

PBEQueueAttributes table
Agent attributes are saved in this table.

PersonalStatus table
Each personal status for each user has a record in this table.

RealObserver
0: agent.
1: observer.

Name Description

Name Description

ID Unique identifier of each skill.

Name Name.

Name Description

ID Refer to agent/user’s PhoneBookEntry record.

SkillID Refer to QueueSkillDefinitions record.

ProficiencyValue The proficiency value.

Name Description

ID Refer to agent/user’s PhoneBookEntry record.

Cost Agent’s Cost.

Custom1 Agent’s Custom1 value.

Custom2 Agent’s Custom2 value.

Custom3 Agent’s Custom3 value.

Name Description

ID Unique ID to identify the record.

OwnerID Refer to user’s PhoneBookEntry record.
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Queue table
Each queue defined in the system has a record in this table.

QueueSkills table
Each skill defined in a queue has a record in this table.

SkillReqLog table
For each skill requirement of a call, there is a record in this table.

Name
The internal name that will be translated into 
localized names when used.

IsSystem
0: user’s custom personal status.
1: system created personal status.

Name Description

Name Description

ID Same number used in PhoneBookEntry table.

DistributionType

0: Top Down
1: Round Robin
2: Longest Idle
3: Fewest Call
4: Least Talk Time
5: Simultaneous
6: Skill and Custom

Name Description

QueueID Refer to PhoneBookEntry record of the queue

SkillID
Refer to QueueSkillDefinitions record of the 
skill.

Name Description

ID Unique identifier of a record.

CallID Refer to the record in the CallLog table.

SkillID
Refer to the record in the 
QueueSkillDefinitions table.

MinReq Minimum requirement for the skill of the call.

MaxReq Maximum requirement for the skill of the call.
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UserPSChange table
Each user personal status change results in a record in this table.

Name Description

ID Unique identifier of a record.

PbeID Refer to the user’s PhoneBookEntry record.

StartTime The time of the change.

StatusID
The personal status a user changed to, 
reference the PersonalStatus table record.

Duration
The duration user stayed in this personal 
status.
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Using queue logs_________________________________________
Queue logs can be an invaluable troubleshooting tool, helping you determine exactly why a call 
did or did not go to a given agent. It can be especially useful to see the inner workings of 
skills-based or custom routing (see Chapter 3).

Queue logs are text file logs that show the step-by-step logic of queue routing in easy-to-read 
detail. The logs list every action taken in or by the queue with timestamps showing when it 
occurred, including:

� Agents signing in or out or changing status

� New calls arriving

� The process of filtering agents

� The numbers used to score available agents

� The numbers used to score waiting calls

Turning on queue logging
To turn on queue logging, do the following:

1. Edit the queue in the Queue dialog box.

2. On the Queue tab, check Trace queue and agent activity to queue logs.

3. Click OK.

Location and size of queue log files
When enabled, queue logs are created on the TeleVantage Server computer in the C:\Program 
Files\TeleVantage Server\Logs directory. The filenames are incremented in the format 
TVQueue*.txt, for example, TVQueue1.txt, TVQueue2.txt, etc. 

The maximum size of a queue log file is 4 MB, and by default the maximum number of queue 
log files is 20. When 20 4 MB files have been created, the Server begins overwriting the old files 
beginning with TVQueue1.txt.

To modify the maximum number of queue log files, use the following DWORD registration key:

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\Settings\QueueNumLogs

Opening queue logs ______________________________________
Queue logs are created on the TeleVantage Server computer in the C:\Program 
Files\TeleVantage Server\Logs directory. The filenames are “TVQueue*.txt,” for example, 
TVQueue1.txt, TVQueue2.txt, etc. 
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Viewing queue logs_______________________________________
You can open a queue log text file in Notepad or any word processor.

Note that each call is listed with its Call ID number in parentheses. You can view the Call ID 
number in the Administrator or ViewPoint Call Log by showing the Call ID column (hidden by 
default). Call ID also appears in the Queue Call History Detail report (see page 8-49).
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INDEX
Symbols
* (on Call Monitor and Queue Monitor tabs), 5-6

*00 (log off from workstation), 5-4

*14 (place calls from a queue), 5-8

*50 (select Available personal status), 5-2

*51 (select Available Queue Only personal status), 5-2

*52 (select Available non-Queue personal status), 5-3

*53 (select On Break personal status), 5-3

*54 (terminate wrap-up time), 5-8

*55 (hear queue statistics), 6-17

*56 (sign in or out of a queue), 5-5

A
account codes report, 8-38

ACD workgroup user
creating, 7-5

creating routing list for, 7-7

ACD workgroups
creating menu choice for, 7-13

creating the ACD workgroup user, 7-5

defined, 1-2

defining agents, 7-6

directing calls to, 7-3

distributing calls to agents, 7-3

distribution algorithms for, 7-10

going on break, 7-16

marking agents as ready and unavailable, 7-14

multiple groups for different shifts, 7-10

overview, 7-3

overview of creating, 7-4

receiving a call, 7-15

routing list for workgroup user, 7-7

sharing folders, 7-11

taking offline, 7-17

using overflow agents, 7-11
ACD workgroups (cont’d.)
voice mail for, 7-16

working as an agent in, 7-14

Activity History by Agent report, 8-19

Activity History by Queue report, 8-21

Agent by Queue and Skill Configuration report, 8-23

Agent Call Trends report, 8-24

Agent dialog box, 2-11

Agent Performance by Skill report, 8-26

Agent Performance Trends by Queue report, 8-25

agent scoring
overview, 3-12

formula, 3-14

in queue logs, A-1

worksheet for, 3-15

Agent State Summary by Queue report, 8-28

Agent State Summary report, 8-27

agent states, defined, 6-5

agents
adding to a queue, 2-11

assigning skills to, 3-4

changing order of, 2-17

changing personal status, 6-20

configuring ringback, 2-35

defined, 2-3

defining for ACD workgroups, 7-6

disallowing personal status change, 2-16

handling queue calls, 5-6

hot-desking, 2-17

marking as ready and unavailable for ACD 
workgroups, 7-14

monitoring, coaching, and joining calls, 6-17

overflow groups, 2-25

performance trends by queue, 8-25

permissions, 2-14

placing automatically On Break, 2-21
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agents (cont’d.)
placing on and off call, 6-19

recording calls, 2-13

roaming, 2-17

setting default permissions, 2-11

viewing skills, 3-11

viewing them being monitored, 6-18

working as in ACD workgroups, 7-14

working at another phone, 5-4

working remotely, 2-17

Agents Pane, 6-4

attributes, assigning to users, 3-4

auto attendant menu choice
creating for ACD workgroups, 7-13

creating for queues, 2-51

auto attendants, adding skill requirements with, 3-6

automatic call distribution. see ACD workgroups

Average Wait Time and Call Volume by Time of Day 
report, 8-29

B
backup reports, 8-6

breaks, taking in ACD workgroups, 7-16

C
call center

agent availability, 5-2

agent workday procedures, 5-2

defined, 1-2

determining if you are on call for a queue, 5-2

ending your shift, 5-3

licenses for, 2-4

ready, 5-2

starting your shift, 5-2

taking a break, 5-3

taking breaks, 5-2

terminology for, 2-3

unavailable, 5-2

user activity report, 8-59

using Contact Manager Assistant, 5-9

viewing pop-up information about a caller, 5-9

wrap-up time, 5-8
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call center agents
Call Monitor view tabs, 5-7

signing in and out, 5-2

taking breaks, 5-2

Call Center Queue Information report, 8-30

Call Center Reporter
overview, 8-2

requirements, 8-2

used with data from earlier versions, 8-2

using Excel toolbar, 8-4

Call Distribution by Skill and Agent report, 8-31

Call Distribution by Skill and Queue report, 8-32

Call ID number, A-3

Call Log
queue activity in, 2-8

sharing for ACD workgroup agents, 7-11

using to analyze ACD workgroup traffic, 7-17

viewing all columns, 7-17

Call Log report, 8-33

Call Monitor
sharing for ACD workgroup agents, 7-11

tabs for call center agents, 5-7

call priority, 2-23

Call Result by Skill report, 8-34

call rules, applying to queue calls, 4-5

call scoring
overview, 2-22

in queue logs, A-1

time in queue vs time in system, 2-22

with call priority, 2-23

with skills, 3-11

worksheet for, 3-15

Call Summary report, 8-35

Call Transfer report, 8-36

Call Trends report, 8-37

Call Volume by Account Code report, 8-38

Call Volume by Identified Caller report, 8-39

callback phone numbers, enabling callers to leave, 2-47

caller ID, setting for outbound queue calls, 2-9

coaching agents’ calls, 6-17
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conditional Hold prompts, 2-38

contacts
report on call volume, 8-39

sharing for ACD workgroup agents, 7-11

sharing with a queue, 4-4

cost, assigning to users, 3-5

Cumulative Calls and Average Talk Time by Agent 
report, 8-40

Custom Data report, 8-41

custom data variable, for call priority, 2-24

custom data variables
overview, 2-54

for conditional Hold prompts, 2-39

for storing entered information, 2-42

custom reports, B-2

custom routing, overview, 3-2

D
data entry by callers, 2-42

database connection settings, B-2

database schema, B-2

default wrap-up time and permissions, setting, 2-11

dial-by-name directory, listing queues in, 2-10

distribution algorithms, 2-19

documentation, 1-6

E
Examples

call rule for special Welcome message, 4-5

conditional Hold prompt, 2-39

printing reports with Report Runner, 8-11

Excel, using reports toolbar in, 8-4

Exchange, synchronizing voice mail with, 2-41

expected wait time, improving, 2-28

extensions for queues, 2-7

F
feature comparison, call centers and ACD 

workgroups, 1-3
I-3
fewest calls distribution, 2-19

G
greetings, 2-47

Grouped Service Level report, 8-42

H
H.323 Gateways, agents over, 5-10

headers and footers, viewing in reports, 8-4

hold
music for, 2-35

options while waiting on, 2-35

Hold Prompt dialog box, 2-37

Hold prompts
conditional, 2-38

creating, 2-36

using custom data variables with, 2-39

hot-desking, 2-17

I
Inbound Call Outcome Trends report, 8-43

Inbound Call Volume Trends report, 8-44

IVR Plug-ins, using with queues, 2-53

J
joining agents’ calls, 6-17

L
language of prompts for a queue, 2-46

least talk time distribution, 2-19

licenses, 2-4

local reports, 8-5

logging queue calls, 2-8

longest idle agent distribution, 2-19

M
mailbox, setting up for a queue, 2-40
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maximum wait time, defining, 2-32

menu choice for queues, 2-51

monitoring agents’ calls, 6-17

N
notifications for voice messages, 2-41

O
On Break status, automatically placing agents in, 2-21

options for waiting callers, 2-35

Outbound Call Comparison report, 8-45

outbound caller ID, 2-9

Outbound Calls by Phone Number report, 8-46

Outbound Long Distance Summary report, 8-47

overflow agents
defined, 2-3

using in ACD workgroups, 7-11

using in queues, 2-25

P
password security, 2-45

permissions
defined, 2-14

for call center agents to supervise other agents, 2-3

setting defaults, 2-11

personal calls, defined, 2-3

personal status
and state, 6-14

changing an agent’s, 6-20

preventing agents from changing, 2-16

placing calls from a queue, 5-8

popping up caller information, 5-9

priority, setting for calls, 2-23

prompts
conditional Hold, 2-38

Hold, 2-36

Welcome, 2-46
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Q
Queue Call History Detail report, 8-49

Queue Comparison report, 8-50

Queue dialog box, 2-6

queue logs, A-1

Queue Monitor view, 5-8, 6-3

Queue Performance Summary by Agent report
reports

Queue Performance Summary by Agent 
report, 8-51

Queue Statistics pane, 6-9

queues
overview of creating, 2-4

adding agents to, 2-11

agent permissions, 2-14

and IVR Plug-ins, 2-53

call distribution, 2-19

call outcome report, 8-43

call priority, 2-23

call volume report, 8-44

caller ID for, 2-9

caller options while waiting, 2-35

clearing lockout, 2-45

closing, 2-8

comparison report, 8-50

contacts for, 4-4

creating a utility user for, 4-3

creating Hold prompts for, 2-36

data entry by callers, 2-42

defined, 2-3

distribution algorithms, 2-19

extensions for, 2-7

hold music for, 2-35

language of telephone prompts, 2-46

listing in dial-by-name directory, 2-10

menu choices for, 2-51

prompt language, 2-46

recording calls, 2-48

setting up menu choice for, 2-51

signing in and out, 5-2

skills for, 3-7
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queues (cont’d.)
statistics by phone, 6-17

supervising overview, 6-2

talk time report by agent, 8-40

trends report, 8-25

using call rules with, 4-5

using contacts with, 4-2

using IVR Plug-ins with, 2-53

using overflow agents, 2-25

utility user, 4-3

validating data entry by callers, 2-43

viewing statistics online, 6-3

voice mail greetings for, 2-47

voice mailbox for, 6-21

voice title for, 2-46

wait by outcome report, 8-61

Welcome prompt for, 2-46

Queues view, 2-5

R
ready, marking yourself in ACD workgroups, 7-14

receiving and handling queue calls, 5-6

recording
agents’ calls, 2-13

queue calls, 2-48

redirecting calls, 2-30

remote agents, 2-17

reports
overview, 8-2

Activity History by Agent, 8-19

Activity History by Queue, 8-21

Agent by Queue and Skill Configuration report, 8-23

Agent Call Trends, 8-24

Agent Performance by Skill, 8-26

Agent Performance Trends by Queue, 8-25

Agent State Summary, 8-27

Agent State Summary by Queue, 8-28

Average Wait Time and Call Volume by Time of 
Day, 8-29

backups for, 8-6

Call Center Queue Information, 8-30
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reports (cont’d.)
Call Distribution by Skill and Agent, 8-31

Call Distribution by Skill and Queue, 8-32

Call Log, 8-33

Call Result by Skill, 8-34

Call Summary, 8-35

Call Transfer, 8-36

Call Trends, 8-37

Call Volume by Account Code, 8-38

Call Volume by Identified Caller, 8-39

Cumulative Calls and Average Talk Time by 
Agent, 8-40

custom, B-2

Custom Data, 8-41

Grouped Service Level, 8-42

Inbound Call Outcome Trends, 8-43

Inbound Call Volume Trends, 8-44

options for, 8-8

Outbound Call Comparison, 8-45

Outbound Calls by Phone Number, 8-46

Outbound Long Distance Summary, 8-47

Queue Call History Detail, 8-49

Queue Comparison, 8-50

running, 8-3

Service Level, 8-52

Service Level by Skill, 8-53

shared and local, 8-5

Skill Assignment by Agent report, 8-54

Trunk Performance, 8-55

Trunk Usage, 8-57

Unanswered Calls During Business Hours, 8-58

User Activity, 8-59

User Call Trends, 8-60

using Excel toolbar to run, 8-4

viewing headers and footers, 8-4

Wait by Outcome, 8-61

reset times for statistics, 6-13

ringback, configuring for agents, 2-35

roaming agents, 2-17

round robin distribution, 2-19

routing list for workgroup user, creating, 7-7
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S
schema for database, B-2

security, managing for a queue, 2-45

Service Level by Skill report, 8-53

Service Level report, 8-52

shared reports, 8-5

shifts
with ACD workgroups, 7-10

with call center queues, 2-50

signing in and out, 5-2

simultaneous ring distribution, 2-20

Skill Assignment by Agent report, 8-54

skills
overview, 3-3

adding to calls as requirements, 3-6

adding to queues, 3-7

adjusting requirements over time, 3-9

assigning to users, 3-4

configuring a queue to use, 3-8

defining, 3-4

reducing wait time for, 3-11

value scale for, 3-5

viewing an agent’s, 3-11

weighting for a queue, 3-7

Skillsworksheet.xls, 3-15

states for agents, defined, 6-5

statistics
configuring collection of, 2-50

displayed for queues, 6-3

when reset, 6-13

supervising
changing agents’ personal status, 6-20

monitoring, coaching, and joining agents’ calls, 6-17

overview, 6-2

without receiving calls, 6-2

supervisor, defined, 2-3

support, technical, 1-9

synchronizing voice mail with Microsoft 
Exchange, 2-41
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T
technical support, 1-9

terminology, 2-3

time-of-day wait time and call volume report, 8-29

toolbar, for reports, using in Microsoft Excel, 8-4

top down distribution, 2-19

transfer, option while waiting, 2-35

trends report, 8-37

Trunk Performance report, 8-55

Trunk Usage report, 8-57

U
Unanswered Calls During Business Hours report, 8-58

User Activity report, 8-59

User Call Trends report, 8-60

utility user, 4-3

V
validating caller data, 2-43

variables. See custom data variables.

voice mail
callback phone numbers, 2-47

creating greetings, 2-47

for ACD workgroups, 7-16

notifications for, 2-41

option while waiting, 2-35

setting up for a queue, 2-40

sharing for ACD workgroup agents, 7-11

synchronizing with Microsoft Exchange, 2-41

voice title for queues, 2-46

W
Wait by Outcome report, 8-61

weighting skills, 3-7

Welcome prompt, recording, 2-46

workgroups, creating for ACD workgroups, 7-6

working remotely, 5-10

wrap-up time
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default setting for, 2-11

ending early, 5-8

using, 5-8
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